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1 INTRODUCTION 

1.1 PURPOSE 

The Consolidated Document System (CDOCS) is an automated database management system 
for the Nuclear Regulatory Commission (NRC) Division of Waste Management (DWM) and Center for 
Nuclear Waste Regulatory Analyses (CNWRA) staffs to use in research and analysis related to radioactive 
waste regulatory activities. The purpose of this document is to provide a brief system description, 
procedures, and guidelines for use in operating CDOCS.  

1.2 SCOPE AND CONTENT 

This User's Guide provides guidelines for use in accessing technical references, reports, Quality 
Assurance (QA) records, correspondence, databases, and other materials used by the NRC and CNWRA 
staffs. CDOCS contains documents and references in ten databases. The contents of these databases can be 
searched and retrieved and copied for use in other applications. Additionally, various reports are available.  
The User's Guide gives users access to computer database management tools that can support them in their 
research and analysis activities. Users are grouped into three broad categories: information users, database 
custodians, and database administrators. Individual chapters have been devoted to the functions available 
to these users.  

The User's Guide consists of this introduction and the following sections: 

"* Chapter 2-System Capabilities and Hardware Requirements-Describes the system design 
concept and primary functions.  

"* Chapter 3-User Guidelines-Provides information to help users: (i) use the TOPIC search 
and retrieval software to retrieve, view, and print records; and (ii) view and produce standard 
reports.  

"• Chapter 4-Scanning Guidelines-Provides general guidance on scanning and optical 
character recognition (OCR).  

"* Chapter 5-Database Custodian Guidelines-Provides guidance to the database custodians 
for submitting, updating, and deleting CDOCS records.  

"• Chapter 6-Database Administrator Guidelines-Provides guidance to the database 
administrator for adding and maintaining user permissions, preferences, and authorities.  

"• Chapter 7-References 

"• Appendix A-Password Logon-provides instruction for: (i) logging on to a password
protected system, and (ii) changing a password.  

"* Appendix B-Error Messages-Provides a listing of error messages and corresponding user 
actions.
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"* Appendix C-ScanWorX Scanning, Optical Character Recognition, and Document 
Cleanup-Provides guidance for scanning and performing optical character recognition using 
the Xerox ScanWorX software and scanner.  

"* Appendix D-Calera M/Series Professional Scanning, Optical Character Recognition, and 
Document Cleanup-Provides guidance for scanning and performing optical character 
recognition using the Calera M/Series Professional software.  

1.3 BACKGROUND 

The DWM has a statutory requirement to make a construction authorization decision within 3 
years following the U. S. Department of Energy (DOE) submittal of a license application (LA) for a 
geologic repository for HLW. This requirement will place considerable demand on the DWM staff as it 
conducts its LA reviews. The Overall Review Strategy for the Nuclear Regulatory Commission High-Level 
Waste Repository Program (Johnson, 1993) identifies the following assumptions and strategies that suggest 
the need for enhanced computer capabilities and tools to support the staff in performing these reviews: 

"* There will be early availability of preliminary information developed and documented by the 
DOE during the prelicense application phase.  

"* The staff will have the ability to use the results of prelicense application reviews and 
supporting investigations.  

" It is possible to streamline the acceptance review process, resulting in compliance reviews 
that focus less on assessing the completeness of detailed supporting information and 
methodologies and more on how the detailed information was used to demonstrate 
compliance.  

"* The staff will be able to use compliance reviews to verify the acceptability of the DOE 
compliance demonstration.  

"* The reviews will be supported through the documentation of concerns as open items and the 
tracking of these open items.  

"* The staff will develop and use computer models and codes as an ongoing activity in support 
of iterative performance assessment.  

CDOCS is a part of the Advanced Computer Review System (ACRS), which is being 
implemented in the DWM to provide technical computing and database and document access capabilities 
to support the staff in performing technical reviews and analyses. Technical computing requirements 
addressed by the ACRS include analyzing and displaying spatial and temporal data; constructing and using 
topology feature models; compiling and running a variety of engineering and scientific codes; and 
accessing large volumes of data from databases maintained by organizations such as DOE and the United 
States Geologic Survey. CDOCS functions as part of the ACRS by providing database access, document 
reference, and database download capabilities; and provides an effective way for staff to access both 
textual information and images (DeWispelare et al., 1995). Textual information is fully accessible through
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the search and retrieval capabilities. Image information associated with textual documents, including maps, 
charts, graphs, photographs, and other image data, is also directly accessible through CDOCS.  

Over a period of years, a number of diverse databases, systems, and information access 
capabilities have been developed which partially satisfy the information requirements of the staff. The 
Nuclear Document System (NUDOCS) at the NRC has been used for loading, searching, and retrieving a 
large volume of bibliographic references and the full text of selected HLW documents. The Technical 
Document Index (TDI) system at the CNWRA has been used for storage and retrieval of bibliographic 
records for Regulatory Information Distribution System (RIDS) documents, technical reports produced by 
the CNWRA, and associated reference documents. A database containing over 1,000 bibliographic 
references and approximately 110 document reviews related to container materials was developed at the 
National Institute of Science and Technology (NIST); this database is currently maintained at the DWM.  
Another database containing bibliographic references related to hydrologic transport was developed at Oak 
Ridge National Laboratory; this database is also currently maintained at the DWM. Other bibliographic 
databases pertaining to site characterization, technical reviews, and research are maintained at the DWM, 
the CNWRA, and elsewhere. The DWM Regulatory Program Database (RPD) provided access to License 
Application Review Plan (LARP) products such as Compliance Determination Strategies (CDSs) and 
Compliance Determination Methods (CDMs) as well as the open items associated with the HLW 
regulatory program (DeWispelare et al., 1995). CDOCS and RPD have been combined into a single text 
management system, CDOCS.  

Each of these diverse systems and databases has been developed with its own user interface and 
access protocols. The resulting environment provided only limited support for the staff in addressing their 
information needs. The role of CDOCS within the ACRS is to provide a unified and consistent facility, 
capable of interfacing with office automation systems, for staff to use in accessing textual information and 
associated images.
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2 SYSTEM CAPABILITIES AND HARDWARE REQUIREMENTS 

2.1 SYSTEM CAPABILITIES 

The design philosophy for CDOCS includes satisfying a number of requirements.  

"Enhance usability of the system through graphical user interfaces (GUIs). Support for 
analysis and review of documents required the implementation of standard GUIs so that 
multiple documents may be viewed concurrently and so that font and window sizes which are 
appropriate to the displayed documents may be selected by the user.  

"* Provide full functionality in CDOCS across multiple computer platforms while maintaining 
the native appearance and operation of those platforms.  

" Use commercially available software to the greatest extent possible. Search and retrieval 
capabilities are implemented using the Verity product TOPIC. The structured query language 
(SQL)-compliant product ORACLE provides the relational database used in CDOCS. The 
GUI development toolkit, Galaxy by Visix, is used to support development of custom client 
code for all computer platforms.  

" Comply with standards [open system, SQL, and standard generalized markup language 
(SGML)] to ensure current and future compatibility. Conform to (i) the POSIX standard for 
open systems; (ii) SQL standards for databasing to support a wide diversity of present and 
anticipated hardware and software configurations, and ensure compatibility with current and 
future SQL database syntax; and (iv) the SGML standard for formatting and processing text 
which provides the flexibility required for viewing and manipulating portions of documents 
to produce custom documents efficiently.  

"* Provide a generalized report writer capability for extracting and integrating database 
information into new documents.  

Information in CDOCS is organized into document sets to (i) facilitate efficient access to specific 
types of documents and to documents containing related information, and (ii) control access to certain 
document sets based on the type of user (e.g., DWM users versus CNWRA users). For many of the 
document sets, CDOCS contains full text files, and record searches are performed on the full text. Other 
document sets include only bibliographic header information (i.e., title, author, etc.), and searches for 
documents within those sets are limited to the header information.  

CDOCS database custodians and database administrators are able to add, update, and delete 
records while other users are limited to accessing, copying, and editing records (for incorporation into 
other products), and generating reports. The capabilities to search for and display records and incorporate 
those records into other work products are available to all users. Standard reporting functions are available 
to all users, but access to some specific reports is limited to the database administrator. The CDOCS user 
interface has be adapted to accommodate the specific capabilities and permissions available to the user so 
that only the authorized functions, document sets, and reports are presented.
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2.2 CONSOLIDATED DOCUMENT SYSTEM DOCUMENT SETS 

Following are the document sets contained in CDOCS.  

"* NRC Technical Documents database-Full-text technical documents submitted and 
maintained by DWM.  

" NRC Technical Documents Bibliography database-Bibliographic headers of technical 
documents submitted and maintained by the DWM.  

" National Institute of Science and Technology Materials database-Bibliographic headers for 
approximately 1,000 references; also contains 110 reviews of DOE documents associated 
with 20 data fields that permit access to the contents of pertinent technical information and 
reviewer comments, submitted and maintained by DWM.  

" Hydrology database-Bibliographic headers for references with cross references to reviews, 
maintained by DWM.  

" CNWRA Technical Document Index-An index of bibliographic headers of technical 
documents archived at the CNWRA.  

" CNWRA Technical Documents-A collection of full-text technical documents submitted by 
the CNWRA.  

" Correspondence Index-An index of bibliographic headers for correspondence.  

" CNWRA Quality Assurance Index-An index of bibliographic headers for QA documents 
maintained in the CNWRA QA records storage facility.  

" Correspondence-Full-text correspondence.  

" Regulations-A collection of selected statutes and regulations in full text.  

" NUREGS-A collection of selected NUREG documents in full text.  

" Staff Technical Positions-A collection of selected NRC Staff Technical Positions (STPs) in 
full text.  

" CNWRA Reports-Full-text deliverable reports produced by the CNWRA.  

" Review Plan Citations and Supplements (RPS)-Ful text applicable regulatory requirements 
and supplementary information for the LARP.  

" Compliance Determination Methods-Full text.  

" Compliance Determination Strategies-Full text.  

" Open Item Records-Full-text regulatory products.
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2.3 PRIMARY FUNCTIONS

2.3.1 Records Search and Retrieval 

CDOCS provides powerful and easy-to-use facilities for identifying and viewing records. The 
TOPIC search and retrieval software is used to find CDOCS records by searching for specific words or 
phrases in : (i) the text of the documents, and/or (ii) document header fields.  

2.3.2 Records Display and Print 

After being selected, a full-text record can be displayed and viewed on the screen and may also 
be printed or saved to an electronic file.  

2.3.3 Cut and Paste Facilities 

Full-text records may be cut and pasted, which permits copying the relevant text in documents.  
The text may be saved, incorporated into other documents, or printed.  

2.3.4 Reports View and Print 

CDOCS reports include: (i) database content and statistics reports, and (ii) reports composed of 
certain types of CDOCS records. Additional customized reports may be developed on request.  

2.4 MULTIPLATFORM IMPLEMENTATION OF THE CONSOLIDATED 
DOCUMENT SYSTEM 

CDOCS has been implemented in a multiplatform environment allowing use in diverse 
hardware/software environments. Therefore, while CDOCS functions the same in all supported hardware/ 
software environments, the appearance and operation of the system vary slightly. CDOCS runs on any of 
three different hardware/software environments: 

"* Microsoft Windows using IBM PS/2 or compatible hardware 

"* OPEN LOOK or MOTIF using Sun hardware 

"* IBM OS/2 using IBM PS/2 or compatible hardware 

"* Mackintosh using System 7 operating system 

The following sections describe the minimum requirements necessary to achieve acceptable 
system functionality and performance for each hardware and software environment. Instructions for 
installing CDOCS on each of the platforms are provided in Appendix A.  

2.4.1 Minimum Sun Workstation Requirements 

• Sun 4 Architecture (IPX or faster) 

• 32 MB random access memory (RAM)
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• 10 MB free hard disk space 

* Sun OS 4.1.3 or Solaris 2.3 

2.4.2 Minimum Windows Workstation 

• Intel 80486 central processing unit (CPU)-based computer 

* 8 MB RAM 

• 10 MB free hard disk space 

* Microsoft Windows Version 3.1 or later 

* File Transfer Protocol (FTP) Version 3.0 (also known as On-Net) by FTP Software 

2.4.3 Minimum OS/2 Workstation Requirements 

* Intel 80486 CPU-based computer 

* 16 MB RAM 

* 10 MB free hard disk space 

* IBM OS/2 Version 2.1 or later 

* IBM Transmission Control Protocol/Internet Protocol (TCP/IP) Version 2.0 or later, 

configured for Network File System (NFS) 

2.4.4 Minimum Macintosh Workstation Requirements 

* Power Macintosh 

* 32 MB RAM 

* 10 MB free hard disk space 

* System 7, or later 

2.4.5 Scanning Workstations 

2.4.5.1 Sun Scanning Workstation 

"• ScanWorX scanning software by Xerox 

"* Minimum Sun Workstation as described in Section 2.4.1 

"* Quarter inch QIC-24 or QIC-150 tape drive (for installing the ScanWorX software on the Sun 

Workstation)
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* ScanWorX scanner 

2.4.5.2 Windows Scanning Workstation 

"* M/Series Professional scanning software by Calera Recognition Systems 

"• DOS 5.0 or later 

"* Minimum Windows Workstation as described in Section 2.4.2 

"* Scanners: 

- Fujitsu 3096G, 3093E/3096E+, and Scan Partner 

- Hewlett Packard ScanJet Plus, IIc, and Ilp with an Automatic Document Feeder (ADF)
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3 USER GUIDELINES 

The previous chapters provided a general introduction to CDOCS and its primary functions. This chapter 
provides the basic information needed to use CDOCS.  

CDOCS has been designed to support users with various levels of computer experience. Mistakes made at 
the workstation will not damage CDOCS or introduce errors into the data in CDOCS. For security reasons, 
access to CDOCS is restricted to NRC and CNWRA staff members with appropriate User lIDs. Help is 
available from system menus, from the CNWRA Help Desk at (210) 522-5258, or from the NRC System 
Administrator at (301) 415-8087.  

3.1 TYPOGRAPHIC CONVENTIONS 

Throughout the User's Guide, the following typographic conventions are used: 

Screen menu names, menu items, and push-button names appear in italics with initial caps 
or as they appear on the screen 

Example: Select CDOCS from the menu bar of the CDOCS Main Menu.  

"* User input and system prompts appear in bold Courier typeface 

Example: Enter the path and file name: c: \wp51 \wp. exe 

"• Keystroke input from the keyboard appears as initial caps inside square brackets 

Example: Press [F1], then [Return] 

"* Keystroke input from the keyboard using combinations of keys (e.g., hold down the Ctrl 
key and press H) appears as initial caps, with the combination of keys joined by a plus 
sign, inside square brackets 

Example: Press [Ctrl+H] 

3.2 DEFINITIONS 

Following are some basic definitions for use with graphical user interfaces (GUIs). Further 
information about the standard GUIs for Microsoft Windows, MOTIF, and OS/2 may be found in Using 
Windows (Que Corporation, 1994), OSFIMOTIF Style Guide (Open Software Foundation, Inc., 1993), and 
the Object-Oriented Interface Design IBM Common User AccessTM Guidelines (IBM Corporation, 1992).  

Accelerator keys An alternate method of selecting menu items that is similar to mnemonics.  
However, unlike mnemonics, the accelerator keys may be used even when the 
pull-down menu is not displayed. For example, the accelerator key, [Ctrl+H] or 
[^H] (hold down the Ctrl key and press the "IH' key) may be used from any main
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Click

Drag

GUI

Mnemonics

Mouse

Mouse button

Select

menu to start the CDOCS help facility. The appropriate accelerator keys are 
displayed at the right of each menu entry.  

Objects in GUI applications are normally selected by using the mouse to position 
the cursor over the object and then pressing one of the mouse buttons. When the 
mouse button is depressed it makes a clicking sound. Thus, selection process is 
often described as "clicking" on the object.  

Many objects in a GUI presentation may be moved around on the screen. This is 
done by positioning the cursor over the desired object, depressing and holding the 
left mouse button, moving the cursor to the new location, and releasing the mouse 
button. As the cursor is moved with the mouse button depressed, the selected 
object follows the cursor movements. Thus, the object is "dragged" to the new 
location.  

A GUI is a presentation of information on a computer screen that takes advantage 
of high-resolution graphics and usually employs a mouse, menu bars, and other 
types of menus, overlapping windows, and icons.  

Alphabetic characters, indicated by an underscore that may be keyed to select the 
desired options rather than using the mouse. For example, the option in the 
Operations pull-down menu that permits the user to exit the CDOCS is 
represented by the menu entry "Exit." Either select this entry with the mouse or 
key the mnemonic, "x." 

A commonly used pointing device that has one or more buttons. When the mouse 
is moved, the cursor moves in a corresponding manner on the screen. When one of 
the mouse buttons is pressed, a signal is sent to the program that results in some 
interaction with the system.  

A button on a mouse that sends a signal to the system when pressed. Mouse 
buttons are used to select choices, initiate actions, or manipulate objects on the 
screen.  

Position the cursor on top of the item to be selected (e.g., menu name, button, 
icon, etc.) and press (or click) the left mouse button.

3.3 GRAPHICAL USER INTERFACE CONTROLS AND FEATURES

Cascading menu An area to the left or right of an entry in a pull-down menu that expands the 
options or functions available for that entry. Cascading menus provide a way to 
layer choices so that a user can have access to a wide range of functions without 
being confused by lengthy lists of choices. Selecting an entry in a cascading menu 
causes the related system function(s) to be performed.
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Cursor

Drop-down list 

Entry field 

Group box 

Help screen

Icon

List view

Maximize button

A visual cue that indicates where the next interaction with the computer screen 
will take place. Cursors are moved by the mouse or the cursor keys and provide a 
way to select and interact with things that appear on the screen.  

A variation of the list view in which only one item in the list is displayed until an 
action is taken to display the rest of the list. Drop-down lists are used in situations 
where a list view is needed but would crowd the window if always present.  

A location in a screen where entry or alteration of textual or numeric information, 
such as a file name, password, or version number, is allowed. Entry fields may 
accommodate single words or numbers, or single or multiple lines of text.  

An area in a screen that contains related information and controls. Group boxes 
are usually surrounded by a labeled square or rectangular line.  

A screen that contains information about how to use the system, recover from 
problems, select available choices, etc. Help screens can be used for assistance 
while learning to use the system. They can also serve as a refresher for users who 
have not accessed the system regularly or recently.  

A small image that represents a function or data object.  

A read-only field with one or more scroll bars that contains multiple entries. The 
list view is used to display a fixed or variable list of values, fields, or options (e.g., 
the list of all documents). Because the display area in a list view can be scrolled, 
the list can contain more items than can be displayed at one time in the display 
area.  

A control in the upper right-hand comer of the window that expands the window 
to its maximum size.

A presentation of options.

Menu bar 

Messages

Minimize button

An area extending across the top of a window below the window title that lists the 
menu entries. Selecting these menu entries causes either the related system 
functions to be performed or a pull-down menu with additional entries and options 
to be displayed. The existence of a pull-down menu is usually indicated by a small 
downward-pointing arrow or triangle at the right-hand side of an entry in the 
menu bar.  

Information displayed when there is a particularly important or urgent condition 
in the software in use. Messages often contain not only a description of a problem 
but also an explanation of how to correct the situation. They may also contain 
selections that assist in deciding how to continue working.  

A control in the upper right comer of the window that shrinks the window to an 
icon.
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Pane

Pull-down menu 

Push-button 

Radio buttons 

Sash line 

Scroll bar 

Sizing buttons 

Title bar 

Window

A defined area within a window that is used as a separately scrollable area.  
Windows are sometimes divided into two or more panes so that different but 
related information may be displayed and scrolled independently.  

A list of options extending below an entry in a menu bar that is displayed when a 
menu bar entry is selected. Pull-down menus contain choices and functions that 
are related to each other in some manner. Typically they contain additional menu 
entries and/or options related to the "parent" entry on the menu bar. Selecting an 
entry in a pull-down menu causes either the related system functions to be 
performed or a cascading menu with additional entries and options to be 
displayed.  

A labeled, rectangular or oval "button" that causes an action to be taken when it is 
selected. When a push-button is selected (e.g., by pressing the left mouse button 
when the cursor is over the push-button), it is shaded and appears to be depressed.  
The push-button remains shaded until the action is completed and then returns to a 
"normal," deselected appearance.  

Two or more related button controls that permit selection of mutually exclusive 
options. The selected option is shaded and appears to be depressed. When a 
different option is selected, the radio button for that option is shaded and 
depressed, and the previously selected radio button returns to a "normal," 
deselected appearance.  

A bold line separating two panes within a window.  

A control, usually positioned at the right-hand side or bottom of a window, that 
permits the contents of the window to be moved horizontally or vertically within 
the window.  

Controls in the comers of the window that can be used to change the size and 
shape of the window.  

An area at the top of the window containing a brief title of the window. Pressing 
the left mouse button when the cursor is in the title bar and "dragging" it moves 
the window to a new position on the screen.  

An area on the screen where data, icons, controls, etc. can be viewed. A window is 
bounded by a window border that separates the window from other windows on 
the screen. The window size and its contents may be changed and controlled by 
using a number of controls in the window border.

CDOCS has been implemented in a multiplatform environment allowing it to be accessed by 
users in diverse hardware/software environments. While CDOCS functions in the same way in all of the 
supported hardware/software environments, the appearence and function of the system will vary slightly.  
The Windows environment has been selected for the screens presented in this User's Guide. Sample
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NRC Sun User Menu New 

(Programs 

Utilities 

Properties 

Standard Applications 

NMSS Applications 

Experimental Applications 

Personal Menu 

HELP 

Exit...

Figure 3-1. Sample screen for a UNIX workstation 

screens for a UNIX workstation (Figure 3-1) and for disk operating system (DOS) Windows (Figure 3-2) 
are provided.  

All of the hardware/software environments employ a mouse to permit the user to quickly select 
options and traverse menus. Communication with the system is accomplished by positioning the cursor, 
using the mouse, and pressing the left button (except when the specific hardware/software environment 
requires use of the right button) to select the desired option. Most menu entries also include mnemonics 
and accelerator keys.  

3.4 SOURCES OF ASSISTANCE 

There are a number of sources that can provide assistance to the user: 

Help Screens-Help that can be activated by positioning the cursor and selecting the 
HELP button or menu entry is provided for each screen display.  

Training-Training for all NRC and CNWRA staff will be provided. Additionally, periodic 
training for new staff and retraining for any other staff will be provided on request.
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Figure 3-2. Sample screen for DOS Windows workstation 

Assistance-Telephone assistance is available by calling the CNWVRA Help Desk at 

(210) 522-5258, or the NRC System Administrator at (301) 415-8087.  

3.5 GETTING STARTED 

To get started, a proper workstation with CDOCS software installed (as described in 
Section 2.4) is required. The program is executed by clicking on the CDOCS icon and executing the 
correct logon procedures. While using CDOCS, various system status and error messages may be 
displayed to alert the user to conditions detected by the program. Many of these messages appear in their 
own windows, and must be cleared before continuing by selecting a push-button at the bottom of the 
message window. The wording of the messages, their meaning, and appropriate responses are described in 
Appendix B.  

CDOCS is normally started by selecting it on the screen display.  

1 . On a Windows workstation, double click on the CDOCS icon on the Windows desktop, 
the CDOCS application icon appears (Figure 3-3). Double click on the CDOCS 
application icon.  

On a Sun workstation, position the cursor on the desktop area of the screen and press the 

right mouse button (for MOTIF environment). A pull-down menu of functions appears.  

On an OS/2 workstation, double click on the CDOCS icon on the OS/2 desktop.  

2. Select CDOCS. The system starts CDOCS, and displays the CDOCS Logon screen, if 
required. Refer to Appendix A for logon instructions.
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Figure 3-3. Sample screen for Windows application icon 

3.6 CONSOLIDATED DOCUMENT SYSTEM MAIN MENU 

After CDOCS has been successfully started, the CDOCS Main Menu screen is 
displayed (Figure 3-4). The menu bar in this screen contains the major functions that the user is permitted 
to perform. Users with special permissions have additional entries available in the menu bar (see 
Section 5.2 and Section 6.2). For all users, the following entries appear in the menu bar of the CDOCS 
Main Menu: 

Operations-Copy a regulatory program or OITS record, use WordPerfect to edit a regulatory 
program or OITS record, change passwords (for CNWRA users), or exit from CDOCS 

Search-Use information searches to find and access CDOCS records 

Report-Access CDOCS report facilities to display and/or print standard reports 

Help-Access CDOCS help facilities to get more information about how to use CDOCS 

Functions may be selected by positioning the cursor on the menu bar of the CDOCS Main Menu 
and selecting the desired entry. Depending on the function selected, either a pull-down menu is displayed 
or the function selected is automatically executed.  

Mnemonics, where applicable, are available to facilitate selection of entries from the menus.  
Mnemonics are alphabetic characters, indicated by an underscore, that may be keyed to select the desired 
options rather than using the mouse. Accelerator keys (e.g., [Ctrl+H] or [AH]) are also available, and 
provide an alternate method of selecting functions from the pull-down menus under the main menu entries.
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Operations Search Report Help 

Figure 3-4. CDOCS main menu 

3.7 MAIN MENU-OPERATIONS ENTRY 

The Operations main menu entry permits performing general functions that are available to all 
users. Selecting Operations from the menu bar of the CDOCS Main Menu causes the Operations 
pull-down menu (Figure 3-5) to appear. This pull-down menu contains functions for: (i) copying a 
regulatory program or PITS record, (ii) using WordPerfect to edit a regulatory program or OITS record, or 
(iii) exiting CDOCS. CNWRA users also have the option to change passwords for their logging-in 
procedure. The database custodians have additional entries in the Operations pull-down menu to support 
their requirements (see Section 5.3 and Section 6.3). Scan capable workstations also have an additional 
entry to allow access to the scanning software.  

3.7.1 Operations-Copying Regulatory Program and Open Item Records 

The Copy entry in the Operations pull-down menu may be used to make electronic copies of 
information in the database by copying the record to diskettes or the local hard disk. The general process 
for copying a regulatory program or OITS record is to: (i) select the record to be copied from a list of 
available records, and (ii) indicate the name of the destination file where the system will copy the 
information. If you are copying a regulatory program or PITS record to a new destination file, you must 
enter the full path and file name in the Filename for Copy entry field. If you are copying the regulatory 
program or OITS record to an existing destination file, you may use the File Chooser facility to obtain the 
full path and file name of the existing destination file.

Figure 3-5. CDOCS-Operations pull-down menu
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To copy a regulatory program or OITS record:

1. Select the Operations entry from the menu bar in the CDOCS Main Menu (Figure 3-4).  
The system will display a pull-down menu (Figure 3-5) that contains options to: (i) copy 
regulatory program or OITS records, (ii) use WordPerfect to edit regulatory program or 
OITS records, (iii) change passwords (CNWRA users only), or (iv) exit CDOCS.  

2. Select Copy from the Operations pull-down menu. Alternatively, you may type the 
mnemonic [y] or the accelerator key [^y]. The Copy a Regulatory Program Record screen 
(Figure 3-6) will be displayed.  

3. Select the Document Type pull-down list indicator to display the pull-down list of 
document types.  

4. Select the desired document type from the Document Type pull-down list. Relevant 
information for the selected document type will appear in the list view. Note that the 
information in this list view may be scrolled horizontally and vertically.  

5. Position the cursor in the list view and select the line that contains the desired record by 
clicking on it with the left mouse button.  

6. If you are copying the record to a new file, you must enter the full path and file name in the 
Filename for Copy entry field.  

If you are copying the record to an existing fie, you may enter the full path and file name 
of the existing file, if known, in the Filename for Copy entry field. If you are not sure of 
the full path and file name of the existing file, you may let the CDOCS file management 
system assist you by selecting the File Chooser push-button next to the Filename for Copy 
entry field. This will cause a list of files in the current directory to be displayed on the File 
Chooser input screen (Figure 3-7), and you may position your cursor on the filename and 
select the desired file. If the desired file is in a different directory than the one being 
displayed by the file chooser, you may position your cursor and select a different 
directory. This will cause the names of the files in the new directory to be displayed so that 
you can select the desired file.  

When you have selected the desired file name you may click on the OK push-button on the 
File Chooser screen. This will cause the path and fie name of the selected fie to be 
copied to the Filenamefor Copy entry field, and the previous screen will be displayed. The 
currently selected path and file name will automatically be passed back to the previous 
screen.  

To exit the File Chooser screen, select the Cancel push-button. If you select the Cancel 
push-button to exit before selecting the Apply or OK push-button, any file names that you 
have selected will be discarded, and the original file name in the Filename for Copy entry 
field will not be changed.
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Figure 3-6. Copy a Regulatory Program Record 

7. Visually review the record you have selected and the file name and path that you have 

entered, and make changes if necessary. When all of the information is correct, select the 

Copy push-button at the bottom of the screen. The record will be copied to the specified 
destination fie.  

8. To exit, select the Close push-button at the bottom of the screen. If you select the Close 

push-button to exit before selecting the Copy push-button, any information that you have 

entered will be discarded, and the record will not be copied to the destination file.  

9. If you need assistance in using the copy function, select the Help push-button at the 
bottom of the screen to display additional information.
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Figure 3-7. File chooser input screen

3.7.2 Operations-Editing Regulatory Program and Open Item Records with 
WordPerfect 

You may use the WordPerfect entry in the Operations pull-down menu (Figure 3-5) to access 
copies of information in the database using WordPerfect. The general process for editing a regulatory 
program or OITS record using WordPerfect is to: (i) select the record to be edited from a list of available 
records, and (ii) start the WordPerfect software so that the selected record can be edited. The records edited 
through WordPerfect may not be stored directly in CDOCS, but can be saved on a diskette or on the local 
hard disk.  

To edit a Regulatory Program or OITS record using WordPerfect: 

1. Select Operations from the menu bar of the CDOCS Main Menu (Figure 3-4). The system 
will display a pull-down menu (Figure 3-5) that contains options for (i) copying regulatory 
program or OITS records, (ii) editing regulatory program or OITS records using 
WordPerfect, (iii) changing your password, or (iv) exiting the CDOCS.  

2. Select WordPerfect in the Operations pull-down menu. Alternatively, you may type the 
mnemonic [w] or the accelerator key [Awl. The Edit a Regulatory Program Record Using 
WordPerfect screen (Figure 3-8) will appear.
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Figure 3-8. Edit a Regulatory Program Record Using WordPerfect screen 

3. Select the Document Type pull-down list indicator to display the document types.  

4. Select the desired document type from the Document Type pull-down list. Relevant 
information for the selected document type will appear in the list view. Note that the 

information in this list view may be scrolled horizontally and vertically.  

5. Position your cursor in the list view and select the line that contains the desired record by 
clickin2 on it with the left mouse button. Visually review the record you have selected, 
and select a different record if necessary. When your selection is correct, select the Edit 

push-button at the bottom of the screen. This will cause the system to start WordPerfect 

using the record you have selected.  

6. Edit the record using the WordPerfect software and then save it to a diskette or your hard 
disk using standard WordPerfect procedures.  

7. To exit, select the Close push-button at the bottom of the screen. If you select the Close 

push-button to exit before selecting the Edit push-button, any information that you have 
entered will be discarded, and the record will not be edited using WordPerfect.  

8. If you need assistance in using the edit function, select the Help push-button at the bottom 
of the screen to display additional information.

3-12



3.7.3 Operations-Exiting from the Consolidated Document System 

To exit from CDOCS: 

1. Select Operations from the menu bar of the CDOCS Main Menu (Figure 3-4). The system 

displays a pull-down menu (Figure 3-5). One of the options on the pull-down menu is for 

exiting CDOCS.  

2. Select the Exit entry from the Operations pull-down menu. Alternatively, the mnemonic 

[x] may be typed or the accelerator key [F3] pressed. The system closes the users security 

permissions and authorities and terminates the CDOCS session. At this point, CDOCS has 

been successfully exited. To use CDOCS again, select the CDOCS entry on the desktop 

screen and perform a logon, if required, by entering User-ID and password through the 

CDOCS Logon screen (see Section B.2).  

3.8 MAIN MENU-SEARCH ENTRY 

CDOCS provides powerful and easy-to-use facilities for identifying and viewing records. The 

TOPIC search and retrieval software is used to find CDOCS records by searching for specific words or 

phrases in: (i) the text of the document, and/or (ii) document header fields.  

3.8.1 Accessing the Search Facilities 

The following steps are required to search for CDOCS records: 

1. Select the Search entry from the menu bar of the CDOCS Main Menu (Figure 3-4). The 

system displays the Search pull-down menu (Figure 3-9).  

2. Select the CDOCS entry from the Search pull-down menu. The CDOCS Search Selection 

displays as appropriate for NRC users (Figure 3-10) or CNWRA users (Figure 3-11) The 

search selection screen permits the user to select the document set or sets to be searched.

Figure 3-9. Search pull-down menu
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Figure 3-10. CDOCS Search Selection List for NRC users

3. Select the desired CDOCS document sets to be searched from the Selection List and click 
on the OK push-button at the bottom of the screen. The system starts the TOPIC search 
and retrieval facilities and displays a TOPIC Query Entry screen for simple queries 
(Figure 3-12). It takes a few seconds for the TOPIC full-text search and retrieval to be 
started, and several information and copyright screens display before the first TOPIC 
Query Entry screen appears.  

If a message appears indicating some sort of problem with configuration and/or some of 
the parameters needed by the TOPIC software, document the message by pressing the 
[Print Screen] key, and contact the CNWRA Help Desk at (210) 522-5258, or the NRC 
System Administrator at (301) 415-8087.  

Searches will be conducted on the entire content of the database for the selected document sets.  
Records entered full-text will have full-text and header information searched. Records entered with header 
information only will support searches only of that header information.
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Figure 3-11. CDOCS Search Selection List for CNWRA users

When the TOPIC search facility has been started, two windows are displayed. The background 
window is the TOPIC Main Menu, which contains a menu bar that permits selection of options pertaining 
to the query. The foreground window is the TOPIC Query Entry screen (Figure 3-12). This window 
permits entry of words and/or phrases to be used in searching for records. The name of the current query 
appears in the shaded title bar at the top of the TOPIC Main Menu screen. New queries have default names 
such as Untitled-l, Untitled-2, etc. If the user selects to save the query, TOPIC will prompt for a file name 
for the query during the save process (See Section 3.8.9.2).  

TOPIC queries are formulated in a very intuitive manner. The following summary of TOPIC 
syntax is intended to be an introduction that will permit the user to begin searching for records. Training 
will be provided as required. For more information on TOPIC syntax, contact the CNWRA Help Desk at 
(210) 522-5258, or the NRC System Administrator at (301) 415-8087.  

Enter words, phrases, or expressions to find the desired record.  

Words-Enter a single word or multiple words separated by commas to formulate a 
TOPIC query. Each word is used individually to search for documents and/or document 
headers containing that word. When multiple words (separated by commas) are entered, 
TOPIC retrieves documents containing any of the specified words. Commas act as 
Boolean OR operators.
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Figure 3-12. Topic Query entry screen 

Words are considered to be stems in that endings are ignored. For example, if the word 
market is entered, TOPIC selects documents that contain "market," "markets," 
"marketing," or "marketed." 

To look for a specific word, enclose it in double quotation marks to prevent it from 
matching as a stem.  

Words are considered to be case insensitive. Thus, for search purposes, words may be 
entered in lowercase, uppercase, or mixed case.  

Phrases-Multiple words may be entered, without separating them with commas, and the 
system treats them as phrases and retrieves only documents that contain corresponding 
phrases.  

To search for more than one phrase, separate the individual phrases with commas. For example, 
if the entry is RADIOACTIVE WASTE, HIGH-LEVEL WASTE, the system searches for documents 
containing either or both phrases.
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Within phrases, TOPIC treats words as stems. Thus, if the search phrase entry is, HIGH-LEVEL 
WASTE, TOPIC selects documents that contain the phrases: (i) "high-level waste...," (ii) "high-level 
wastes...," (iii) "higher-level waste...,. or (iv) "higher-level wastes ...  

To search for a specific phrase. enclose it in double quotation marks.  

Expressions-Indicate the required combinations of phrases and words by using special 
words such as "and," "or," and "not" to combine the words and phrases into expressions.  
When one of these reserved words is typed, TOPIC changes its appearance to indicate that 
the reserved word is being interpreted as a logical operator rather than as a word. For 
example, if the expression, WASTE AND CONTAINMENT is entered, the system 
interprets the word "and" as an operator, and displays the query terms as WASTE <AND> 
CONTAINMENT. This query would only retrieve documents that contain both the words 
"waste" and "containment." 

To use a reserved word such as "and," "or," or "not" as a word in a phrase, it must be enclosed in 
quotation marks to prevent the system from interpreting it as an operator. For example, WASTE "AND" 
EMPLACEMENT would be interpreted as a phrase rather than an expression because "and" is enclosed in 
quotation marks.  

3.8.2 Entering a Simple Query 

For simple queries, the TOPIC Query Entry screen (Figure 3-12) permits the user to enter words, 
phrases, and/or expressions to search and to view the resulting list of selected documents. The TOPIC 
Query Entry screen for simple queries contains an upper pane and a lower pane, separated by a sash line.  
The upper pane contains an entry field that can be scrolled if necessary. Words and/or phrases that are to be 
used for searching are typed into the entry field under the prompt: Enter words and phrases separated by 
commas.  

To enter a simple query: 

1. Position the cursor in the Enter words and phrases, separated by commas entry field of the 
upper pane of the TOPIC Query Entry screen for simple queries (Figure 3-12) and press 
the left mouse button. This activates the entry field. If a vertical cursor bar does not appear 
in the upper left-hand comer of the entry field, it may be necessary to move the scroll bar 
at the right side of the entry field in order to position the cursor at the top of the entry field.  

2. Type the desired word(s) and/or phrase(s) in the Enter words and phrases, separated by 
commas entry field. Note that the entry field is initially set up to display only a few lines.  
However, as many words and/or phrases can be entered as needed. If more information is 
typed in than can be held on a single line, the words wrap automatically to the next line. If 
more Lines than can be displayed in the entry field are typed in, the text scrolls 
automatically. To see text that has been typed in that is not currently visible in the entry 
field: (i) move the vertical scroll bar at the right side of the entry field, or (ii) make the 
entry field larger by selecting and holding the dark bar below the entry field and then 
dragging the bottom of the entry field downward.
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3. When all of the desired search words, phrases, and/or expressions have been entered, start 
the search either by: (i) pressing the [Return] or [Enter] key, or (ii) selecting the Retrieve 
push-button under the entry field. As the query is executed, several pieces of status 
information are displayed: (i) a colored bar at the right side of the window, under the entry 
field, fills from left to right to indicate how far the query has progressed; (ii) a message at 
the left side of the window, under the entry field, which has the form "Retrieved: 25 of 
150" updates continuously to show how many documents have been selected and how 
many have been examined by the query; and (iii) the results list in the lower pane of the 
window fills from top to bottom with a description of the selected records.  

3.8.3 Entering Form Queries 

TOPIC also supports the ability to search for words and/or phrases in specific "header" fields, 
such as document title, document type, status, etc. This type of query is called a form query, because the 
input screen looks like a structured form. When using a form query, the upper pane of the TOPIC Form 
Queryv Entry screen (Figure 3-14) contains a list of available fields, each with its own entry field. For each 
header field and its associated entry field, there is an option labeled Require. If this option is selected for a 
field, the field will be required for the search to be satisfied. Otherwise, the field will be considered 
optional.  

3.8.3.1 Selecting the Form Query Entry Mode 

TOPIC normally starts in simple query mode. The first query screen will be formatted to accept 
simple queries. To enter a form query, change to Form Query mode.  

To change TOPIC to form query mode: 

1. Select the Query entry from the menu bar of the TOPIC Main Menu screen. A pull-down 
menu appears with various query options (see Figure 3-13).  

2. Select the Form Query entry from the Query pull-down menu (Figure 3-13). The various 
search fields are displayed in the TOPIC Form Query entry screen (Figure 3-14).  

Words and/or phrases may be entered into a form query just as in a simple query, but the words 
and/or phrases are associated with specific fields. Thus, if the word "earthquakes" is searched for in the 
Title field, the resulting query will select all documents with the word "earthquakes" in the title.  

To enter search information into a form query: 

1. Enter the search word(s) and/or phrase(s) in the entry field next to the desired header field.  

2. Select the Require option for the field if the search information is required rather than 
optional.  

3. Repeat Steps # I and 2 for each desired field.
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Figure 3-13. TOPIC Query pull-down menu

4. When the search information for all desired fields has been entered, press the [Return] or 
[Enter] key or select the Retrieve push-button to start the query retrieval.  

3.8.4 Selecting Documents for Viewing from the Results List 

As a query runs, two pieces of information are updated in the status area immediately below the 
Query Entry pane. On the left of the status area, there is a message that displays the number of records 
selected out of the number of records that have been examined. On the right of the status area, there is a 
bar-indicator that fills with color, left to right, to indicate the percent of the query completed. When the bar 
is completely filled with color, the search has completed, and a brief description of the selected documents 
will appear in the results list located immediately below the status area (Figure 3-15).The results list 
contains the following information about each selected document: 

DOCUMENT_SET-A code indicating the type of document (e.g., NTD, TDI, NIST, etc.).
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Figure 3-14. TOPIC Form Query entry screen

TITLE-The title of the document appears in this field. Note that the title may be too long to 
display within the results list pane. If this is the case, select and move the horizontal scroll bar 
indicator at the bottom of the results list to shift the display left or right as needed.  

To select a document in the results list for viewing: 

1. Select the desired entry in the results list. The selected information is retrieved and 
displayed in a separate window. Documents stored in full-text will be displayed.  
Documents stored as header information only will display the header information.  

2. To view more than one document at a time, position the cursor and select additional 
documents. Each document is displayed in its own window.  

3. The TOPIC window may be maximized to include the entire screen..  

4. The individual document windows may be moved around within the TOPIC window to 
permit viewing of two or more documents concurrently. To move a document window: 
(i) position the cursor on the title bar, (ii) press and hold the mouse button, (iii) drag the
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Figure 3-15. TOPIC results list 

window to the desired location, and (iv) release the left mouse button to leave the window 
in its new position.  

3.8.5 Viewing Selected Documents 

When a full-text document has been selected from the results list for viewing, it will appear in a 
display window. The search term(s) used to retrieve the document will be highlighted (Figure 3-16), and 
"navigation" facilities are provided to permit a rapid "jump" through the document display to the next or 
previous occurrence of the search term 

To search for the next or previous occurrence of the search term: 

1. Select the Navigate options from the menu bar of the TOPIC Main Menu. The system 
displays the Navigate pull-down menu (Figure 3-17).
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Figure 3-16. TOPIC document display 

2. To find the next search term, select Next Highlight.  

3. To find the previous search term, select PreviQus Highlight.  

Facilities are provided to search for additional words and/or phrases that were not used as 
original search terms.  

To find additional words and/or phrases in the text: 

1. Select the Navigate option from the menu bar of the TOPIC Main Menu.  

2. Select the Eind Text entry in the Navigate pull-down menu. Another entry window is 

displayed where the word(s) or phrase(s) that are to be found can be entered (Figure 3-18).  

3. Enter the desired word(s) or phrase(s), and select Find Next to find the next occurrence or 
Find Previous to find the previous occurrence.  

4. Select Cancel to exit from the text search window.
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Figure 3-17. TOPIC Navigate pull-down menu 

Facilities are also provided to display the next or previous document in the selection list.  

To display the next or previous document in the selection list: 

1. Select the Navigate option from the menu bar of the TOPIC Main Menu.  

2. To display the next document in the selection list, select Next Document.  

3. To find the previous document in the selection list, select Previous Document.
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Figure 3-18. TOPIC navigation facilities find text screen 

3.8.6 Launching WordPerfect

A full-text document that has been selected for display may be viewed and/or edited with 
WordPerfect, but, it may not be saved directly into CDOCS. However, the user may freely access records 
from CDOCS, modify them, incorporate them into other work products, or save them on a local hard disk 
or a diskette.  

When a full-text document has been selected for display using the CDOCS search facilities, an 
icon and descriptive line (i.e., Edit document) appears at the top of the document (see Figure 3-19). If this 
icon is clicked, the system will start a WordPerfect session in another window using the selected document
WordPerfect functions can then be performed on this document. If the results of the WordPerfect session 
are saved, the WordPerfect save action will not modify the record in CDOCS.  

3.8.7 Displaying Images 

Many full-text documents contain graphical images, figures, etc., that may be displayed through 
the image display facilities of TOPIC. Images and text are stored in different formats, and a special facility 
is required to display images. The normal TOPIC display for documents includes the text and icons 
representing any graphical images. Figure 3-19 illustrates a document that contains an image represented
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Figure 3-19. TOPIC document display containing image icons 

by an icon embedded in the text. If an image icon is clicked, the system will start the image viewer in 
another window using the selected image (Figure 3-20).  

To view an embedded image from a TOPIC document display: 

1. Click on the icon for the desired image. The system displays the image in a separate 
window (Figure 3-20).  

2. When finished viewing the image, close the image window by clicking on the upper left 
comer of the window and selecting Close from the pull-down menu.  

3.8.8 Exiting from the Record Search Facility 

To exit from the Search facility: 

1 .Select the File entry in the menu bar at the top of the TOPIC Query Entry screen. The system 
displays the File pull-down menu (Figure 3-21)..
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Hydrological properties of the rock mass surrounding the engineered barrier system of a 
repository for the deep geologic disposal of nuclear waste may change due to various conditions 
such as stress changes aruund the repository from construction activities, dynamic ground motion 
associated with eathquakes, and rack ihemial expansiio due to the heat released from buried 
waste. TheIse c ges may result in large scale dynamic rock shearing which may cause fracture 
dilation andlor closure. The shearing process may continue well after permanent closure of the 
repository. All these aspects may alter the capability of fractures to conduct fluid. The presern of 
heat ctxold result in thermaL.mechanical-hydrological (TMH) coupled processes which must be 
understood in order to determine the fluid saturation distribution in the repository near-field.  
Modeling such coupled processes at very large scaks with imbedded fracture networks requires 
understanding fluid flow behavi and transpor at a smaller scale, such as the scale of a single 
fracture.  

In this study, two-phase relative perneabilifies of a single fracture to air and water have 
been nume rically nv1estigatel as part of an analysis of mechanical-hydrological (MH) coupled 

. .. . . . .. . ......  

gure 3-20. TOPIC image display 

2. Select the EXit entry from the File pull-down menu. TOPIC displays a message asking 

whether to save or discard the current query and waits for a response (Figure 3-26).  

3. In most cases, it is not desirable to save the current query. Select the Discard push-button 
under the message. The TOPIC full-text search and retrieval environment terminates, and 

the CDOCS Main Menu displays again.
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Figure 3-21. TOPIC File pull-down menu 

3.8.9 TOPIC-Detailed Functions

The following sections discuss items from the TOPIC Main Menu along with their associated 
pull-down menus in greater detail. Only selected features of the TOPIC full-text search and retrieval 
software are discussed in this User's Guide. For further information, see the appropriate TOPIC user's 
guide for the hardware/software platform or call the CNWRA Help Desk at (210) 522-5258, or the NRC 
System Administrator at (301) 415-8087.  

The menu bar of the TOPIC Main Menu contains entries that provide access to a number of 
capabilities of the TOPIC search and retrieval software. The TOPIC Main Menu bar options are: 

File-Start new queries and save the current query 

Edit-Cut, copy, paste, and search for specific text in a document display 

View-View different document displays 

Query--Change the type of query
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Launch-Start other programs such as WordPerfect 

Help-Get additional Help information 

3.8.9.1 TOPIC Main Menu-File Entry 

The TOPIC File pull-down menu is illustrated in Figure 3-21 

When the File entry in the TOPIC Main Menu is selected, the File pull-down menu appears.  
This pull-down menu contains the following options: 

New Query-Begin a new query definition 

Open Query-Open a previously defined and saved query so that it may be used and/or modified 

Open Selection-Open a selected item into a new window 

Save Query-Save the current query so that it may be used again and/or modified in the future 

Save As-Save the current query using a specified file name 

Save Topics--Save changes made to the TOPIC database during the current session 

Get Info-Display a window containing additional information about a selected document 

Query Manager-Display a window containing a list of the available queries 

Page Setup-Change the printer, margins, and/or page size used when printing information 
directly from TOPIC 

Print-Print information from the currently selected TOPIC screen 

Close-Close the currently selected TOPIC query screen 

Exit-Close all TOPIC query screens and exit from the TOPIC search and retrieval system 

Those TOPIC options which are most commonly used in the CDOCS are discussed as follows.  

TOPIC File Pull-down Menu-New Query Entry 

The New Query entry in the File pull-down menu permits start of a new query. If an existing 
query is active, that screen remains but an additional new query screen is created. The options selected in 
the TOPIC preference file determine the initial settings of query screens. Normally, a new query is started 
as a simple query. If a different type of query screen is desired, (e.g., a form query), change the query type 
by selecting the Query entry from the TOPIC Main Menu. (For a further discussion of how to select a 
different query type, see Section 3.8.3.1).
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To start a new query:

1. Select the File entry from the menu bar of the TOPIC Main Menu. The File pull-down 
menu appears.  

2. Select the New Query entry from the File pull-down menu. A new screen is created using 
the default query type (normally a simple query).  

3. To access a different type of query screen, use the Query entry in the TOPIC Main Menu 
to change the query type (see Section 3.8.3.1).  

TOPIC File Pull-down Menu-Open Query Entry 

The Open Query entry in the File pull-down menu permits retrieval of the definition of an 
existing query that was previously stored. If an existing query is active, that screen will remain but a new 
query screen will be created for the query that is being retrieved. The options selected for the existing 
query that is being opened will determine the initial settings of the query screen.  

To open an existing query: 

1. Select the File entry from the menu bar of the TOPIC Main Menu. The File pull-down 
menu appears.  

2. Select the Open Query entry from the File pull-down menu. An entry screen appears to 
permit location and selection of the name of the query definition file (Figure 3-22).  

TOPIC File Pull-down Menu-Save Query Entry 

The Save Querv entry in the File pull-down menu permits definition of the current query to be 
saved so that it can be retrieved and used in the future. The Save Query entry is normally used to save and 
update the definition of a named query that had been previously saved. The query name will not be 
changed. If the entry is used for a new query, a prompt will request the path and file name for the query 
(See Figure 3-23).  

To save an existing query: 

1. Select the File entry from the menu bar of the TOPIC Main Menu. The File pull-down 
menu appears.  

2. Select the Save Query entry from the File pull-down menu. If a previously named query is 
being saved, the query definition is saved, and no further action is required.  

If an unnamed query is being saved, one that has not previously been saved, an entry 
screen appears so that a path and file name for the query definition can be selected.

3-29



Figure 3-22. TOPIC Open Query screen 

TOPIC File Pull-down Menu-Save As Entry

The Save As entry in the File pull-down menu permits the definition of the current query to be 
saved with a new name, so that it can be retrieved and used in the future. The Save As entry is normally 
used to save an existing query definition, which has been updated, with a new name.  

To save an existing query using a new name: 

1. Select the File entry from the menu bar of the TOPIC Main Menu. The File pull-down 
menu appears.  

2. Select the Save As entry from the File pull-down menu. An entry screen appears so that a 
path and file name may be selected for the query definition (Figure 3-23).  

3. Select the desired path and enter the desired file name for the query. If possible, the name 
of the query should be descriptive and meaningful to support easy retrieval.
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Figure 3-23. TOPIC Save Query screen 

4. Select the OK push-button at the bottom of the entry screen to save the query.  

TOPIC File Pull-down Menu-Page Setup Entry 

The Page Setup entry in the File pull-down menu permits options to be set, including page 
height, page width, and margins, that control the appearance of printed information produced by TOPIC.  

To change the options for the setup of printed pages: 

1. Select the File entry from the menu bar of the TOPIC Main Menu. The File pull-down 
menu appears.  

2. Select the Page Setup entry from the File pull-down menu. An entry screen appears so that 
page setup options may be entered and/or changed (Figure 3-24).  

3. Enter the desired values in the entry fields for Page height, Page width, Left margin, Right 
margin, Top margin, and Bottom margin.
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Figure 3-24. TOPIC Page Setup screen 

4. Select the OK push-button at the bottom of the entry screen to save the page setup options.  

5. Select the Cancel push-button at the bottom of the entry screen to exit from the Page Setup 
entry screen without updating the page setup options.  

TOPIC File Pull-down Menu-Print Entry 

The Print entry in the File pull-down menu permits setting options that control printing 
information produced by TOPIC.  

To change the options for printing: 

1. Select the File entry from the menu bar of the TOPIC Main Menu. The File pull-down 
menu appears.  

2. Select the Print entry from the File pull-down menu. An entry screen appears so that print 
options can entered and/or changed (Figure 3-25).
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Figure 3-25. TOPIC Print screen

3. Enter the system name of the desired printer device in the Printer entry field. Contact the 

CNWRA Help Desk at (210) 522-5258, or the NRC System Administrator at 

(301) 415-8087 for specific information on printer devices.  

4. Select the option button for Print all to indicate whether to print the entire document or 

just selected pages. If the Print all button is depressed, the entire document is printed. If 

the Print all button is not depressed, only the specified pages of the document are printed; 

the beginning page must be entered in the From entry field and the ending page in the To 

entry field.  

5. Select the OK push-button at the bottom of the entry screen to print the document and save 

the print options.  

6. Select the Cancel push-button at the bottom of the entry screen to exit from the Print 

options screen without printing the document.
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TOPIC File Pull-down Menu-Close Entry

The Close entry in the File pull-down menu permits closing the current query window without 
exiting TOPIC. When the window is closed, TOPIC will display a screen that permits the current query to 
be saved or discarded (Figure 3-26).  

To close the current query window: 

1. Select the File entry from the menu bar of the TOPIC Main Menu. The File pull-down 
menu appears.  

2. Select the Close entry from the File pull-down menu. A screen appears that provides a 
choice of either discarding or saving the current query.  

3. Select the Save push-button to save the current query. This causes the TOPIC Save Query 
screen to appear (Figure 3-23).

Figure 3-26. TOPIC Close screen
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4. Select the Discard push-button to close the current query screen without saving the query.  

5. Select the Cancel push-button to exit from the Close options screen without closing the 
current query 

TOPIC File Pull-Down Menu-Exit Entry 

The Exit entry in the File pull-down menu permits closing all active current query windows and 
exit from TOPIC. When the last window is closed, TOPIC will display a screen that permits the user to 
exit.  

To exit TOPIC: 

1. Select the File entry from the menu bar of the TOPIC Main Menu. The File pull-down 
menu appears.  

2. Select the Exit entry from the File pull-down menu. A screen appears that allows 
cancelling the query and exiting from TOPIC.  

3.8.9.2 TOPIC Main Menu-Edit Entry 

When the Edit entry is selected from the menu bar of the TOPIC Main Menu, the Edit pull-down 
menu appears (Figure 3-27). This menu contains the following options: 

Undo-Reverse the previous operation to undo its effects 

Cut-Remove the highlighted text and copy it to a temporary area called the clipboard 

Copy-Copy the highlighted text to the clipboard.  

Paste-Insert the contents of the clipboard at the location of the cursor 

Clear Selection-Clear the selected TOPIC, document, etc., in a window 

Delete Selection-Delete the selected topic, document, etc., from the TOPIC database 

Select All-Highlight the entire text of the area identified by the cursor 

Add to Query-Add current query selections to an existing named query 

The TOPIC Edit pull-down menu is illustrated in Figure 3-27 . Those TOPIC options which are 
most commonly used in CDOCS are described below.  

TOPIC Edit Pull-down Menu-Undo Entry 

The Undo entry in the Edit pull-down menu permits reversing of the previous action. The Undo 
option is not always available because some actions do not lend themselves to being reversed. In these
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Figure 3-27. TOPIC Edit pull-down menu

circumstances the Undo option is grayed to indicate that it is not available. When the Undo option is 
available and is selected, the system is restored to its state before the previous operations. For example, if a 
Select All operation had been performed, the entire document would be highlighted. Selecting the LUndo 
option would reverse the highlighting resulting from the Select All option.  

TOPIC Edit Pull-Down Menu-Cut Entry 

The Cut entry in the Edit pull-down menu permits the user to remove highlighted text from the 
document and insert it in a temporary area called the clipboard. After text has been inserted into the 
clipboard by either the Cut or Copy operation, it may be inserted into a document using the Paste 
operation.  

To use the Cut option: 

1. Highlight the text that is to be cut by positioning the cursor at the first character, 
depressing and holding the left mouse button, moving the cursor to the last character to be 
cut, and releasing the left mouse button (click and drag).
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2. Select the Cut option from the Edit pull-down menu. The highlighted text is removed from 
the current document and stored in the clipboard. A Cut operation replaces the previous 
contents of the clipboard.  

TOPIC Edit Pull-down Menu-Copy Entry 

The Copy entry in the Edit pull-down menu permits the user to copy highlighted text from the 
document and insert it in a temporary area called the clipboard. After text has been inserted into the 
clipboard by the Copy operation, it may be inserted into a document using the Paste operation.  

To use the Copy option: 

1. Click and drag to select the text for copying.  

2. Select the Copy option from the Edit pull-down menu. The highlighted text is stored in the 
clipboard. The Copy operation replaces the previous contents of the clipboard.  

TOPIC Edit Pull-down Menu-Paste Entry 

The Paste entry in the Edit pull-down menu permits inserting the contents of the clipboard at the 
location of the cursor.  

To use the Paste option: 

1. Position the cursor at the location where the contents of the clipboard are to be inserted 
and click the left mouse button to establish the new cursor location.  

2. Select the Paste option from the Edit pull-down menu. The contents of the clipboard are 
inserted at the cursor location. The Paste operation does not affect the contents of the 
clipboard. Therefore, the contents of the clipboard may be pasted repeatedly at different 
locations in the document.  

TOPIC Edit Pull-down Menu-Select All Entry 

The Select All entry in the Edit pull-down menu permits highlighting an entire document.  

To use the Select All option: 

1. Position the cursor on the document to be selected and click the left mouse button to 
establish the new cursor location.  

2. Select the Select All option from the Edit pull-down menu. The entire document is 
highlighted to indicate that it has been selected and may be cut or copied.
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3.8.9.3 TOPIC Main Menu-View Entry 

The TOPIC riew pull-down menu provides options for altering the appearance of the TOPIC 

query and query results windows. When View entry is selected in the TOPIC Main Menu. the View 

pull-down menu appears (Figure 3-28). The View pull-down menu contains the following entries: 

Expand Selection-Expand the node for the selected topic, assists item, results folder, or group 

to show more detail 

Collapse Selection-Collapse the node for the selected topic, assists item, results folder, or 

group to show less detail 

Son-Select sorting criteria to be used in sequencing the query results list.  

Tree-Change the layout of the topic query to a tree format 

Outline--Change the layout of the topic query to an outline format

Figure 3-28. TOPIC View pull-down menu
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The View pull-down menu is illustrated in Figure 3-28. Those TOPIC options that are most 
commonly used in the CDOCS are described below.  

TOPIC View Pull-down Menu-Sort Entry 

A default sequence is defined for the query results lists. However, the results list sequence may 
be altered by selecting the 5ort option from the View pull-down menu.  

To change the Sort sequence for the query results list: 

1. Select the View entry from the TOPIC Main Menu. The View pull-down menu appears 
(Figure 3-28).  

2. Select the Sort entry from the View pull-down menu. A Sort Specification window appears 
(Figure 3-29).  

3. Select the Ascending or Descending radio button to specify ascending or descending 
sequence for the sort.

Figure 3-29. TOPIC Sort Specification screen
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4. Double clicking fields in the Sort by group box removes them from the sort. Another 
method is to: (i) highlight the field in the Sort by box that is to be removed, and (ii) click 
the Move button.  

5. Double clicking fields in the Available fields group box adds them to the sort. Another 
method is to: (i) highlight the field in the Available fields box that is to be added, and 
(ii) click the Move button.  

6. Select the Set push-button to save the new sort sequence.  

7. Select the Re-Sort push-button to apply the new sort sequence to the current results list.  

8. Select the Cancel push-button to discard the changes to the sort sequence.  

3.8.9.4 TOPIC Main Menu-Query Entry 

The TOPIC Query pull-down menu provides a method of altering various options associated 
with TOPIC queries. When the Query entry in the TOPIC Main Menu is selected, the Query pull-down 
menu appears (Figure 3-13).  

The Query pull-down menu contains the following entries: 

Start Retrieval-Start a query retrieval based on the current query defined in the query window 

Cancel Retrieval-Cancel the current query retrieval 

Merge Results-Merge the results of a retrieval when results have been obtained from multiple 
partitions 

Assists-Open the Assists window to display topics, words, and stems contained in the TOPIC 
database 

Add Operator-Add an operator in a topic query 

Add Child-Add a branch topic or a leaf topic to a selected parent.  

Add Sibling-Add a branch topic or a leaf topic as a sibling to a selected topic 

Simple Query--Conduct a simple query 

Form Query-Conduct a form query 

Topic Query-Conduct a topic query 

Query Options-Specify options for the query
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Choose Sources-Select a source or set of sources to be used in retrievals

The Query pull-down menu is illustrated in Figure 3-13. Those TOPIC options that are most 
commonly used in the CDOCS are described below.  

TOPIC Query Pull-down Menu-Assists Entry 

TOPIC includes a number of tools for assisting in formulating queries. These may be accessed 
through the Assists entry in the Query pull-down menu.  

To access the Assists window: 

1. Select the Query entry from the TOPIC Main Menu. The Query pull-down menu appears 
(Figure 3-13).  

2. Select the Assists entry from the Query pull-down menu. An Assists window appears 
(Figure 3-30).  

3. Select the desired Assists entry from the list in the Assists Window. See the TOPIC User's 
Guide for more information on this option.  

4. Click outside of the Assists window to close it.  

TOPIC Query Pull-down Menu-Simple Query, Form Query, Topic Query 

TOPIC provides facilities for three types of queries: (i) simple queries, (ii) form queries, and 
(iii) topic queries. The type of query selected determines the appearance and format of the query entry 
window. The desired type of query may be selected through the Query pull-down menu.  

To select the type of query: 

1. Select the Query entry from the TOPIC Main Menu. The Query pull-down menu appears 

(Figure 3-13).  

2. Select the query type from the Query pull-down menu.  

Instructions for entering simple queries and form queries may be found in Section 3.8.2 and 

Section 3.8.3.  

TOPIC Query Pull-down Menu-Query Options Entry 

TOPIC provides facilities for associating various options with queries. The query options may be 

selected through the Query Qptions entry in the Query pull-down menu.  

To select the query options: 

1. Select the Qjuery entry from the TOPIC Main Menu. The Query pull-down menu appears 
(Figure 3-13).
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Figure 3-30. TOPIC Assists pull-down menu 

2. Select the Query Qptions entry from the Query pull-down menu. A Query Q(ptions 
window appears (Figure 3-31).  

3. Select and/or enter the desired query options in this window.  

4. Select the OK push-button to close the Query Qptions window and save the options that 
have been entered and/or selected.  

5. Select the Cancel push-button to close the Query Qptions window and discard the options 
that have been entered and/or selected.  

TOPIC Query Pull-down Menu-Choose Sources Entry 

TOPIC provides facilities for limiting the scope of query searches to selected sets of documents.  
These selected sets of documents are called "sources." By selecting one or more particular sources, the
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Figure 3-31. TOPIC Query Options window 

number of documents searched may be limited and reduce the occurrences of unwanted documents from 
extraneous sources in the search results list.  

To select one or more sources: 

1. Select the Query entry from the TOPIC Main Menu. The Query pull-down menu appears 
(Figure 3-13).  

2. Select the Choose Sources entry from the Query pull-down menu. A Source Selection 
screen appears (Figure 3-32).  

3. Select one or more sources by clicking the entries in this window. Selected entries are 
highlighted.  

4. Select the OK push-button to close the Source Selection window and save the selected 
sources.  

5. Select the Cancel push-button to close the Source Selection window and discard the 
selected sources.
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Figure 3-32. TOPIC Source Selection screen 

3.8.9.5 TOPIC Main Menu-Launch Entry 

The TOPIC Launch pull-down menu provides options for starting other programs and functions 
from TOPIC. When the Launch entry in the TOPIC Main Menu is selected, the Launch pull-down menu 
appears (Figure 3-33). The Launch pull-down menu contains the following entries: 

Import from File-Import a named file of retrieval results and display them in a query window 

Export to File-Export the current retrieval results to a named file 

Export Topic to File (User Modifications)-Export the modifications that have been made to a 
topic to a named file 

Export Topic to File (Full Definition)--Export the full definition of a topic to a named file 

WordPerfect 5. 1-Start WordPerfect 5.1 

Write Results to File 

Only the WordPerfect 5.1 option is described below
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Figure 3-33. TOPIC Launch pull-down menu 

TOPIC Launch Pull-down Menu-WordPerfect 5.1 Entry

TOPIC provides facilities for starting WordPerfect, using a file selected from the TOPIC full-text 
repository.  

To start WordPerfect: 

1. Select the Launch entry from the TOPIC Main Menu. The Launch pull-down menu 
appears (Figure 3-33).  

2. Select the WordPerfect 5.1 entry from the Launch pull-down menu. WordPerfect is started.  

3.9 MAIN MENU-REPORT ENTRY 

The availability of reports depends on the users authorities and permissions. Reports that are 
authorized for viewing will appear on the Report pull-down menu. Figure 3-34 illustrates the report 
pull-down menu.
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Figure 3-34. Report pull-down menu 

3.9.1 Selecting, Displaying, and Printing Database Content Reports 

To select, display, and print a database content report: 

1. Select Report from the menu bar of the CDOCS Main Menu (Figure 3-4). The Report 
pull-down menu will appear (Figure 3-34).  

2. Select the Database Content entry from the Report pull-down menu. A cascading menu 
will appear that includes the names of the Regulatory Records reports in the Database 
Content group that are available to you.  

3. Select the desired report from the Database Content reports cascading menu. The report 
will be prepared and displayed on your screen (Figure 3-35). The report display screen 
may be scrolled in both the horizontal and vertical directions. To view any portions of the 
report that are not visible, position your cursor over the appropriate scroll bar, press the 
mouse button, and move the indicator until the desired information appears in the 
Regulatory Records Status Report Display screen.  

4. If you want printed output, select the Print push-button at the bottom of the Regulatory 
Records Status Report Display screen. The report display will be formatted and routed to a 
printer.  

5. When you have finished viewing and/or printing the report, you may close the Regulatory 
Records Status Report Display screen by selecting the Close push-button at the bottom of 
the screen.  

6. If you need assistance displaying or printing reports, you can select the Help push-button 
at the bottom of the Regulatory Records Status Report Display screen to display additional 
information.
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Figure 3-35. Regulatory Records Status Report 

3.9.2 Selecting, Displaying, and Printing Database Reports

Production of database reports is supported by the generalized report writer. This facility permits 
selection of a wide variety of information and report formatting. Once the information has been extracted 
from the database, it is formatted according to the selected report specifications and presented as a 
WordPerfect document. You may then view the WordPerfect document, print it, edit it, save it, or 
incorporate it into other work products. You cannot save an assembled or edited database report document 
back to the CDOCS database.  

To select a database report: 

1. Select the Report entry in the menu bar of the CDOCS Main Menu (Figure 3-4). The 
system will display The CDOCS Reports pull-down menu (Figure 3-34).  

2. Select Database Reports from the Report pull-down menu. Alternatively, you may press 
the accelerator key [AZ]. The Database Reports Selection List screen (Figure 3-36) will
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Figure 3-36. Database Reports Selection List

appear that includes a list view with the names of all database reports that are available to 
you.  

3. Select the desired report from the list of available database reports and click the View 
push-button at the bottom of the screen. The system will format the requested report as a 
WordPerfect document and start the WordPerfect software.  

Once the report has been formatted as a WordPerfect document, you may use the normal 
facilities of WordPerfect to view the document, edit it, print it, or save it. However, if you 
want to save the document, you must do so on a diskette or the local hard disk. You will 
not be permitted to save a database report document in CDOCS.  

4. To exit from the Database Reports Selection List screen, select the Close push-button at 
the bottom of the screen.  

5. If you need assistance in accessing database reports, select the Help push-button at the 
bottom of the Database Reports Selection List screen.
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3.9.3 Report Menu-Reference Report

The Reference Report contains listings of two NRC bibliographic databases: the NIST Citations 
and Hydrologic Database References. To display and print a CDOCS Reference Report: 

1. Select the Report entry in the CDOCS Main Menu (Figure 3-4). The CDOCS Report 
pull-down menu appears (Figure 3-34).  

2. Select the Reference Reports entry from the CDOCS Report pull-down menu. A list of 
available reference reports is displayed.  

3. Select the desired report from the list of reference reports. The selected report is displayed.  

4. Select the Print push button to print the report.  

3.9.4 Report Menu-Database Statistics 

The Database Statistics Report contains summary listings of the content of CDOCS by numbers 
of type of document and month/year of submittal. To display and print the CDOCS Database Statistics 
Report: 

1. Select the Report entry in the CDOCS Main Menu (Figure 3-4). The CDOCS Report 
pull-down menu appears (Figure 3-34).  

2. Select the Database Statistics entry from the CDOCS Report pull-down menu. The 
database statistics report is displayed.  

3. Select the Print push button to print the report.  

3.9.5 Report Menu-New Acquisitions Report 

The CDOCS New Acquisitions Report is designed to assist in tracking new acquisitions in the 
CDOCS system. The new acquisitions report is accessed through the CDOCS New Acquisitions Report 
selection screen (Figure 3-37).  

To use the CDOCS New Acquisitions Report: 

1. Select Report from the Main Menu (Figure 3-4). The Report pull-down menu is displayed 
(Figure 3-34).  

2. Select New Acquisitions from the Report pull-down menu. The CDOCS New Acquisitions 
Report selection screen is displayed (Figure 3-37).  

If the correct document set is not indicated in the Document Set drop-down list, select the 
drop-down indicator to display a list of available document sets and select the desired 
entry.
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Figure 3-37. New Acquisitions Report selection screen 

4. Enter the beginning date for the reporting period in the From Date entry field 
(Figure 3-38).  

5. Enter the ending date for the reporting period in the To Date entry field.  

6. Select the OK push-button to execute the report. The New Acquisitions Report screen is 
displayed (Figure 3-39).  

7. Select the Print push-button to print the report, if desired.  

8. Select the Close push-button to exit from the CDOCS New Acquisition Report selection 
screen.  

3.10 MAIN MENU-HELP ENTRY 

CDOCS provides on-line help that is configured to reflect the individual user's authorities and 
permissions.  

To access the on-line Help from the CDOCS Main Menu: 

1. Select Help from the menu bar of the CDOCS Main Menu (Figure 3-4). A Help pull-down 
menu appears with entries for Help and About (Figure 3-40).
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Figure 3-38. New Acquisitions Report selection example 

2. Select Help, or press the mnemonic key [h] or the accelerator key [Ctrl+H], a screen 
appears that provides information about how to use the Help facility.  

3. Select the About entry, or press the mnemonic key [a], a description of the CDOCS is 
displayed.  

To use the Help entry in the Help pull-down menu: 

1. Select the Help entry from the Help pull-down menu (Figure 3-40). The Help Index 
window is displayed (Figure 3-41).  

2. Select the desired entry from the Help Index window to display the help topics for that 
entry (Figure 3-42).  

Similar help functions are available from all other CDOCS and TOPIC search screens.
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Figure 3-39. New Acquisitions Report screen

Figure 3-40. CDOCS Help pull-down menu
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Figure 3-41. CDOCS Help Index
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Figure 3-42. CDOCS help screen
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4 SCANNING GUIDELINES 

4.1 INTRODUCTION 

Scanning is the process through which hard-copy documents are captured in electronic form. The 

document pages submitted for scanning may include text, images, or both text and images. In the scanning 

step, the hard-copy pages are scanned to capture an electronic image. Then the electronic image is 

processed for character recognition [also known as optical character recognition (OCR)]. During the OCR 

process, the digital image of each scanned page is analyzed and manipulated by software to recognize 

individual text characters and arrange them into words, sentences, paragraphs, etc. Some portions of the 

digital image of a page may contain nontextual features that cannot be processed for OCR. Other portions 

may contain specialized text, such as tables of numbers. A process called zoning permits these specialized 

nontextual portions of the image to be identified so that the OCR software can interpret or process them in 

an appropriate way.  

Scanning and OCR are imperfect processes whose accuracy may be affected adversely by a 

number of factors. Therefore, scanning, zoning, and OCR are normally followed by a document cleanup 

step in which the text produced by the OCR process is reviewed and edited manually to correct scannng 
and OCR errors.  

Figure 4-42 illustrates the data flow and relationships between the scanning, zoning, OCR, and 

document cleanup functions.  

The scanning process involves several distinct steps: 

"* The document is examined to determine if exception conditions must be accommodated.  

"• A user-supplied document name is entered and options for text and full-page images are 

selected.  

"* The pages are placed in the document feeder or on the scanner bed and scanned.  

"* Page images are zoned as required to designate areas of text versus areas of graphical images.  

" Pages of text are accessed through a special editor to correct scanning/OCR errors.  

" The corrected text is exported to the file system along with any associated images as a 

collection of related files for loading into the full-text and image repositories or for individual 

use.  

4.2 OVERVIEW OF DOCUMENT SCANNING FOR SUBMISSION TO THE 
CONSOLIDATED DOCUMENT MANAGEMENT SYSTEM 

For the purpose of this discussion, we will assume the document to be submitted to CDOCS is a 

single-page document- Every document page submitted to CDOCS must at minimum consist of a full page 

image. Other scanned information may be required, depending on the format of the document being 

submitted.
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Figure 4-1. Scanning data flow 

4.2.1 Single-Page Document with Only Plain Text 

Two scanner generated files are required: 

"• An image file of the full page 

"* An ASCII file of the scanned and OCR processed text 

"* A WordPerfect file generated from the ASCII file 

Depending on the layout of the page (single column text, multiple column text, footnotes, etc.) 
multiple zones may need to be defined and linked in the appropriate order to create a correct ASCII file
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of the text. Zoning is discussed in greater detail in Section 4.4 and in Appendices C and D which discuss 
the use of two different scanning application programs.  

4.2.2 Single-Page Document with Text and Images 

Three types of files may be required: 

"* An image file of the full page is always required.  

"* An ASCII file of the scanned and OCR processed text, including all pages, is always required.  

"* A WordPerfect file generated from the ASCII file.  

"* Additional image files may be created for each individually zoned image on the page.  

4.3 FACTORS AFFECTING THE QUALITY OF SCANNING AND OPTICAL 
CHARACTER RECOGNITION 

A number of factors, including the quality of printing, the alignment of the document in the 
scanner, the presence of folds or creases, can introduce distortion and cause the OCR process to 
misinterpret the scanned image. The following sections identify several of the common factors affecting 
the quality of scanning and OCR- Approaches to minimizing the impact of these factors on the scanning 
and OCR processes are discussed.  

4.3.1 Skewed Document Scanning 

Scanning occurs in a predictable sequence, from the top to the bottom of the page, and from the 
left to the right of each line. The top edge of the page serves as a reference for the scanning process and the 
image is assumed to be either parallel or perpendicular to this edge. When the scanned image is processed 
for OCR, the software also assumes reasonable alignment of the text with the top edge of the physical 
page. If the document is slightly skewed, individual lines of text may be broken into multiple lines. If the 
document is skewed excessively, the OCR process may produce unusable text because the skew may 
interfere with the recognition of individual characters. Therefore, it is important to avoid skewed document 
scanning because improper alignment of the document can have an adverse effect on the OCR error rate.  

If the scanner document feeder is being used, particular care should be given to positioning the 
document guides on the input tray. The document guides should be positioned firmly against the edges of 
the document stack and the documents should be positioned firmly against the feed mechanism. If the bed 
of the scanner is being used, particular care should be exercised in placing the document on the scanner 
bed to avoid skewed scanning and subsequent OCR errors.  

4.3.2 Orientation of the Document Pages 

It is important for the document to be properly oriented in the feeder or on the scanner bed. If a 
document is upside down or rotated from its expected orientation, the OCR software will have difficulty 
interpreting the image. Therefore, unusual orientations of document pages must be adjusted by rotating the 
image electronically before OCR processing is attempted. The scanning software has capabilities for 
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rotating images after scanning, but use of these capabilities requires manual intervention. Therefore, 

whenever possible, it is easier and preferable to orient the pages correctly before scanning begins.  

4.3.3 Interleaved Portrait and Landscaped Pages 

Most pages are printed in a "portrait" orientation where the text is aligned with the short axis of 

the paper. Other pages may be printed in a "landscape" orientation where the text is aligned with the long 

axis of the paper. In order to properly interpret the image, options must be selected that permit the OCR 

software to anticipate the page orientation as either portrait or landscape. However, some documents 

contain both portrait and landscape pages. When scanning such documents, it is necessary to select the 

predominate orientation for the entire document and then treat pages with different orientations as 

exceptions.  

If pages with portrait and landscape orientations are interleaved, the primary orientation is 

selected for the entire document, and image rotation facilities are used after scanning to adjust the 

orientation of exception pages before the OCR process is started for those pages. The ability to rotate the 

image is part of the zoning process. Therefore, if a document contains interleaved portrait and landscape 

pages, zoning should be deferred to permit individual adjustment of the orientation of exception pages. An 

alternative approach is to scan all pages in the document as if they had the predominant orientation (e.g., 

landscape or portrait), and then re-scan, or electronically rotate, any pages found with exception 
orientations.  

4.3.4 Scanning Bound Documents 

If the document is bound, it must be scanned using the bed of the scanning device. When 

scanning bound documents it is important that each page be properly positioned and aligned with the 

scanner to avoid skewed scanning. Bound documents present an additional problem. The scanner bed is 

flat, but the pages of a bound document are not necessarily flat because the binding causes pages to bend 

upward away from the scanner bed at the bound margin. This results in distortion of the image along the 

bound edge of the page that can degrade the OCR process. Therefore, it is very important to press bound 

documents firmly against the glass of the scanner bed to flatten the pages as they are scanned. If the 

document is excessively skewed or if the pages are not flat, the scanned image may be too distorted to 

permit effective OCR processing.  

4.3.5 White Space 

Empty space surrounds individual characters and separates lines, paragraphs, and columns. This 

empty space is known as "white space." Proper interpretation of digital images by the OCR software 

requires consistent white space. A very small amount of white space is required to distinguish adjacent 

characters. More white space is required to distinguish adjacent words. White space is also required 

between lines to distinguish the text on one line from text on the following line. Additional white space is 

required to distinguish multiple columns on a page.  

Many factors, including distorted characters, extraneous marks, unusual printing layout or 

format, etc., can interfere with the interpretation of white space and cause the OCR process to produce 

unsatisfactory results. There is little that can be done to compensate for insufficient white space between 

characters or lines. Documents with such printing problems produce large numbers of OCR errors that 

must be corrected manually during the document cleanup process.
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Document pages that are printed in multiple columns may also present OCR problems if the 
white space between the columns is not sufficient or is not consistent. The OCR software must distinguish 
between the spaces separating words and the spaces separating columns. If the white space between 
columns is wider than the white space between words and is consistent in its placement and width, the 
columns will be detected and interpreted correctly. However, if the white space between columns is too 
small, the OCR software may interpret it as spaces between words on lines that span the entire width of the 
page. This causes corresponding lines from the columns to be interleaved, and the resulting text is 
unusable. Zoning provides a solution for this problem by permitting the columns to be identified and 
sequenced individually.  

4.3.6 Inappropriate Contrast 

Black and white scanners rely on contrast to distinguish text, figures, and graphic images from 
white space. The underlying assumption of such hardware is that points that are dark are part of the image 
and points that are white are part of the white space. Unfortunately, images exist with widely varying 
intensities and levels of contrast. Adjustments are available to permit the hardware and software to be fine 
tuned to the optical characteristics of the document. However, some combinations of colors cannot be 
satisfactorily scanned on black and white scanners because of insufficient contrast between adjacent areas 
of similar colors. Also, copying (Xeroxing) of pages may result in reduced contrast. Therefore, care must 
be taken when scanning copied originals.  

4.3.7 Poor Quality Printing 

OCR is most effective when individual characters do not actually touch, because a small amount 
of white space is required to distinguish adjacent characters. Poor quality printing in which characters 
touch or are not well formed can adversely affect the OCR process. Making copies of documents distorts 
the individual characters because the lines that form the characters are thickened. Multigeneration 
reproduction, where copies are made of copies, compounds this problem and quickly distorts characters to 
the point where frequent OCR errors occur. After two or three generations, many characters on a copy may 
touch or even merge to the extent that effective OCR will not be possible. There is little that can be done to 
improve the OCR process for such documents. Therefore, it is important to obtain and use original copies 
for scanning whenever possible.  

4.3.8 Dot Matrix Printing 

Some computer printers form individual characters by printing a number of very closely spaced 
dots. Although the individual characters formed by such dot matrix printers appear to the naked eye to be 
well formed, the scanning and OCR processes may detect and misinterpret the white space between the 
individual dots that form the characters. A special dot matrix setting is available that may be used along 
with textual or numeric zoning to improve the accuracy of the OCR process. The dot matrix setting reduces 
the sensitivity of the OCR process so that characters formed by a dot matrix printer are not misinterpreted.

4-5



4.4 ZONING 

Zoning is the process that permits physical areas of a document page to be identified for special 
processing. Once the scanning process has produced a digital image of the page, zoning permits 
identification of image areas for special handling by drawing boxes around them (Figure 4-2). Multiple 
zones may be defined for a particular page and these zones may overlap. Thus, a page containing text, 
footnotes, figures, and equations may be zoned to identify areas containing these different kinds of 
information and to specify the type of processing appropriate for each. Zoning is used to address five major 
functions: 

"• Specify the type of information 

"• Exclude unwanted text or nontextual information 

"* Clarify boundaries 

"* Specify the order of OCR processing 

"* Designate areas for special processing 

4.4.1 Zoning to Specify the Type of Information 

A scanned page may contain various types of information.  

"* Text-Most pages are primarily textual in nature. The text may be arranged in a single 
column, multiple columns, or in irregular areas surrounding figures, photographs, or graphs.  
Zoning permits the areas containing text to be identified and designated for OCR processing.  

"* Images--CDOCS stores full page images of each page. Therefore, the entire page is normally 
zoned as an image. Other image features on the page, such as figures, graphs, photographs, 
etc., may also be zoned as individual images.  

"* Text and image-A zoning option is available to designate an area as being both text and 
image. By zoning areas as both text and image, a digital image of the area is retained and the 
entire area is designated for OCR processing.  

4.4.2 Zoning to Exclude Nontextual or Unwanted Information 

Those areas of a digital image that are not zoned as "text" are not to be processed by the OCR 
software. Therefore, zoning is used prior to the OCR process to exclude portions of a document page that 
may cause OCR errors. If a page contains several types of information, such as equations, figures, and text, 
zoning is used to explicitly identify the areas of text. When this is done, the OCR process skips the 
nontextual areas, such as equations and figures, and only attempts to convert the areas designated as text.  

Selective zoning may also be used to exclude areas of unwanted text. For example, many 
documents have headings on each page. The headings are textual in nature, but they do not contain useful 
information. Therefore, zoning is normally used to exclude page headings so that the OCR process will not 
insert the page headings into the main body of the text.
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B
...... authorIze to adudaeIn

Certain users. such as custodians and database 
-administrators have additional authorities and 
permissions that allow them to perform functions 
not available to most CDOCS users. This chapter 
discusses authorities, permissions, and functions 
available to database custodians. Where functions 
available to the database custodian are the same 
as those available to CDOCS users, reference is 
made to prior sections of the User's gide.  
Familiarity with the CDOCS primary tions 
presented in previous sections prepares thler 
to operate CDOCS and utilize these addition; 
functions.  

While access to CDOCS for retrieval and 
viewing is generally available to the NRC and 
CNWRA staffs, database custodians are

A 

C.

Figure 4-2. Zone examples: (A and B) Text zones linked to create a single text file (C) Ignore or 

exclude zone, and (D) Image zone
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Sauthorized to add, update, and 
delete records. After a record 

has been identified for entry 
into CDOCS, it is processed 
by the database custodian for 
submission. If records are to 
be updated or deleted, that 
action is also performed by the 
database custodian.  

CDOCS is a system that runs 
under security, and the user is 
part of that security. A 

atabase custodian must logoi 
ovide an appropriate 

Use and password (see 
Appendix B). When the 
custodian logs on to the 
system, the user's security 
permissions and authorities are 
made available to anyone 
using the terminal. Leaving 
the terminal unattended, but 
logged on, makes it possible 
for unauthorized users to gain 
access to CDOCS by using the 
logged-on user's security 
permissions and authorities.  
Therefore, CDOCS should 
always be exited whenever the 
terminal must be left 
unattended.  

5.2 CONSOLIDATED 
DOCUMENT SYSTEM 
MAIN MENU 

After the logon process has 
been completed, the system 
displays the CDOCS Main 

enu for the database



4.4.3 Zoning to Clarify Boundaries

As discussed in Section 4.3.5, white space is essential to permit the OCR process to distinguish 
characters, Lines of text, paragraphs, and columns. However, in some documents the white space between 
colunms may not be sufficient to permit the OCR software to properly interpret the image. In such cases, 
zoning is used to clarify boundaries so that columns are properly recognized and processedZoning to 
Specify the Order of Optical Character Recognition Processing 

Zoning serves another purpose in permitting nonstandard OCR sequences to be specified.  
Scanning occurs in a predictable sequence, from the top to the bottom of the page and from the left to the 
right of each line. OCR normally follows the same sequence. Therefore, the OCR text normally reflects the 
sequence in which the scanning process encountered the text. However, some document pages require a 
different OCR sequence. For example, a page containing footnotes at the bottom of the first column would 
insert the text of the footnote immediately following the last word in the column. This could result in the 
footnote appearing out of context in the middle of a sentence or paragraph. By individually zoning 
columns or paragraphs, the order in which the image is processed for OCR can be specified and unusual 
page layouts can be easily accommodated.  

4.4.4 Zoning to Designate Areas for Special Processing 

Certain portions of a page may require specialized OCR processing. For example, a portion of a 
page might contain text produced with a dot matrix printer. Other areas might contain tables consisting 
entirely of numbers. In such cases, the areas requiring specialized OCR processing are individually zoned 
so that the appropriate OCR options can be selected for them.  

4.5 EXAMINING THE DOCUMENT 

The condition, quality of printing, and orientation of the document can have significant impact 
on the effectiveness of the OCR process. Therefore, before scanning a document. it is important to examine 
all pages so that unusual conditions can be anticipated and appropriate options can be selected. If the 
document is creased or otherwise defective, the scanned image may cause OCR problems. If the document 
has interleaved portrait and landscape pages, options must be selected during zoning to accommodate the 
orientation of the individual pages.  

Images of pages are numbered consecutively as the pages are scanned. The sequence of the OCR 
processing also follows these consecutive page numbers. Therefore, the sequence in which document 
pages are scanned determines the page numbers and the resulting sequence of the OCR text. It is important 
for the pages of the document to be scanned in the proper order to avoid confusion and improper 
sequencing of the output text file. Out-of-sequence pages should be reordered and missing pages should be 
found and inserted in their proper location before scanning begins.  

Scanning may be done one page at a time, or an entire stack of pages may be scanned in a single 
operation. The scanning and zoning options for the document, such as the options to scan one page at a 
time or scan a stack of pages, are normally selected when scanning is initiated. Therefore, the document 
should be examined for conditions that require exception handling before scanning is started. Several 
conditions may require pages to be scanned individually: 

Bound documents cannot utilize the document feeder on the scanner and must be scanned one 
page at a time by positioning the document on the scanner bed.  
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"• Documents with many figures and equations may require zoning to prevent OCR processing 
of selected areas of the pages. This zoning may be done after each page is scanned or may be 
deferred until all pages have been scanned.  

"* Documents that contain pages with interspersed landscape and portrait orientation require 
special handling after scanning to reorient the image before OCR processing.  

"• Documents containing pages with footnotes may require individual zoning for those pages so 
that the footnotes will appear in an appropriate sequence in the OCR text.  

4.6 DETECTION OF OPTICAL CHARACTER RECOGNITION ERRORS 

Scanning and OCR are susceptible to many types of errors that can affect the usability of the 
generated text. Scanning/OCR errors are detected in two ways by the system: 

"• When the image is processed for OCR, the characters are recognized and stored. If there is 
sufficient ambiguity in recognizing a particular character, it is flagged as a suspected 
scanning/OCR error.  

"* Following the initial OCR processing, the text is subjected to a spelling check to detect 
potential errors caused by incorrect character recognition that was not sufficiently ambiguous 
to cause flagging as a scanning/OCR error.  

This automatic flagging of suspected errors facilitates document cleanup, but it is available only 
at the scanning station as an integral part the scanning/OCR/editing process. Once the document text and 
images have been exported, the error flagging is no longer available. Therefore, cleanup to correct OCR 
errors should be performed promptly while the source document is available for reference.  

An option is provided in the export process to flag the scanning/OCR errors with a user-specified 
character in the output text file. This permits the cleanup process to be performed on other machines using 
standard text editors or word processors. However, this approach is not generally recommended because 
the exported text file will not support pop-up images of the scanning/OCR errors.  

4.6.1 Scanner Options to Minimize Optical Character Recognition Errors 

Several options are available to allow the scanner to be fine tuned to the document. These 
adjustments are not utilized for most documents, but may be required for documents with very low or very 
high contrast. See Appendices C and D for additional details.  

4.6.2 Software Options to Minimize Optical Character Recognition Errors 

Several software options are available to minimize OCR errors. These options condition the OCR 
software to expect certain types of data, and thereby limit the opportunities for misinterpretation of 
individual characters. The use of these options can result in a dramatic reduction in the number of OCR 
errors. Therefore they should be used wherever appropriate for the data being scanned.  

• Dot matrix printing-This option conditions the OCR software to expect text printed on a dot 
matrix printer. The effect of this option is to make the OCR process slightly less sensitive so
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that the dots making up the individual characters will not be misinterpreted (see 
Section 4.3.8).  

Numeric data-This zoning option conditions the OCR software to expect only numeric data 
in a specified zone. Therefore, the number of ways a particular character's image can be 
interpreted is limited. For example, the digit V0' will not be interpreted as an alphabetic 'O', 
and a digit '1' will not be interpreted as an alphabetic '1' if numeric zoning is selected.  

4.6.3 User Dictionaries 

Following the OCR process, a spelling checker is utilized to detect potential OCR errors where 
there was not sufficient ambiguity to mark individual characters. However, the spelling checker may 
incorrectly flag a number of words as potential OCR errors simply because those words do not exist in the 
dictionary. To address the problem of these "false alarms," the system provides facilities for creating and 
maintaining user-defined dictionaries. Such dictionaries are very useful in identifying technical 
vocabularies that are specific to certain classes of document- Therefore, user-defined dictionaries should 
be created and maintained to expedite the document cleanup process.  

4.7 DOCUMENT CLEANUP 

While many suspected OCR errors can be detected and flagged automatically, the correction of 
those errors is an inherently manual process in which the operator compares the original document or 
image to the text generated by the OCR process. The manual cleanup of OCR text can be a very time 
consuming process, and it can also introduce additional errors if not performed carefully.  

When documents are scanned and processed for OCR through the CDOCS on-demand 
facilities, the need to perform document cleanup is determined by the degree to which the end user of the 
text is able to tolerate OCR errors. If the end user only wants the images, then cleanup of the text is 
inappropriate. However, if the end user wants to utilize the text by storing it or incorporating it in another 
work product, then some level of document cleanup should be performed. At a minimum, any characters 
flagged as ambiguous by the OCR process should be examined and corrected. Also, words flagged by the 
spell check process should be visually reviewed and corrected if necessary. Words that are flagged 
incorrectly during the spell check process because they do not exist in the dictionary should be added to 
the appropriate user-defined dictionary.  

When documents are scanned and processed for OCR through the CDOCS routine loading 
facilities, the need to perform document cleanup is great. This is because the impact on the effectiveness 
and usability of the system resulting from uncorrected scanning and OCR errors is extensive. CDOCS is a 
system that relies on full-text search and retrieval to locate and retrieve documents. Therefore, the user of 
the system must be able to formulate queries that will find the desired materials. This is predicated on the 
text being reasonably consistent and accurate. If the user searches for the word "containment" that word 
must exist in a document if the document is to be selected and retrieved. However, if scanning/OCR errors 
have distorted the spelling of the word (e.g., "contoinmant" rather than "containment," because the "a" 
was interpreted as an "o" and the "e" was interpreted as an "a"), the query will fail, and the document will 
not be selected.  

Single character errors do not present insurmountable problems, but when alignment or 
distortion problems cause more serious errors such as: (i) words filled with punctuation, (ii) words
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combined from separate lines, or (iii) multiple skipped words, the effectiveness of the search facilities are 
degraded. Uncorrected scanning/OCR errors are indexed in the full-text system and ultimately degrade the 
search and retrieval capabilities of the system. Therefore, appropriate document cleanup is necessary for all 
documents loaded into CDOCS.  

4.8 SCANNING SOFTWARE AND HARDWARE 

Scanning can be performed using either of the two following software packages. The necessary 
hardware is determined by the software.  

4.8.1 ScanWorX 

The scanning application software is ScanWorX by Xerox. System requirements are: 

"• Minimum Sun Workstation as described in Section 2.5.1.1 

"* Quarter inch QIC-24 or QIC-150 tape drive (for installing the ScanWorX software on the 
SUN Workstation) 

"* ScanWorX Scanner 

Refer to Appendix C ScanWorX-Scanning, Optical Character Recognition, and Document 
Cleanup for scanning instructions.  

4.8.2 M/Series Professional 

The scanning application software is M/Series Professional by Calera Recognition Systems.  
System requirements are: 

"• DOS 5.0 or later 

"* Minimum Windows Workstation as described in Section 2.5.1.2 

"* Scanners: 

- Fujitsu 

- 3096G 

- 3093E/3096E+

- Scan Partner 

- Hewlett Packard 

- ScanJet Plus, llc, and Up, with (ADFs)
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Refer to Appendix D Calera M/Series Professional-Scanning, Optical Character Recognition, 
and Document Cleanup for scanning instructions.
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5 DATABASE CUSTODIAN GUIDELINES 

The previous chapters provided a general introduction to CDOCS and its primary functions and described 
the functions available to most CDOCS users. This chapter introduces the functions that are available to 
the database custodians for inputting, updating, and deleting documents.  

5.1 CUSTODIAN AUTHORITIES AND PERMISSIONS 

This chapter discusses authorities, permissions, and functions available to database custodians.  
Where functions available to the database custodian are the same as those available to CDOCS users, 
reference is made to prior sections of the User's Guide. Familiarity with the CDOCS primary functions 
presented in previous sections prepares the user to operate the CDOCS and utilize these additional 
functions.  

While access to CDOCS for retrieval and viewing is generally available to the NRC and 
CNWRA staffs, database custodians are authorized to add, update, and delete records. After a record has 
been identified for entry into CDOCS, it is processed by the database custodian for submission. If records 
are to be updated or deleted, that action is also performed by the database custodian.  

CDOCS has security requirements, of which the user is part of that security. When the custodian 
logs on to the system. the custodian's security permissions and authorities are made available to anyone 
using the terminal. Leaving the terminal unattended, but logged on, makes unauthorized use possible.  
Therefore, CDOCS should always be exited whenever the user is finished or whenever the terminal must 
be left unattended.  

5.2 CONSOLIDATED DOCUMENT SYSTEM MAIN MENU 

After the logon process has been completed, the system displays the CDOCS Main Menu for the 
database custodian (Figure 5-1). This screen contains a menu bar at the top of the screen with the following 
major functions that can be accessed by the database custodian.  

Operations-Copy a regulatory program or OITS record, use WordPerfect to edit a regulatory 

program or OITS record, change passwords (for CNWRA users), or exit from CDOCS 

Search-Use full-text and/or fielded information to find and access CDOCS records 

Custodian-Perform operations to submit, update, delete, check-out/in CDOCS records and 
define, checkin, and retire regulatory program and OITS records

I OClerations Search Custodian Ren

Figure 5-1. CDOCS main menu for database custodians
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Report-Access CDOCS report facilities to display and/or print standard reports

Help-Access CDOCS help facilities 

5.3 MAIN MENU-OPERATIONS ENTRY 

The Operations entry in the menu bar of the CDOCS Main Menu permits performance of general 
functions that are available to ail users. Selecting Operations from the menu bar of the CDOCS Main Menu 
causes the Operations pull-down menu to appear (Figure 5-2). This pull-down menu contains the functions 
that the database custodian's level of access permits, including copying regulatory program records, using 
WordPerfect to edit regulatory program records, changing the password, and exiting CDOCS. For further 

information about how to use the Operations entry in the CDOCS Main Menu, see Section 3.7. For further 
information on Password Logon. see Appendix A.  

5.4 MAIN MENU-SEARCH ENTRY 

CDOCS provides powerful and easy-to-use facilities for identifying and viewing records in the 
database. The TOPIC search and retrieval software is used to find records by searching for specific words 
or phrases in: (i) the text of the document, and/or (ii) certain document header fields, such as the author or 
title. For further information about how to use the Search entry in the menu bar of the CDOCS Main Menu, 
see Section 3.8.  

5.5 MAIN MENU-CUSTODIAN ENTRY 

In addition to functions available to other users, CDOCS provides capabilities for submitting, 
updating, deleting, checking in, and checking out CDOCS records, and maintaining regulatory program 
and OITS records. These facilities are available to the database custodian through the Custodian entry in

Figure 5-2. CDOCS Custodian Operations pull-down menu
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the menu bar of the CDOCS Main Menu (Figure 5-t). When the Custodian entry is selected, a pull-down 
menu appears that contains entries for each of the maintenance functions available to the database 
custodian. Figure 5-3 illustrates the Custodian pull-down menu for NRC database custodians. Figure 5-4 
illustrates the Custodian pull-down menu for CNWRA database custodians.The NRC Custodian pull-down 
menu permits access to the following maintenance functions: 

submir Record-Use CDOCS maintenance facilities to add new CDOCS records 

Up-date Record-Use CDOCS maintenance facilities to update existing CDOCS records 

Delete Record-LUse CDOCS maintenance facilities to delete existing CDOCS records 

Process a Regulatory Record-Access facilities for maintenance of regulatory program and 
OITS records

Figure 5-3. CDOCS-NRC Custodian pull-down menu

Figure 5-4. CDOCS-CNWRA Custodian pull-down menu
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In addition to these capabilities, the CNWRA Custodian pull-down menu (Figure 5-4) contains 
the following functions that pertain to circulation control at the CNWRA library: 

Checkout Document-Use CDOCS maintenance facilities to check a hard-copy document out of 
the CNWRA library 

Checkin Document-Use CDOCS maintenance facilities to check a hard-copy document into the 
CNWRA library 

5.6 CUSTODIAN FUNCTIONS 

To access the database custodian facilities: 

1. Select Custodian from the menu bar of the CDOCS Main Menu. The system displays a 
pull-down menu containing options to Submit Record, Update Record, Delete Record, and 
Process a Regulatory Record (Figure 5-3 or Figure 5-4).  

2. Select the desired function from the Custodian pull-down menu. The system executes the 
selected function.  

5.6.1 Submitting New CDOCS Records 

When Submit Record is selected from the Custodian pull-down menu, the Submit a CDOCS 
Record entry screen (Figure 5-5) appears with the NRC Technical Document Set in the Document Set 
pull-down as the default. CDOCS contains a number of document sets, such as NRC Technical 
Documents, CNWRA Technical Documents, CNWRA Reports, and NUREGS. Fields that are not 
applicable to the currently selected document set, such as Addressee(s) and Duration, are grayed out and 
the field cannot be accessed. The Submit a CDOCS Record screen includes both mandatory and optional 
fields. Optional fields are indicated by an asterisk (*) next to the field name on the left side of the screen.  

The Document Number field is used to display the document number assigned by the system 
after the Submit push-button is selected. Therefore, no information is entered in the Document Number 
field.  

To enter the data in the fields for a specific document (this example illustrates a document from 
the NRC Technical Document set.  

1. Enter the author name in the Author(s) entry field. The author name is entered as a last 
name followed by initials. If there are multiple authors, their names should be entered 
separated by semicolons. For example: Johnson, G.M.; Smith, L.O.  

At the right side of the Author(s) entry field (and other fields such as Title and 
Publication), there is a small square push-button with three dots. This push-button is used 
to expand the entry field when there is more than one line of information to input. When 

this button is selected, a new screen appears with a scrollable entry field (Figure 5-6). The 
information may be entered as several lines. When the information has been entered, select
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Figure 5-5. CDOCS Submit-NRC Technical Document entry screen

the OK push-button at the bottom of the screen. The information that was entered is copied 
to the corresponding data field.  

2. Enter the title in the 7Ttle entry field. If the title is too long to fit in the Title entry field, 
select the push-button with three dots next to the Tile entry field to obtain an extended 
entry field screen (Figure 5-6). The title is normally entered with initial capital letters.  

3. In the Publication field, enter pertinent document information, such as publisher's name, 
publisher's location, pages, journal name, etc. If the information is too long to fit in the 
Publication entry field, select the push-button with the three dots next to the Publication 
entry field to obtain an extended entry field screen.  

4. Enter the document date in the Document Date entry field. The document date is entered 
in the form DD MON YYYY, where DD is two digits representing the day of the month, 
MON is a three-character abbreviation for the month, and YYYY is the full four-digit
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Figure 5-6. CDOCS Submit-extended entry-field screen 

year. If the day portion of the date is not available, enter "01" for the day. If the month is 

not available, enter "JAN" for the month.  

5. If appropriate, enter code(s) assigned to the document in the optional Code(s) field.  

Multiple codes may be entered separated by semicolons.  

6. If appropriate, enter the report number or other identifying number associated with the 

document, such as revision number or software vendor and version identifier in the 

optional Number(s) field. Multiple numbers may be entered, separated by semicolons.
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7. An optional field. Note, is provided to enter any other relevant information about the 
document.  

8. If the document is to be shared between the NRC and the CNWRA, click on the box next 
to sharable. If the document is not to be shared, do not click the box. The effect of making 
a document shareable is defined below: 

"* Shared-Both local and remote databases are updated.  

"* Unshared-Local database is updated. remote database is not updated.  

9. At the bottom of the screen is a field titled Directory where files reside. The field is 
initialized to "None" indicating a header only document. If the document includes text, 
word processing, and/or image files, the directory where the files are stored must be 
specified in this field. Enter the directory name or use the drop-down indicator at the right 
of this field to select the directory where the text, word processing, and image files for the 
document that is being submitted are located (Figure 5-7). If the directory does not appear 
in the drop-down list, then key in the path to the directory.

Figure 5-7. CDOCS Submit-directory where files reside
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10. After entering all of the information for the record, review it for completeness and 
accuracy and make corrections as needed. To submit the record to CDOCS, select the 
Submit push-button at the bottom of the screen.  

When the Submit push-button is selected, the transaction is validated. If errors are found, 
appropriate error messages are displayed. If no errors are found, the Submit transaction is 
accepted, an advisory message is displayed, and a document number is assigned to the 
record. The document number is displayed in the Document Number field at the top of the 
screen.  

After the Submit transaction has been processed and the advisory message has been 
cleared, the screen is locked, but the information entered in the previous Submit 
transaction remains in the input fields. This action permits efficient submission of sets of 
related documents by altering only the information that has changed.  

11. To enable the Submit a CDOCS Record screen so that a new record may be entered, select 
the Reset push-button at the bottom of the screen. The entry screen is enabled to permit 
entry of the information for the next record.  

12. To exit from the document submission process, select the Close push-button at the bottom 
of the screen.  

5.6.2 Updating Records from the Consolidated Document Management System 

CDOCS document updates are always handled as a complete replacement of the existing 
document header record and, optionally, a replacement of the document text and image files. If new text 
and image files are submitted. the existing files are deleted, and the new files are added to the CDOCS 
database. Updating a record requires that the user specify the document set and document number that was 
assigned automatically when the record was submitted to CDOCS. These two data elements (document set 
and document number) uniquely identify the record to be updated. If it is necessary to locate a document 
number, use the TOPIC full-text search facility to retrieve the document. The document number is 
displayed in the header information.  

To update a CDOCS record: 

1. If the CDOCS Update screen (Figure 5-8) is not visible, select Update Record from the 
Custodian pull-down menu in the CDOCS Main Menu (Figure 5-3).  

The CDOCS Update screen appears and the Document Set drop-down list is initialized to 
NRC Technical Documents by default (Figure 5-8). To select a Low-Level Waste record 
for update, the Document Set must be changed to Low-Level Waste. If necessary, select 
the Document Set drop-down indicator and then select Low-Level Waste to change the 
document set.  

2. Key in the number of the document to be updated in the Document Number entry field.
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Figure 5-8. CDOCS Update screen

3. Select the OK push-button at the bottom of the screen. The CDOCS Update entry screen is 
displayed (Figure 5-8).  

The CDOCS Update entry screen is very similar to the CDOCS Submit screen. The 
Document Number field displays the number entered in the CDOCS Update screen. This 
number cannot be updated.  

4. Key in the updated document header information in the appropriate fields of the CDOCS 
Update entry screen (Figure 5-9).  

5. The effect of the shareable flag during a record update is defined in Table 5-1.  

Note: A shared document cannot be updated as unshared. If the Sharable button is grayed 
in the update screen, then the document is shared. To update and unshare a document, the 
document must be resubmitted as unshared.  

6. If new ASCII text, word processing, or image files are to be submitted with the update, 
select the path to the directory from the Directory where files reside field drop-down 
menu, or key the path to the directory into the field. If no files are being submitted, select 
"None" in the Directory where files reside field. If no files are submitted, only the 
document header is updated.

5-9



Figure 5-9. CDOCS Update entry screen

Table 5-1. Effect of sharable flag during record update 

Updated 
Prior Sharing Sharing 

Status Status Local Database Remote Database 

Shared Unshared A shared document cannot be updated as unshared. The unshared 
update must be submitted as a new document.  

Unshared Shared Record is updated. Record is submitted.  

Shared Shared Record is updated. Record is updated.  

Unshared Unshared Record is updated. No action.
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7. When all of the updated information has been entered, select the Update push-button at the 
bottom left of the screen. When the update has been successfully completed, a 

confirmation screen displays (Figure 5-10). To exit the record update screen without 

performing an update, select the Close button.  

5.6.3 Deleting Records from the Consolidated Document System 

CDOCS includes facilities for deleting records from the document sets. Deletion of records 
requires that the user specify the document set and the document number that was assigned automatically 
when the record was submitted to CDOCS. These two data elements uniquely identify the record to be 

deleted. If it is necessary to locate a document number, use the TOPIC search facility to retrieve the 
document. The document number is displayed in the header information.

Figure 5-10. CDOCS Update confirmation screen
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To delete a record from CDOCS:

I If the CDOCS Delete screen (Figure 5-11) is not visible, select Delete Record from the 
Custodian pull-down menu in the CDOCS Main Menu (Figure 5-3). The Delete Record 
entry screen (Figure 5-11) appears and the Document Set drop-down list is initialized to 
the default document set-NRC Technical Documents. For example, to select a 
Low-Level Waste record for deletion, select the Document Set drop-down indicator and 
then select Low-Level Waste.  

2. Enter the document number of the document to be deleted in the Document Number entry 
field and press the OK push-button. The document deletion confirmation screen displays 
(Figure 5-12).  

3. Set the shareable flag as required by selecting the Shareable box. The result of deleting 
shared files is defined below: 

* Shared record-deleted in both local and remote databases.  

v Unshared record-deleted in local database; no action is taken at remote database.  

4. Verify that the document displayed is the document to be deleted. If the document 
displayed is the document to be deleted, press the Delete push-button at the bottom of the 
screen. When the document has been deleted, the system displays a Document Deleted 
response screen (Figure 5-13).

Figure 5-11. CDOCS Delete screen
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Figure 5-12.CDOCS Delete confirmation screen

Figure 5-13. Document deleted response screen
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If the document displayed is not the document to be deleted, press the Close push-button 
to exit the screen without deleting the document.  

5.7 CUSTODIAN FUNCTIONS FOR REGULATORY RECORDS 

When the Custodian entry is selected, a pull-down menu appears that contains entries for each 
of the maintenance functions available to the database custodian. Figure 5-3 illustrated the Custodian 
pull-down menu for the NRC database custodian. Figure 5-4 illustrated the Custodian pull-down menu for 
CNWRA database custodians. When the Process a Regulatory Record entry is selected from the 
Custodian pull-down menu a cascading menu appears that contains options for maintaining regulatory 
records (Figure 5-14). The Process a Regulatory Record cascading menu permits access to the following 
maintenance functions: 

Define a Regulatory Record-Use CDOCS maintenance facilities to define new regulatory 
records.  

Retire a Regulatory Record-Use CDOCS maintenance facilities to retire existing regulatory 
records.  

Format Check a Regulatory Record-Use CDOCS maintenance facilities to check the format of 
a regulatory record.  

Enter a Regulatory Record-Use CDOCS maintenance facilities to enter a new version of a 
regulatory record.

Figure 5-14. CDOCS Process a Regulatory Record cascading menu
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1. Select Custodian from the menu bar of the CDOCS Main Menu. The system displays a 
pull-down menu containing options to Submit Record, Update Record,. Delete Record, and 
Process a Regulatory Record (Figure 5-3).  

2. Select Process a Regulatory Record from the Custodian pull-down menu. The system 
displays a cascading menu containing options to Define a Regulatory Record, Retire a 
Regulatory Record, Format Check a Regulatory Record, and Enter a Regulatory Record 
(Figure 5-14).  

3. Select the desired function from the Process a Regulatory Record cascading menu. The 
system executes the selected function.  

5.7.1 Defining New Regulatory Records 

Record header information, such as title and review plan number for regulatory program records, 
and OITS identifier and OITS topic for OITS records, must be preloaded in the database before textual 
data associated with the regulatory records may be checked in. Conceptually, the record header preloading 
process creates a place for the data, and the entry process actually stores the textual information. When a 
record is preloaded, the system reserves space in the relational database and in the full-text repository by 
formatting and storing placeholder records that contain the text.  

The record definition and header preloading process requires an entry screen through which the 
document type, review plan number, and title are entered. To define a new regulatory program record: 

1. Select Custodian from the menu bar of the CDOCS Main Menu. The system displays a 
pull-down menu containing options to Submit Record, Upidate Record, Delete Record, and 
Process a Regulatory Record (Figure 5-3).  

2. Select Process a Regulatory Record from the Custodian pull-down menu. The system 
displays a cascading menu containing options to Define a Regulatory Record, Retire a 
Regulatory Record, Format Check a Regulatory Record, and Enter a Regulatory Record 
(Figure 5-14).  

3. Select the Define a Record entry from the Process a Regulatory Record cascading menu.  
Alternatively, you may press the mnemonic key [d]. The Define a Regulatory Program 
Record entry screen appears (Figure 5-15).  

4. Select the Document Type pull-down indicator to display the pull-down list of document 
types (Figure 5-16), and select the desired document type (CDS, CDM, RPS, or OITS).  
The drop-down list will display the selected type of document and the Define a Regulatory 
Program Record entry screen will be prepared for entry of data.  

5. Enter the review plan number for the new record in the Review Plan Number entry field 
(Figure 5-15).  

6. Enter the title for the new record in the Title entry field. Note that if you type more than 
one line, the title will automatically wrap to another line. If you enter more information
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Figure 5-15. Define a Regulatory Program Record input screen 

than will display in the Title entry field, you may view the information that is not currently 

visible by moving the vertical scroll bar at the right-hand side of the Title entry field.  

7. Visually review the information you have entered and make corrections if necessary.  

When all of the information is correct, select the Define push-button at the bottom of the 

Define a Regulatory Program Record entry screen to accept the record and update the 
database.  

If an error is detected (e.g., the review plan number already exists for the type of document 

you have selected), an error message will display, and you will not be permitted to 
continue until the error condition has been resolved.  

A few seconds are required to update the database. During this time, the Define 

push-button will remain shaded, and the system will be locked to prevent further entry of 

information. When the update has been completed, the Define push-button will return to
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Figure 5-16. Define a Regulatory Program Record document type selection 

its normal appearance, and a message will display indicating whether or not the update 
was successful. If, for any reason, the update was not successful, an error message will 
display, providing further information and instructions. In general, only internal system 
problems will make the update process fail. Therefore, if an error message appears 
indicating that the update was not successful, you should follow the instructions in the 
error message and/or its associated help message, and contact the database administrator 
immediately at (210) 522-5258.  

8. To exit from the Define a Regulatory Program Record screen, select the Close 
push-button at the bottom of the screen. If you select the Close push-button to exit before 
selecting the Define push-button, any information that you have entered will be discarded.
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5.7.2 Defining New Open Item Tracking System Records 

Record header information for OITS records, such as OITS identifier and topic, must be 

preloaded in the database before textual data associated with the records may be entered. As with 

regulatory program records, the record header preloading process creates a place for the data, and the 

check in process actually stores the textual information. When a record is preloaded, the system reserves 

space in the relational database and in the full-text repository by formatting and storing placeholder records 

that contain the text.  

The OITS record definition and header preloading process requires an entry screen through 

which the document type, OITS identifier, and topic are entered. When the define functionality is selected, 

the record definition screen for regulatory program records appears (Figure 5-3). When the OITS option is 

selected for Document Type, the appearance of the screen changes to accommodate entry of OITS 
information (Figure 5-17).  

To define a new OITS record: 

1. Select Custodian from the menu bar of the CDOCS Main Menu. The system displays a 

pull-down menu containing options to Submit Record, Up-date Record, Delete Record, and 
Process a Regulatory Record (Figure 5-3).  

2. Select Process a Regulatory Record from the Custodian pull-down menu. The system 
displays a cascading menu containing options to Define a Regulatory Record, Retire a 

Regulatory Record, Format Check a Regulatory Record, and Enter a Regulatory Record 
(Figure 5-14).  

3. Select the Define a Record entry from the Process a Regulatory Record cascading menu.  
Alternatively, you may press the mnemonic key [d]. The Define a Regulatory Program 

Record entry screen appears (Figure 5-15) 

4. Select the Document Type pull-down indicator to display the pull-down list of document 
types (Figfure 5-16), and select the OITS document type.  

The Document Type drop-down list will display OITS and the Define an OITS Record 

entry screen will be prepared for entry of data (Figure 5-17).  

5. Enter the OITS identifier for the new record in the OITS ID entry field.  

6. Enter the topic for the new record in the Topic entry field. Note that if you type more than 

one line, the topic will automatically wrap to another line. If you enter more information 

than will display in the Topic entry field, you may view the information that is not 

currently visible by moving the vertical scroll bar at the right-hand side of the Topic entry 
field.  

7. Visually review the information you have entered and make corrections if necessary.  
When all of the information is correct, select the Define push-button at the bottom of the
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Figure 5-17. Define an OITS Record

Define an OITS Record entry screen to accept the record and update the database.  

If an error is detected (e.g., the OITS identifier already exists), an error message will 
display, and you will not be permitted to continue until the error condition has been 
resolved.  

A few seconds are required to update the database. During this time, the Define 
push-button will remain shaded, and the system will be locked to prevent further entry of 
information. When the update has been completed, the Define push-button will return to its 
normal appearance, and a message will display indicating whether or not the update was 
successful. If, for any reason, the update was not successful, an error message will display 
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providing further information and instructions. In general, only internal system problems 
will make the update process fail. Therefore, if an error message appears indicating that 
the update was not successful, you should follow the instructions in the error message 
and/or its associated help message, and contact the database administrator immediately at 
(210) 522-5258.  

8. To exit from the Define an OITS Record screen, select the Close push-button at the bottom 
of the screen. If you select the Close push-button to exit before selecting the Define 
push-button, any information that you have entered will be discarded.  

5.7.3 Enter New and Updated Records 

Once a record has been defined in the database, the textual information associated with that 
record may be entered. The check in process is used: (i) whenever the text of a new record is loaded for the 
first time or (ii) whenever a record's text is changed and reloaded. The information to be entered is 
submitted as a WordPerfect file on a diskette or on the network hard disk. This data file must be correctly 
identified and validated through the appropriate entry screen before the data is accepted and updated in 
CDOCS.  

The entry screens for regulatory program records (CDS, CDM, and RPS) differ from those for 
OITS. Therefore, the entry processes for regulatory program and OITS records are treated separately.  

5.7.4 Enter Regulatory Program Records 

To enter a regulatory program record: 

1. Select Custodian from the menu bar of the CDOCS Main Menu. The system displays a 
pull-down menu containing options to Submit Record, Update Record, Delete Record, and 
Process a Regulatory Record (Figure 5-3).  

2. Select Process a Regulatory Record from the Custodian pull-down menu. The system 
displays a cascading menu containing options to Define a Regulatory Record, Retire a 
Regulatory Record, Format Check a Regulatory Record, and Enter a Regulatory Record 
(Figure 5-14).  

3. Select the Enter a Regulatory Record entry from the Process a Regulatory Record 
cascading menu. Alternatively, you may press the mnemonic key [c]. The Enter a 
Regulatory Program Record entry screen will appear and the Document Type pull-down 
indicator will be set to the default value of CDM (Figure 5-18).  

4. If a different document type is required, select the Document Type pull-down indicator to 
display the pull-down list of document types, and select the desired document type (e.g., 
CDS, CDM, or RPS) (Figure 5-19). All of the active and defined review plan numbers and 
titles for the selected document type will appear in the Review Plan Number and Title list 
view. Note that the information in this list view may be scrolled horizontally and 
vertically.
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Figure 5-18. Enter a Regulatory Program Record input screen

5. Select the line in the Review Plan Number and Ttle list view that contains the desired 
review plan number and title.  

6. Select either the Major Revision or Minor Revision radio button under the Entry Type: 
heading 

7. Enter the appropriate number in the New Version Number entry field for the document 
being entered. The system will also compute a new version number based on the current 
version number and the type of change (major or minor). This new computed version 
number will be compared to the version that you have entered. If they do not match, the 
system will display an error message, and you will be permitted to: (i) change the version 
number that you have entered, or (ii) exit from the Enter a Regulatory Program Record 
entry screen by selecting the Close push-button at the bottom of the screen.
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Figure 5-19. Enter a Regulatory Program Record document type selection 

8. Enter the Filename for Entry Document in the space provided. If you are not sure of the 
file name, you may select the File Chooser push-button next to the Filename for Entry 
Document entry field. This will cause a list of files to be displayed (Figure 3-7), and you 
may select the desired disk, directory, and file name.  

9. Visually review the information you have entered, and make corrections if necessary.  

10. When all of the information is correct, select the Enter push-button at the bottom of the 
Enter a Regulatory Program Record entry screen to accept the entry information and 
update the database. A few seconds are required to perform the entry process. During this 
time, the Enter push-button will remain shaded, and the system will be locked to prevent 

further entry of information. When the check in process has been completed, the Enter
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push-button will return to its normal appearance, and a message will display indicating 
whether or not the entry was successful.  

If, for any reason. the entry was not successful, an error message will display, providing 
further information and instructions. Several conditions can cause the entry process to fail 
in ways that cannot be immediately corrected by the operator. If any of the following 
conditions is indicated, the entry process will be terminated automatically, and you will 
have to correct and resubmit the data: (i) internal system problems, (ii) a corrupted 
WordPerfect input file, (iii) an input file that is not in WordPerfect format, or (iv) an input 
file that the system cannot parse to find the document type., review plan number, and title.  

There is one condition that causes the entry process to pause and ask for operator 
confirmation. If the document type, review plan number, or title in the submitted 
document file does not match the corresponding information on the Enter a Regulatory 
Program Record screen, the system will assume that the wrong file has been submitted.  
This will cause the system to pause and display an error message, showing the expected 
versus the submitted document type, review plan number, and title. In some cases, such as 
when a change occurs in the title of a document, you may want to verify that the correct 
document has been selected by checking the review plan number, and then accept the 
input document file and override the title in the Enter a Regulatory Program Record 
screen information by selecting the Force Entry push-button at the bottom of the error 
message screen. This action must be approved in accordance with TOP-001-015, RPD 
Loading Control, Version Control, and Change Control (Center for Nuclear Waste 
Regulatory Analyses, 1993). If you do not want to accept the input document file, you 
may exit from the Enter a Regulatory Program Record screen by selecting the Close 
push-button at the bottom of the error message screen.  

11. To exit from the Enter a Regulatory Program Record screen, select the Close push-button 
at the bottom of the screen. If you select the Close push-button to exit before selecting the 
Checkin push-button, any information that you have entered will be discarded.  

5.7.5 Enter Open Item Tracking System Records 

To enter an OITS record: 

1. Select Custodian from the menu bar of the CDOCS Main Menu. The system displays a 
pull-down menu containing options to Submit Record, Update Record, Delete Record, and 
Process a Regulatory Record (Figure 5-3).  

2. Select Process a Regulatory Record from the Custodian pull-down menu. The system 
displays a cascading menu containing options to Define a Regulatory Record, Retire a 
Regulatory Record, Eormat Check a Regulatory Record, and Enter a Regulatory Record 
(Figure 5-14).  

3. Select the Enter a Regulatory Record entry from the Process a Regulatory Record 
cascading menu. Alternatively, you may press the mnemonic key [c]. The Enter a
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Regulatory Program Record entry screen will appear and the Document Type pull-down 

indicator will be set to the default value of CDM (Figure 5-19) 

4. To access the entry screen for OITS records, you must select the OITS document type.  

Select the Document Thpe pull-down indicator to display the pull-down list of document 

types, and select the OITS entry (Figure 5-19). The appearance of the screen will change 

and all of the active and defined OITS identifiers and topics will appear in the OITS ID 

and TOPIC list view. Note that the information in this list view may be scrolled 

horizontally and vertically.  

5. Select the line in the OITS ID and Topic list view that contains the desired OH'S identifier 

and topic. The Enter an OITS Record screen will display (Figure 5-20).

Figure 5-20. Enter an OITS record
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6. Enter the Filename for Entry Document in the space provided. If you are not sure of the 
file name, you may select the File Chooser push-button next to the Filename for Entry 
Document entry field. This will cause a list of files to be displayed (Figure 3-7), and you 
may select the desired file and select the OK push-button.  

7. Visually review the information you have entered, and make corrections if necessary.  

8. When all of the information is correct, select the Enter push-button at the bottom of the 
Enter an OITS Record entry screen to accept the check in information and update the 
database. A few seconds are required to perform the check in process. During this time, 
the Enter push-button will remain shaded, and the system will be locked to prevent further 
entry of information. When the check in process has been completed, the Enter 
push-button will return to its normal appearance, and a message will display indicating 
whether or not the check in was successful.  

If, for any reason, the entry was not successful, an error message will display, providing 
further information and instructions. Several conditions can cause the entry process to fail 
in ways that cannot be immediately corrected by the operator. If any of the following 
conditions are indicated, the entry process will be terminated automatically, and you will 
have to correct and resubmit the data: (i) internal system problems, (ii) a corrupted 
WordPerfect input file, (iii) an input file that is not in WordPerfect format, or (iv) an input 
file that the system cannot parse.  

There is one condition that causes the entry process to pause and ask for operator 
confirmation. If the document type, OITS identifier, or topic in the submitted document 
file does not match the corresponding information on the Enter an OITS Record screen, 
the system will assume that the wrong file has been submitted. This will cause the system 
to pause and display an error message, showing the expected versus the submitted 
document type, OITS identifier, and topic. In some cases, such as when a change occurs in 
the topic of a document, you may want to verify that the correct document has been 
selected by checking the OITS identifier number, and then accept the input document file 
and override the topic in the Enter an OITS Record screen information by selecting the 
Force Entry push-button at the bottom of the error message screen. If you do not want to 
accept the input document file, you may exit from the Enter an OITS Record screen by 
selecting the Close push-button at the bottom of the error message screen.  

9. To exit from the Enter an OITS Record screen, select the Close push-button at the bottom 
of the screen. If you select the Close push-button to exit before selecting the Enter 
push-button, any information that you have entered will be discarded.  

5.7.6 Format Check for New and Updated Regulatory Records 

The CDOCS regulatory record processing function has a facility for checking the format of input 
records prior to submitting them. The format check facility is nearly identical to the entry process 
described in Section 5.7.4, except that the database is not updated. All input edits are performed and any 
error conditions are included in a format check error report. The Format Check entry screens for regulatory
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program and OITS records require the record to be selected from a list view of available records. The input 

file must be identified either through entry of the full path and file name or through selection with the file 

chooser facility.  

The format check screens for regulatory program records (CDS, CDM, and RPS) differ from 

those for OITS records. Therefore, the format check processes for regulatory program and OITS records 

are treated separately.  

5.7.6.1 Format Check For Regulatory Program Records 

To format check an regulatory program record: 

1. Select Custodian from the menu bar of the CDOCS Main Menu. The system displays a 

pull-down menu containing options to Submit Record, Update Record, Delete Record, and 

Process a Regulatory Record (Figure 5-3).  

2. Select Process a Regulatory Record from the Custodian pull-down menu. The system 

displays a cascading menu containing options to Refine a Regulatory Record, Retire a 

Regulatory Record, Format Check a Regulatory Record, and Enter a Regulatory Record 

(Figure 5-14).  

3. Select the Format Check a Regulatory Record entry from the Enter a Regulatory Record 

cascading menu. Alternatively, you may press the mnemonic key [f] or the accelerator key 
[1^-. The Format Check a Regulatory Program Record entry screen will appear 

(Figure 5-21).  

4. Select the Document Type pull-down indicator to display the pull-down list of document 

types, and select the desired regulatory program document type (e.g., CDS, CDM, or 

RPS). All of the active and defined review plan numbers and titles for the selected 

document type will appear in the Review Plan Number and Title list view. Note that the 

information in this list view may be scrolled horizontally and vertically.  

5. Select the line in the Review Plan Number and Title list view that contains the desired 

review plan number and title.  

6. Select either the Major Revision or Minor Revision radio button under the Format Check 

Type heading.  

7. Enter the appropriate number in the New Version Number entry field for the document 

being format checked. The system will also compute a new version number based on the 

current version number and the type of change (major or minor). This new computed 

version number will be compared to the version that you have entered. If they do not 

match, the system will display an error message, and you will be permitted to: (i) change 

the version number that you have entered, or (ii) exit from the Format Check a Regulatory 

Program Record entry screen by selecting the Close push-button at the bottom of the 

screen.
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Figure 5-21. Format Check a Regulatory Program Record screen

8. Enter the Filenamefor Format Check Document in the space provided. If you are not sure 
of the file name, you may select the File Chooser push-button next to the Filename for 
Format Check Document entry field. This will cause a list of files to be displayed 
(Figure 3-7), and you may select the desired disk, directory, and file name.  

9. Visually review the information you have entered and make corrections if necessary.  

10. When all of the information is correct, select the Format Check push-button at the bottom 
of the Format Check a Regulatory Program Record entry screen to accept the format check 
input information and check the format of the submitted record. A few seconds are 
required to perform the format check process. During this time, the Format Check 
push-button will remain shaded, and the system will be locked to prevent further entry of 
information. When the format check process has been completed, the Format Check

5-27



push-button will return to its normal appearance, and a message will display indicating 
whether or not the format check was successful.  

If, for any reason, the format check was not successful, an error message will display, 
providing further information and instructions (see Appendix B).  

There is one condition that causes the format check process to pause and ask for operator 
confirmation. If the document type, review plan number, or title in the submitted 
document file does not match the corresponding information on the Format Check a 
Regulatory Program Record input screen, the system will assume that the wrong file has 
been submitted. This will cause the system to pause and display an error message, 
showing the expected versus the submitted document type, review plan number, and title.  

11. To exit from the Format Check a Regulatory Program Record screen, select the Close 
push-button at the bottom of the screen. If you exit before selecting the Format Check 
push-button, any information that you have entered will be discarded.  

5.7.6.2 Format Check for Open Item Tracking System Records 

To format check an O1TS record: 

1. Select Custodian from the menu bar of the CDOCS Main Menu. The system displays a 
pull-down menu containing options to Submit Record, UpLdate Record, Delete Record, and 
Process a Regulatory Record (Figure 5-3).  

2. Select Process a Regulatory Record from the Custodian pull-down menu. The system 
displays a cascading menu containing options to DJefine a Regulatory Record, Retire a 
Regulatory Record, Format Check a Regulatory Record, and Enter a Regulatory Record 
(Figure 5-14).  

3. Select the Format Check a Regulatory Program Record entry from the Enter a Regulatory 
Program Record cascading menu. Alternatively, you may press the mnemonic key [f]. The 
Format Check a Regulatory Program Record entry screen will appear (Figure 5-21).  

4. Select the Document Type pull-down indicator to display the pull-down list of document 
types, and select the OITS. The appearance of the input screen will change to reflect OITS 
records and all of the active and defined OITS identifiers and topics will appear in the 
OITS Identifier and Topic list view. Note that the information in this list view may be 
scrolled horizontally and vertically.  

5. Select the line in the OITS ID and Topic List view that contains the desired OITS identifier 
and topic.  

6. Select the appropriate OITS record.  

7. Enter the Filename for Format Check Document in the space provided. If you are not sure 
of the file name, you may select the File Chooser push-button next to the Filename for
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Format Check Document entry field. This will cause a list of files to be displayed 
(Figure 3-7), and you may select the desired disk, directory, and file name.  

8. Visually review the information you have entered and make corrections if necessary.  

9. When all of the information is correct, select the Format Check push-button at the bottom 
of the Format Check an QITS Record entry screen to accept the format check input 
information and check the format of the submitted record. A few seconds are required to 
perform the format check process. During this time, the Format Check push-button will 
remain shaded, and the system will be locked to prevent further entry of information.  
When the format check process has been completed, the Format Check push-button will 
return to its normal appearance, and a message will display indicating whether or not the 
format check was successful.  

If, for any reason, the format check was not successful, an error message will display, 
providing further information and instructions (see Appendix B).  

10. To exit from the Format Check an OITS Record screen, select the Close push-button at the 
bottom of the screen. If you select the Close push-button to exit before selecting the 
Format Check push-button, any information that you have entered will be discarded.  

5.7.7 Retire Regulatory Program Records 

A regulatory program record may become obsolete and may need to be removed from the active 
database. The record retirement process is used to archive an outdated regulatory program record and 
remove it from the active database. The information in the retired record is physically retained, but is no 
longer available to users through the normal access methods. The record to be retired must be positively 
identified through the Retire a Regulatory Program Record screen (Figure 5-22) before it can be archived 
and removed from the active database. Such action must be approved by NRC and CNWRA management 
and must be done in accordance with TOP-001-015, RPD Loading, Control, Version Control, and Change 
Control (Center for Nuclear Waste Regulatory Analyses, 1993) for regulatory program records.  

5.7.7.1 Retire a Regulatory Program Record 

To retire a regulatory program record: 

1. Select Custodian from the menu bar of the CDOCS Main Menu. The system displays a 
pull-down menu containing options to Submit Record, Up-date Record, Delete Record, and 
Process a Regulatory Record (Figure 5-3) 

2. Select Process Regulatory Record from the Custodian pull-down menu. The system 
displays a cascading menu containing options to Define a Regulatory Record, Retire a 
Regulatory Record, format Check a Regulatory Record, and Enter a Regulatory Record 
(Figure 5-14).  

3. Select Retire a Regulatory Record from the Process a Regulatory Record cascading menu.
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Alternatively, you may press the mnemonic key [f] or the accelerator key [^-f]. The Retire 
a Regulatory Program Record entry screen will appear (Figure 5-22). Select the Document 

Type pull-down indicator to display the pull-down list of document types, and select the 
desired remulatory program document type (e.g., CDS, CDM, or RPS). All of the active 
and defined review plan numbers and titles for the selected document type will appear in 
the Review Plan Number and Title list view. Note that the information in this list view may 

be scrolled horizontally and vertically.  

4. Select the line in the Review Plan Number and Title list view that contains the desired 
review plan number and title..

Figure 5-22. Retire a Regulatory Program Record screen
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5. When you have selected the record to be retired, select the Retire push-button at the 
bottom of the Retire a Regulatory Program Record screen. The system will display a 
confirmation message and ask you to verify that the correct record has been selected. You 
may continue with the record retirement by selecting the Retire push-button in the 
message window.  

6. If the wrong record has been selected, or if you do not want to continue with the record 
retirement, you may exit from the Retire a Regulatory Program Record screen by 
selecting the Close push-button at the bottom of the screen.  

When a record has been retired, a message will appear at the bottom of the screen 
informing you that the record retirement transaction successfully completed.  

7. To exit from the Retire a Regulatory Program Record screen, select the Close push-button 
at the bottom of the screen. If you select the Close push-button to exit before selecting the 
Retire push-button, the record that you were starting to retire will remain in the active 
database.  

5.8 CUSTODIAN FUNCTIONS FOR LIBRARY CONTROL 

The CNWRA maintains a library of selected documents. CDOCS performs additional functions 
at the CNWRA associated with circulation control of these documents. The CDOCS circulation control 
facilities are not needed at the NRC, therefore, the circulation control options do not appear on the NRC 
Custodian pull-down menu (Figure 5-3).  

5.8.1 Checking Out a Consolidated Document System Record 

CDOCS provides facilities for circulation control of hard-copy documents associated with 
certain document sets. The circulation control facilities permit a document to be checked out from the 
CNWRA library.  

To check out a record from CDOCS: 

1. If the CDOCS Checkout entry screen (Figure 5-23) is not visible, select Checkout 
Document from the CNWRA Custodian pull-down menu in the CDOCS Main Menu 
(Figure 5-4).  

The CDOCS Checkout entry screen appears (Figure 5-23) and the Document Set 
drop-down list is initialized to the default document set 

2. Enter the number of the document to be checked out in the Document Number entry field.  

3. Select the staff member's name from the Selection List. If the name is not in the Selection 
List, then enter it in the Other Names field. The name should be entered as last name 
followed by a comma, first and middle initials, each followed by a period.
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Figure 5-23. CDOCS Checkout entry screen

4. Select the OK push-button at the right of the screen to check out the record.  

5. The check out process validates the document number that was entered. If an invalid 
document number was entered, an error message appears prompting reentry of the 
document number. If the document is already checked out to someone else, an error 
message is displayed, and prompts for reentry of the document number again. If the 
document number is valid and the document is not already checked out, the document 
check out process displays an advisory message, including the title of the record being 
checked out, to indicate that the checkout process was completed successfully.  

6. To exit the CDOCS Checkout entry screen, select the Close push-button at the right of the 
screen.
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If the Close push-button is selected before selecting the OK push-button, the record is not 
checked out.  

5.8.2 Checking In a Consolidated Document System Record 

CDOCS provides facilities for circulation control of hard-copy documents associated with 
certain document sets. The circulation control facilities permit the document to be checked in when the 
document is returned to the CNWRA library.  

To check in a CDOCS record: 

1. If the CDOCS Checkin entry screen (Figure 5-24) is not visible, select Checkin Document 
from the CNWRA Custodian pull-down menu in the CDOCS Main Menu (Figure 5-3).  

The CDOCS Checkin entry screen appears and the Document Set drop-down list is 
initialized to the default document set.  

2. Enter the document number in the Document Number entry field.  

3. Select the OK push-button at the right of the screen to check in the record (Figure 5-24).

Figure 5-24. CDOCS Checkin entry screen

5-33



The checkin process validates the document number that was entered. If an invalid 
document number is entered, an error message appears prompting reentry of the document 
number again. If the document is not checked out to someone, an error message is 
displayed and prompts for reentry of the document number again. If the document number 
is valid and the document is currently checked out, the document check-in process 
displays a confirmation screen including the title of the record being checked in. Select 
OK to check in the record. The system displays an advisory message to indicate that the 
check-in process has completed successfully.  

4. To exit the Document Checkin entry screen, select the Close push-button at the right of the 
screen. If the Close push-button is selected before selecting the OK push-button, the 
record is not checked in.  

5.9 MAIN MENU-REPORT ENTRY 

CDOCS custodians have access to the standard reference and database status reports and new 
acquisition reports. For further information on how to select, view, and print CDOCS reference reports, 
database statistics reports, and new acquisition reports, see Section 3.9.  

The availability of reports depends on the users authorities and permissions. Reports that the 
custodians are authorized to access appear on the Report pull-down menu (Figure 5-25.  

In addition to the standard reference reports, database status reports. and new acquisition reports, 
custodians also have access to the following additional CDOCS reports: 

Circulation-Circulation status for hard-copy documents in the CNWRA library.  

Labels-Labels to be affixed to hard copy documents (books, reports, etc.) to assist in document 
tracking.)

Status ... Ctrl+ 
ilatory Records Content ... Ctrl÷O

Figure 5-25. Report pull-down menu for database custodians
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5.9.1 Report Menu-Circulation Reports

The CDOCS circulation reports comprise a suite of related reports that assist in locating physical 
documents. The specific circulation reports are accessed through the CDOCS Circulation Reports screen 
(Figure 5-26).  

To use the CDOCS circulation reports: 

1. Select Reports from the CDOCS Main Menu (Figure 5-3). The Report pull-down menu is 
displayed (Figure 5-25)).

Figure 5-26. CDOCS Circulation Report selection screen
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2. Select Circulation from the Report pull-down menu. The CDOCS Circulation Reports 
selection screen is displayed (Figure 5-26).  

3. Select the radio button for the desired type of report.  

4. If the radio button for Who has a certain document was selected, enter the document 
number in the corresponding entry field.  

5. If the radio button for Retrieve all documents checked out by a certain person was 
selected, select the person's name from the selection list, or enter the name in the Other 
Name field.  

6. Select the OK push-button to execute the report.  

7. Select the Print push-button to print the report.  

8. Select the Close push-button to exit from the CDOCS Circulation Reports selection 
screen.  

5.9.2 Accessing the Consolidated Document Management System Labels 

These labels are affixed to hard copy documents (books, reports, etc.) to assist in document 
tracking.  

To use the CDOCS labels function: 

1. Select Reports from the CDOCS Main Menu (Figure 5-3). The Report pull-down menu is 
displayed (Figure 5-25).  

2. Select Labels from the Report pull-down menu. The Labels Report selection screen is 
displayed.  

3. Select Print to print the labels.  

5.10 MAIN MENU-HELP ENTRY 

For information about how to use the Help facility, see Section 3.10.
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6 DATABASE ADMINISTRATOR GUIDELINES 

The previous chapters provided a general introduction to CDOCS and its primary functions and described 
the functions available to most CDOCS users and the database custodian. This chapter introduces the func
tions available to the CDOCS database administrator.  

6.1 DATABASE ADMINISTRATOR AUTHORITIES AND PERMISSIONS 

This chapter discusses authorities, permissions, and functions available to the database 
administrator. Where fimctions available to the database administrator are the same as those available to 
other CDOCS users, reference is made to prior sections of the User's Guide. Familiarity with the CDOCS 
primary functions presented in previous sections prepares the administrator to operate CDOCS and utilize 
these additional functions. The database administrator has extensive authorities and permissions to access 
all functions of other CDOCS users as well as to the exclusive abilities to add new users to the system and 
to alter user permissions and preferences.  

6.2 CONSOLIDATED DOCUMENT SYSTEM MAIN MENU 

After the logon process has been completed, the system displays the CDOCS Main Menu for the 
database administrator (Figure 6-1). This screen contains a menu bar at the top of the screen with the 
following major functions that can be accessed by the database administrator: 

Operations-Copy a regulatory program or OITS record, use WordPerfect to edit a regulatory 
program or OITS record, change passwords (for CNWRA users), or exit from CDOCS 

Search-Use information searches to find and access CDOCS records 

Custodian-Perform operations to submit, delete, check out, or check in CDOCS records 

Report-Access CDOCS report facilities to display and/or print standard reports 

System-Use system maintenance functions 

Help-Access CDOCS help facilities to get more information about how to use CDOCS

Figure 6-1. CDOCS main menu for database administrator

6-1



6.3 -MAIN MENU-OPERATIONS ENTRY

The Operations entry in the menu bar of the CDOCS Main Menu permits performance of general 

functions that are available to all users. Selecting Operations from the menu bar of the CDOCS Main Menu 

causes the Operations pull-down menu to appear (Figure 6-3). The Operations pull-down menu includes 

options for (i) copying a regulatory program or OITS record., (ii) using WordPerfect to edit a regulatory 
program or OITS record, (iii) changing passwords (for CNWRA users), (iv) setting user preferences, 
(v) scan and optical character recognition, or (vi) exiting CDOCS. For further information about how to 

use the Operations entry in the CDOCS Main Menu. see Section 3.7; for further information on Password 
Logon, see Appendix A.  

6.4 MAIN MENU-SEARCH ENTRY 

CDOCS provides powerful and easy-to-use facilities for identifying and viewing records. The 

TOPIC search and retrieval software permits the user to find records by searching for specific words or 

phrases in: (i) the text of the document, and/or (ii) certain document header fields, such as the author or 

title. For further information about how to use the Search entry in the menu bar of the CDOCS Main Menu, 
see Section 3.8 

6.5 MAIN MENU-CUSTODIAN ENTRY 

The database administrator has permissions and authorities that permit maintenance of CDOCS 

records. The record maintenance capabilities available through the Custodian pull-down from the CDOCS 

Main Menu include submitting, deleting, checking in and checking out CDOCS records, and maintaining 

regulatory records. These functions are fully described in Chapter 5.  

6.6 MAIN MENU-REPORT ENTRY 

The availability of reports depends upon the authority and permissions of the individual user.  

Reports that are authorized for a particular user appear on the Report menu. The database administrator has 

unique reporting capabilities (Figure 6-4). For further information on how to select and print database 
content reports. see Section 3.9.

Figure 6-2. CDOCS Database administrator operations pull-down menu
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Database Reports (CDS, CDM, Open Items) ... Ctrl+Z 

Reference Reports ...  
Database Statistics ...  
Circulation ...  
N.ew Acquisition ...  
Labels ...

Figure 6-3. Report pull-down menu for database administrators

To view database administrator reports: 

1. Select Report from the menu bar of the CDOCS Main Menu. The system displays a 
pull-down menu of report types (Figure 6-3).  

2. Select Database Content from the Report pull-down menu. The system displays a 
cascading menu (Figure 6-4).  

3. The DB Dump and DBA reports, which appear on the menu, provide detailed information 
on the database development, and may be selected for viewing or printing as required.  

6.7 MAIN MENU-SYSTEM ENTRY 

The System main menu entry permits the database administrator to perform maintenance on the 
list of authorized users of the system. This facility permits users to be added, deleted, or changed.  

Adding a New User ID 

To add a CDOCS User ID: 

1. Select System from the menu bar of the CDOCS Main Menu. The system displays a 
pull-down menu that contains the User IDs entry (Figure 6-5) 

.2. Select the U~ser IDs entry in the System pull-down menu. The CDOCS User ID 
Maintenance screen (Figure 6-6) appears 

3. Enter the user identification number in the User ID entry field.  

4. Enter the password in the Password entry field. The password that is entered in this field is 
the initial password for the user.
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Figure 6-4. Database Content cascading menu

Figure 6-5. CDOCS system pull-down menu

5. Enter the name of the user in the Username entry field.  

6. Select the desired privilege from the Privilege drop-down list.  

7. Review the information that has been entered and make corrections if necessary. When all 

of the information is correct, select the Add push-button at the bottom of the User ID 
Maintenance screen to add the new User ID.  

8. To exit from the CDOCS User ID Maintenance screen, select the Close push-button at the 

bottom of the screen. If this screen is exited before selecting the Add push-button, any 

information that was entered is discarded, and the new User ID is not added.  

6.7.1 Deleting a User ID 

To delete a CDOCS User ID: 

1. Select System from the menu bar of the CDOCS Main Menu. The system displays a 

pull-down menu that contains the User IDs entry (Figure 6-5).
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2. Select the User IDs entry in the System pull-down menu. The CDOCS User ID 
Maintenance screen (Figure 6-6) appears.  

3. Select the User ID to be deleted from the scrollable list view of User IDs and privileges.  

4. Review the selected User 1ID, and select a different User ID if necessary. When the correct 
User lID has been selected, select the Delete push-button at the bottom of the User ID 
Maintenance screen to delete the User ID.  

5. To exit from the CDOCS User-ID Maintenance screen, select the Close push-button at the 
bottom of the screen. If this screen is exited before selecting the Delete push-button, the 
User ID that was to be deleted remains valid.  

6.7.2 Changing User Privileges 

The following steps are required to change the privileges of a CDOCS User ID: 

1. Select System from the menu bar of the CDOCS Main Menu. The system displays a 
pull-down menu that contains the User IDs entry(Figure 6-5)..

Figure 6-6. CDOCS User ID Maintenance screen
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2. Select the ULser IDs entry in the System pull-down menu. The CDOCS User ID 
Maintenance screen (Figure 6-6) appears.  

3. Select the User ID of the privilege to be changed from the scrollable list of User IDs.  

4. Review the selected User ID, and select a different User ID if necessary.  

5. Select the Privilege push-button to view the Privilege drop-down lists. Privileges are as 
follows: 

"* 0-NRC User 

"* 1-NRC Custodian 

"* 2-CNWRA User 

"* 3--CNWRA Custodian 

"* 60-Database Administrator 

7. Select the Change push-button at the bottom of the User ID Maintenance screen to change 
the user's privileges.  

8. To exit from the CDOCS User ID Maintenance screen, select the Close push-button at the 
bottom of the screen. If this screen is exited before selecting the Change push-button, the 
privileges and password for the User tD is not changed.  

6.8 MAIN MENU-HELP ENTRY 

For information about how to use the help facility, see Section 3-10.
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A PASSWORD LOGON

A.1 OVERVIEW 

When CDOCS is started for a CNWRA user, the first screen displayed is the Logon screen 
(Figure A-i). This screen requires entry of an User ID and password so the system can identify the user 
and enable the appropriate access authorities and permissions.  

A.2 LOGON PROCEDURE 

The following steps are required during the logon process: 

I. When the CDOCS Logon screen appears, enter User ID in the User ID entry field and 
press the [Tab] key or use the mouse to select the Pass-word entry field.  

Note: The User ID field is case sensitive and must be keyed in exactly. For example: The 
User ID "User:" During logon, a capital "U" followed by lower case "ser" (User) must be 
entered. If any variation, such as "user" or "USER" are entered, the logon will not be 
successful.  

2. Enter current password in the Password entry field, and press the [Return] or [Enter] key 
or select the Logon push-button at the bottom of the screen. Note, for security reasons, the 
password does not display as it is entered.  

The system verifies the User ID and password. If they are valid, the CDOCS Main Menu 
screen displays (Figure 3-3) indicating a successful logon has been completed.  

If the User ID or password is not valid, the system displays an error message, and requests 
re-entry of the User ID and password.

Figure A-1. CDOCS Logon screen
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3. If the User iDD and password cannot be entered correctly, exit from CDOCS by selecting 
the Exit push-button at the bottom of the CDOCS Logon screen or by pressing the [Esc] 
key. For logon assistance, contact the Center for Nuclear Waste Regulatory Analyses 
(CNWRA) IMS staff at (210) 522-5258, or the NRC System Administrator at 
(301) 415-8087.  

If help is needed during the logon procedure, select the Help push-button at the bottom of the 
CDOCS Logon screen to display the help information.  

A.3 OPERATIONS-CHANGING PASSWORD 

Before a CNWRA user first uses the CDOCS, the CNWRA IMS staff assigns an arbitrary 
password to the user. This password should be changed the first time the user logs on to the system to make 
the User ID secure. For continued User ID security, the user should change passwords at least every 60 
days. The system permits users with the appropriate security class to change their password at any time 
through the Operations entry in the menu bar of the CDOCS Main Menu.  

To change password: 

1. Select Operations from the menu bar of the CDOCS Main Menu. The system displays a 
pull-down menu (Figure Figure A-2) that contains options for changing password or 
exiting the CDOCS.  

2. Select Change Password from the Operations pull-down menu. Alternatively, the 
mnemonic [c] may be typed or the accelerator key [Ctrl+P] pressed. The system displays 
the Change Password screen (Figure A-3).  

The Change Password screen may be exited before the password has been changed by 
selecting the Close push-button at the bottom of the screen. If this option is selected, the 
system terminates the change password process and leaves the old password in effect.  

3. Enter the new password in the New password entry field and press the [Tab] key or use the 
mouse to select the Reenter new password entry field.

Figure A-2. Operations pull-down menu
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Figure A-3. CDOCS Change Password screen

4. Enter the new password again in the Reenter new password entry field to verify that it was 
keyed in correctly, and either press the [Return] or [Enter] key or select the Change 
push-button at the bottom of the Change Password screen. Note, for security reasons, the 
password does not display as it is entered.  

If the new password was the same both times it was entered, the system changes the 
current password to the new password and a PASSWORD CHANGED message displays.  
Otherwise an error message is displayed asking for re-entry of the new password again.  

5. When the password has been changed, select the Close push-button at the bottom of the 
Change Password screen to exit from the change password process. At this point, the new 
password is in effect. Subsequent logons will require entry of the assigned User ID and the 
new password.  

To obtain help during the change password procedure, select the Help push-button at the 
bottom of the Change Password screen to display help information
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B ERROR MESSAGES 

Custodian/administrator assistance is available at the following phone numbers: 

"* NRC System Administrator (310) 415-8087(8:00 am - 5:00 pm, EST) 

"* CNWRA Help Desk (210) 522-5258(8:00 am - 5:00 pm, CST)

ERROR MESSAGE ERROR INFORMATION/USER ACTION 

Bad working directory. Server cannot change to proper directory. Contact the 
database custodian/administrator and report the error 
message.  

Can not check out document. Verify the correct document number was entered and the 
correct document set was specified. Check to determine 
if the document is already checked out. If the problem 
persists, contact the database custodian/administrator and 
report the error message.  

Can not delete deleted document. The document specified for deletion has already been 
deleted. Verify correct document number was entered and 
the correct document set selected. If the problem persists, 
contact the database custodian/administrator and report 
the error message.  

Can not delete document. Verify the correct document number was entered and the 
correct document set selected. Check to determine if the 
document is checked out. If the problem persist after 
verifying that the information entered is correct, and that 
the document is not checked out, then contact the 
database custodian/administrator and report the error 
message.  

Check in error. Verify the correct document number was entered and the 
correct document set selected. Check to determine if the 
document is checked out. If the problem persists after 
verifying that the information entered is correct and that 
the document is checked out, then, contact the database 
custodian/administrator and report the error message.  

Client file error (%Id). Cannot save file to local disk. (i) Use the owner account 
(permissions). (ii) Clean off the disk.  

Client Memory Error. Client out of memory. Close some applications.  

Could not write document. Contact the database custodian/administrator and report 
the error message.
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ERROR MESSAGE ERROR INFORMATION/USER ACTION 

Document already checked in. The document specified for check in is already checked 
in. Verify the correct document number was entered and 
the correct document set specified.  

Document already checked out. The document specified for check out is already checked 
out. Verify the correct document number was entered and 
the correct document set specified. This message can be 
overridden to check out multiple copies of a document.  
See Section 6.5.16.  

Document synchronization failed Retry the operation. If the problem reoccurs, verify that 
the server is up and functioning. If the network 
connection is up and flnctioning, and the problem 
persists, contact the database custodian/administrator and 
report the error message.  

Error connecting to server. Server is not functioning. Contact the database custodian/ 
administrator and report the error message.  

Input Data Too Long. Input data too long for field(s). Re-enter abbreviated 
form of data.  

Invalid Document Type. Unknown document type passed to server. Contact the 
database custodianladministrator and report the error 
message.  

Invalid logon name/password. Server could not verify User-ID or password. Logon 
using the correct User-ID and password 

New password does not match the When attempting to change the user's password, there 
re-entered new password. was a password mismatch between the password and the 

re-entered password. Select OK to dismiss the error 
message and then re-enter the new password twice to 
verify its correctness.  

No more records. Contact the database custodian/administrator and report 
the error message.  

NULL password entered. When attempting to change the user's password, the 
RETURN key was pressed or the CHANGE button was 
selected when the Re-enter new password field was 
empty. Select the OK button to dismiss the error message 
and then re-enter the new password twice to verify its 
correctness.  

Password must be at least 4 characters. The password entered is less than the minimum 4 
characters, Re-enter a password with a minimum of 4 
characters.

B-2

I



ERROR MESSAGE ERROR INFORMATION/USER ACTION 
Password must be no longer than 16 The password entered is longer than the maximum 16 
characters, characters. Re-enter a password with less than 16 

characters.  

RPC Call timed out. System error. Contact the database custodian/ 
administrator and report the error message.  

Server File Error (%Id). Cannot read/write file. Contact the database custodian/ 
administrator and report the error message.  

Server list data error. Contact the database custodian/administrator and report 
the error message.  

Server Memory Error. Server out of memory. Contact the database custodian/ 
administrator and report the error message.  

SQL Error (%Id). System error. Improper installation. Contact the database 
custodian/administrator and report the error message.  

Unable to find ipc dLh Contact the database custodian/administrator and report 
the error message.  

Unknown Server Error. Contact the database custodian/administrator and report 
the error message.  

Version Error Installation problem. Contact the database custodian! 
administrator and report the error message.  

You entered and invalid User-ID or When logging on, an incorrect User-ID and/or password 
password. was entered. Re-enter the User-ID and password.  

You MUST enter both a User-ID and When logging on, either the User-ID or password was not 
password. entered. Try again, using both the User-ID and password.
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C ScanWorX-SCANNING, OPTICAL CHARACTER 
RECOGNITION, AND DOCUMENT CLEANUP 

C.1 OVERVIEW 

The scanning, Optical Character Recognition (OCR), and document cleanup processes involve 
several distinct steps.  

"* The document is examined to determine if exception conditions must be accommodated.  

"* A new or existing document is specified and the system assigns a job name.  

"* A user-supplied document name is entered and options for text and full-page images are 
selected.  

"* The pages are placed in the document feeder, or on the scanner bed, and scanned.  

"* Pages are zoned as required to designate areas of text versus areas that contain images.  

"* Pages of text are accessed through a special editor to correct scanning/OCR errors.  

"* The corrected text is exported to the file system, along with any associated images, for 
loading into the full-text and image databases.  

C.2 STARTING THE SCANNING OPERATION 

The scanning process is initiated from the SCAN and OCR entry in the Operations pull-down 
menu (Figure C-i) on scan capable workstations. If the workstation is not scan-capable (does not have the 
appropriate scanner and software installed) this option does not appear.  

To start the scan operation: 

1. Select the Operations entry from the CDOCSMain Menu.  

2. The O~perations pull-down menu appears.  

3. Select the SCAN and OCR entry in the O~perations pull-down menu, and the scanning 
facilities is started.

£hangc P assword ... C tr 1.+.P ......  
2references ... Ctrl+E ...... . ...  

Scan and OCR ...  
ExSit F3 

Figure C-1. CDOCS-Operations pull-down menu 
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C.3 ScanWorX CONTROL WINDOWS 

The following sections provide an overview of the screens used to control the ScanWorX 
scanning process. Sample screens (windows) are shown with instructions for accessing the window and 
brief descriptions of option selections. The windows overviewed in this section are: 

Main window (Section C3.1): 

"* General Help window 

"* Pause window 

"* Document Settings window (Section C3.2) 

"* Scanner Settings window (Section C3.3) 

"* Start Processing window (Section C3.4) 

"* Text Format pop-up window (Section C3.4.2) 

"* Image Format pop-up window (Section C3.4.3) 

"* Text Options pop-up window (Section C3.4.4) 

C.3.1 Main Window 

The ScanWorX main window is illustrated in Figure C-2. The items in this window fall into five 
general categories.  

Input Source-Defines the origin of pages to be processed: the scanner or Tag Image File Format 

(TIFF) image files loaded in the TIFF Queue 

Process-Defines what type of data is to be output during the job: text, image, or both 

Options-Indicates the interactive tools that can be used during the scanning procedure: preview, 
verify, or feedback 

Settings-Provides access to subwindows that are used to define job settings, save and load 
settings files, and save/restore default settings 

General Commands-Help, Quit, Start, Pause, Resume, Convert, About ScanWorX 

C.3.1.1 Commands 

The ScanWorX Main window offers all of the commands and options that can be selected to 
prepare for a scanning. Seven general commands can be selected from the main window by use of the 
mouse. In general, ScanWorX does not provide a keyboard interface to menu options. Three of the 
commands are displayed at the top of the main window: Help, About ScanWorX, and Quit.
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ScanWorX - Xerox Imaging Systems, Inc.  

(About ScanWorX (

Input Source: EfScanner E3 TIFF 

Process: [ Text El Image El Both 

Options:

El Preview

El Verify

Load Tem plate) 

( Load Verification Data )

El Feedback

Settings: Document

C Save

) Q Scanner

) ( Load

. Save As Defaults ) ( Restore Defaults

Status: Idle

Figure C-2. ScanWorX-main window 

Help-Accesses a general message that describes how to use the built-in context-sensitive Help 
system (Figure C-3). The Help window opens onto the desktop. Select the push pin in the upper 
left corner window to exit from the Help window. To use the context-specific help, point to a 
menu item and press the [Help] key or the [F1] key.  

About ScanWorX-Displays a help window with basic ScanWorX product information such as 
version number and copyright information. Select the Help window (or anywhere on the 
desktop) to close it.  

Quit--Closes the ScanWorX main window, all other open subwindows, and terminates the 
scanning process.  

The next four commands are located two-thirds of the way down the Main window.  

Start-Displays the Start Processing window. The Start Processing window enables the start of 
a new job and allows specification of the directory and names of the files to be created. This 
window is discussed in further detail in Section E.3.4.  

Pause-Suspends processing of the current document. A pop-up window (Figure C-4) provides 
six choices: Continue, Preview Current Page, Interrupt, End Document, Cancel Page, or Cancel 
Document. Pause may be used to change settings and then continue with the job.
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__settings: Help 

Displays information about any button, field or 
option on any of the ScanWorX windows. Position 
the pointer on the item needing clarification and 
press the Help key for the F1 key.

Figure C-3. ScanWorX-general Help window

0 ScanWorX - Pausing.  

Continue 

Preview Current Page 
Interrupt 
End Document 

Cancel Page 

Cancel Document 

Figure C-4. ScanWorX-pause window
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Examples: Select Pause, leave the Pause Window displayed while changing the settings, then 
select Continue to proceed with the new settings.  

Resume-Allows processing of a document that was interrupted to resume. The Resume 
command displays a window where the file name and directory of the interrupted document can 
be specified.  

Convert-Allows conversion of a Format Analyzed Text file to one of the other supported text 
formats: Interleaf, FrameMaker, WordPerfect, American Standard Code for Information 
Interchange (ASCII), etc Options 

Main window options are listed as headers on the left side of the Main window (Figure C-2). The 
following summarizes the option selections available from the Main window.  

Input Source 

"• Scanner-Input will be from the scanner.  

" TIFF-Input will be from TIFF Queue. The TIFF Queue button becomes available when 
TIFF is selected. Selecting the TIFF Queue button displays the TIFF Queue Manager 
window. The TIFF Queue Manager allows selection of the files to be processed. The 
directory displayed may be changed by entering a new pathname and selecting the Show Files 
button. If a group of files is to be processed, ScanWorX automatically treats the group as a 
document and reads them in the specified order from the TIFF Queue. The TIFF Queue 
command allows editing of the "stack" of TIFF files to be recognized.  

Process 

"• Text-Only text will be processed from the input source.  

"* Image-Only images will be processed from the input source. A "picture" of each scanned 
page will be stored in a separate image file.  

"• Both-Both text and images will be processed from the input source. Also known as 
"compound scanning." With this option, images will only be processed as line art.  

Options 

"• Preview-Opens the Preview window for manual zoning.  

"• Verify-Opens the Verifier for manual text verification.  

"• Feedback-Opens the Feedback window, which displays the scanned page with words being 
highlighted as they are recognized.  

Load Template-Loads a template file (a predefined set of page zones) to use to process the job.  

Load Verification Data-Loads a named verification data file to process job.
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Settings-Allows viewing and changing of document and scanner settings; saving and loading 
settings files; saving user defaults, and restoring system or user default settings (Figure C-5).  

C.3.2 Document Settings Window 

The Document Settings window (Figure C-5) is used to inform the system about the document to 
be processed. These settings include Page Settings (Orientation, Page Size, Column Layout) and 
Recognition Settings. Recognition Settings describe the text to be processed, which optimizes character 
recognition.  

To specify document settings: 

1. Select the Document Settings command from the Main window (Figure C-2). The Document 
Settings window will appear (Figure C-5).  

2. Specify document settings for the document to be processed.  

Orientation-Select Portrait or Landscape.  

Page Size-Select one of the listed page sizes. When scanning images, select the standard 
page size that most closely approximates the size of the image to be scanned.  

Columns 

Specify the quantity of columns (1, 2, 3, or 4) for pages that have evenly-spaced columns of 
equal width..  

"* Auto Detect-Select this option for pages that have an irregular layout, or have more than 
four columns.  

"* Next Page-Enter the number of the next page to be scanned. In general, if starting a new 
document, use the default setting of 1.  

(• Scan WorX - Document Settings.  

Page Settings Recognition Settings 

Orientation: (D Portrait Text Type: (B Alphanumeric 

Page Size: I• US Letter Lexical Context (1 Enabled 

Columns: I• 1 Column Flterln9:'-"f None 

Next Page: 1 Confidence Level: 5 1 10 

Pages: ( Single-sided User Dictionarv. None 

o3 Blank Pages separate Documents (Choose User Dpionary) 

Choose Language: M English 

Figure C-5. ScanWorX-Document Settings window
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• Page-Select Single-sided or Double-sided

Blank pages separate documents-If set ON, multiple documents will be scanned as part 
of the same job. When ON, ScanWorX will interpret a blank page as the start of a new 
document and open a new output file automatically.  

Text type 

"• Alphanumeric-Select this option for scanning input with both numbers and letters.  

"• Number Only-Select this option for scanning financial or other numeric data.  

"• Letters Only-Select this option for scanning input which has few or no numbers.  

Lexical context 

"• Enabled-Select this option to specify that the system's language dictionary and context 
rules are to be used during character recognition. If a user dictionary is loaded, it will also 
be used.  

" Disabled-Select this option to prevent the system from using the system (or user) 
dictionary.  

" No Rules-Select this option to prevent the system from using either the dictionary(ies) or 
the context rules.  

Filtering 

"* None-Select this option to keep all filters off.  

"• Remove Halftones-Select this option to filter out embedded halftone pictures and speed 
up character recognition.  

"• Enhance Dot Matrix-Select this option for draft-quality dot matrix documents.  

Confidence Level-This entry is an assurance value that the recognition software tries to 
attain for each character before it releases it as "recognized correctly." The higher the 
confidence level, the greater the number of characters that the system will flag as possibly 
incorrect.  

User Dictionary-This is the name of the currently loaded user dictionary, if there is one.  

Choose User Dictionary-Key in the full path name of the user dictionary to be loaded.  

Load Language-Select the language of the document being recognized. English is the 
default.  

3. Select Done to close the Document Settings window.
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C.3.3 Scanner Settings Window

The Scanner Settings window (Figure C-6) is used to inform the system about the document to 
be scanned. These settings include Scanner Resolution, page feeding method, Output Brightness, and 
halftone specifications.  

To specify scanner settings: 

1. Select Scanner in the Settings category of the Main window (Figure E-2). The Scanner 
Settings window appears (Figure C-6).  

2. Specify scanner settings for the document to be processed.  

Scanner Resolution-Three resolutions are available: 400 dpi (default), 300 dpi, and 
200 dpi. In general, the highest available resolution achieves the most detailed image. To 
obtain the most accurate image file, try to match the resolution of the scanned image with the 
device that will be used to print it. For example, for a 300 dpi laser printer, the images should 
be scanned at 300 dpi. If the image to be scanned is relatively simple, for example a line 
drawing, a lower resolution can be selected. This reduces the amount of time it takes to scan 
and recognize the images, and the size of the resulting file. If the image is a continuous tone 
(contone) image, the higher the resolution, the greater the number of gray levels that can be 
represented by the halftone pattern, thus the more accurate the resulting image file. Use the 
default (400 dpi) for all text documents.  

Use Automatic Document Feeder (ADF) 

ON-Select ON if pages will be loaded in the ADF.  

OFF-Select OFF if pages will be manually placed on the flatbed. Scanning images on the 
flatbed eliminates the possibility of skew induced by the ADF mechanism.  

ScanWorX - Scanner Settings.  

Scanner Resolution: ) 400 

O Use Automatic Document Feeder 

Output Brightness: I Normal 

SText/Line Art 

[1 Halftone 

Figu lfreoC6 e Pan~tter n e Seting-wi•. n dl 

Figure C-6. ScanWorX--Scanner Settings window
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Output Brightness

" Normal-Use this setting unless the document is very dark or very light. Normal is the 
default setting: it is usually adequate for most good-quality images.  

" Light/Lighter-Select this setting if the characters appear too bold, are starting to fill in, 
are touching, or if words are separated by very small spaces (as in some magazines). Also, 
recognition of document with a lot of background noise, or with colored backgrounds, 
may improve considerably by using a lighter setting.  

" Dark/Darker-Select this setting if the characters appear faint, broken, or very thin.  

" Custom-Select this setting to access the slider bar so brightness can be adjusted in finer 
increments.  

"• Text/Line Art-Select this setting for text scanning, or if scanning a black and white line 
drawing, or to achieve a posterized look from a continuous-tone image.  

"* Halftone-Select this setting for image scanning to simulate the continuous tone of a 
photograph or color illustration with different bit-mapped patterns and densities of black 
dots. Leave OFF for text scanning.  

"• Halftone Pattern-This option becomes available when Halftone is selected. If scanning a 
halftone image, one of ten halftone patterns can be specified.  

3. Select Done to accept the new scanner settings. The Start Processing window (Figure C-7).  

C.3.4 Start Processing Window 

The Start Processing window (Figure C-7) enables starting a new job, specification of the 
directory and names of the files to be created, and specification of the text and image file formats.  

C.3.4.1 Output File Names 

When specifying the document name, do not include a file extension. For all output files, 
ScanWorX appends an identifying extension (Table C-1).  

When scanning images, the name specified will be the base name. This base name is used for all 
of the image files created during a scanning session (multiple images may be scanned during one session).  
To differentiate between image files created during one scanning session, the system appends a three digit 
page number to the base file name. For example, if "tampa" is entered as the base name, the first file name 
will be: 

tampapgOOl. ext 

The fie extension is dependent upon the image or text format selected from the Text Format or 
Image Format pop-up screens (see Figure C-8, Section C.3.4.3 and Table C-i).
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Figure C-7. ScanWorX-Start Processing window

Table C-1. File types and file extensions 

File 
File Type Extension Description 

Interleaf . do c Text files in Interleaf ASCII format.  

FrameMaker . mi f Text files in FrameMaker's Interchange Format.  

WordPerfect 4.2 . txt Text flies in WordPerfect 4.2 ASCII format.  

WordPerfect 5.X . txt Text files in WordPerfect 5.0 format.  

ASCII . txt Text files in straight ASCII format.  

Raster Image . ras Image files in Sun Raster or Raster Encoded format.  

TIFF Image . t if Tag Image File Format (TIFF) images.  

KDOC .kdc An unconverted file containing recognized text and 
formatting for later conversion to Computer Acquisition 
and Logistics Support (CALS) or other third party format.  

Interleaf Image . img Image files in Interleaf Graphics Format.  

Format analyzed text . @fa Unconverted document file containing formatting 
information. This file, created when Format Analyzed Text 
was selected, must have a companion. @fc file.  
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Table C-1. File types and file extensions (cont'd) 

File 
File Type Extension Description 

Document content . @dc Unconverted file containing document content. This file 
must have a companion. @ fa file.  

Verification data file . @cs Contains a reloadable verification data set created with the 
ScanWorX Verifier option.  

Template file . @tm Contains a reloadable set of zones defined with the 
Preview option.  

Settings file . @in Contains a reloadable group of settings to streamline job 
processing.  

User dictionary . @ lx User-defined word list to improve text recognition.  

Temporary . @t i Temporary settings file created when files are interrupted.  

@tc Temporary verification data file.  

@ t f Temporary unconverted document file.  

@tq Temporary TIFF Queue file.  

. @tt Temporary template file.  

C.3.4.2 Text Format Pop-Up Window 

ScanWorX supports output of recognized text to seven final formats, and two proprietary 
formats for later conversion.  

To specify the output text file format: 

1. Select the Text Format button of the Start Processing window. The Text Format pop-up 
window appears (Figure C-8). The default selection is outlined with a double border.  

2. Change the text format selection by holding down the right mouse button, pointing to the 
new format, then releasing the button. The text format selections are described below: 

Text with Linebreaks-Select this format if the scanned document consist primarily of text in 
a simple format. The Text with Linebreaks settings output end-of-line and end-of-paragraph 
codes to maintain line and paragraph breaks. All tabs used in the original document are 
replaced by spaces. Therefore, if the document contains tabular information that needs to be 
maintained, choose Tab Delimited.  

Text Only-Select this format if the scanned document contains only text with little or no 
formatting. The Text Only settings outputs end-of-paragraph marks only. It does not output 
end-of-line codes and wraps text continually until it reaches an end-of-paragraph mark. Line
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Figure C-8. ScanWorX-Text Format pop-up window 

length (number of characters per line) is determined by the application used to import and 
edit the scanned text.  

Tab Delimited-Select this format if the scanned document contains tabular information that 
needs to be maintained, such as spreadsheets or tables. the Tab Delimited setting recognizes 
and outputs: tabs, end-of-line codes, and end-of-paragraph codes.  

FrameMaker-Select this format if the text output from the scanned document is to be 
output to the Maker Interchange Format (MIF), Frame Technology's ASCII format with 
embedded markup codes.  

Interleaf-Select this format if the text from the scanned document is to be output to Interleaf 
ASCII Format, Interleaf's ASCII format with embedded markup codes. Interleaf's ASCII 
Format files can be imported to Interleaf TPS 4.0 and later on the Sun system.  

WordPerfect-ScanWorX converts scanned text to two WordPerfect text formats: 

"* WordPerfect 4.2-This option supports simple text formatting including tabs, indents, 
underlines, and centers.  

"* WordPerfect 5.X Style-This option supports the same text formatting as 4.2 plus more 
complex features such as styles.
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KDOC-Select this format if the text from the scanned document is to be output to a file for 
eventual conversion to CALS. KDOC is the ScanWorX-proprietary interim format for 
eventual conversion to CALS and other third-party formats.  

Format Analyzed Text-This is an interim (unconverted) format for eventual conversion to 
one of the final formats: Text with Line Breaks, Text Only, Tab Delimited, FrameMaker, and 
KDOC. The benefit of saving text as Format Analyzed Text is that the Convert command can 
be used to convert it to more than one format. For example, it can convert the file to Text with 
Line Breaks to use in an on-line database. Then, it can be converted to FrameMaker for 
desktop publishing. The Format Analyzed Text file remains intact until it is manually 
removed.  

C.3.4.3 Image Format Pop-Up Window 

ScanWorX supports six output formats for scanned images.  

To specify the image file output format: 

1. Select the Image Format button of the Start Processing window with the right mouse button.  
The Text Format pop-up window appears. The default selection is outlined with a double 
border.  

2. Change the image format selection by holding down the right mouse button to display the 
pop-up menu, pointing to the new image format, then releasing the button. The image 
formats supported are: 

"* Interleaf (IGF) 

"* TIFF Uncompressed 

"* TIFF CCITT-3 

"* TIFF CCITT-4 

"* Sun Rasterfile Standard 

"* Sun Rasterfile Encoded 

C.3.4.4 Text Options Pop-Up Window 

To define the text options, select the Text Options button on the Start Processing window to 
display a Text Options selection window (Figure C-9).
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Figure C-9. ScanWorX-Text Options pop-up window 

The Text Options selections are defined as: 

Markup 

" Questionable-This selection allows specification of characters used to flag any character 
ScanWorX is unsure about. The flag appears directly before the questionable character in the 
output file.  

"* Illegible-This selection allows specification of characters to flag characters ScanWorX 
could not recognize. A flag appears in place of the illegible character.  

Zones 

Zone marker-This selection allows specification of characteristic flags that ScanWorX will 
write in the output file at points where new columns or zones in the original hard copy begin.  
For example:
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* Zone position-This selection allows output of zone coordinate information in the output file.  
Each zone position code has six values, separated by commas and enclosed in square 
brackets. For example: 

[ 185,0,153,623,t,O] 

The syntax of the zone position code is as follows: [ Im,tm,w,h,t,0] 

Im-distance from the leftmost edge of the original page to the left edge of the zone, in points 

tm--distance from the topmost edge of the original page to the top edge of the zone, in points 

w-width of the zone in points 

h-height (vertical length) of the zone, in points 

t-a fixed value set by the system 

0-a fixed value set by the system 

* Preserve-Allows preservation of italic, bold, underlines, font changes, page breaks, and 
subscripts and superscripts. (Preserve options other than page breaks are available only for 
Interleaf. FrameMaker, and WordPerfect 5.X Style formats.) 

C.4 MULTIPLE-PAGE AND DOUBLE-SIDED DOCUMENTS 

C.4.1 Multiple-Page Documents 

The ScanWorX scanner is a 400 dpi flatbed scanner with an ADE The ADF has a capacity of 
50 pages. Individual pages may be placed face-down on the flatbed for individual scanning (optimum 
method for image scanning), or the ADF may be used for volume processing of multiple page documents.  

C.4.1.1 Loading Portrait Oriented Pages 

Place the stack of pages (do not exceed 50 pages) in the ADF oriented in the following manner: 

"• Face down 

"• Page top entering the scanner first 

C.4.1.2 Loading Landscape Oriented Pages 

Place the stack of pages in the ADF, oriented in the following manner: 
"* Face down 

"* Page top along the left edge of the ADF 

C.4.1.3 Using Document Separators 

Multiple documents of similar format that require identical settings may be scanned as a single 
job and output to different files by using document separators. When document separators are used, each 
time ScanWorX encounters a blank page, it will end the current output document and begin another one.  
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To scan multiple documents as a single job:

1. Setup for the job (Document Settings, Image Settings, Text Formatting, etc.).  

2. Load the pages to be scanned into the ADF, inserting a blank piece of paper between each 
separate document.  

C.4.2 Double-Sided Documents 

ScanWorX provides automatic collation of double-sided documents. Thus, all of the odd pages 
can be scanned first, then the stack can be flipped and the reverse sides scanned. When scanning a double
sided document, perform job setup as necessary for the document to be scanned (Text Scanning, Image 
Scanning, Compound Scanning). Then continue with the following steps to process the double-sided 
document.  

1. Load the document in the scanner. If using the ADF, place the documents in the ADF face 
down, with the top of the pages entering the scanner.  

2. Specify Document Settings. Be sure to select double-sided in the Pages field. To start 
scanning on an even-numbered page, specify the correct number in the Next Page field so 
ScanWorX can correctly collate the pages.  

3. Select Done in the Start Processing window. The scanner scans the odd sides of all the pages 
in the ADF. When all pages have been scanned, the system displays the Out of Input window 
(Figure C- 10).  

"* To process more right-hand (front side) pages go to Step 4.  

"* To process more reverse sides of the double-sided pages, go to Step 6To end the document 
before ScanWorX scans the even pages, recognizes text, converts, automatically collates, 
and outputs the document to a file formatted for a text application, go to Step 7.  

4. Load more pages in the scanner, then select Continue. The system scans and recognizes the 
pages, then again displays the Out of Input window.  

5. Turn the stack over and place it in the ADF so the last even-numbered page is in position to 
be scanned next.  

6. Select the Flip and Continue button (Figure C-10). The Next Page number in the Document 
Settings window is updated appropriately and scanning resumes. When all of the pages have 
been scanned, the Out of Input window is redisplayed.  

Note: If multiple stacks of pages have been scanned, be sure to process the reverse sides in 
descending order.

C-16



Figure C- 10. ScanWorX-Out of Input window 

7. When all pages of the document have been processed, select the End Document button.  

The system outputs the recognized text in the selected format. During the conversion 
process, the system performs automatic collation, sequencing the scanned text in the same 
order it appeared in the original double-sided document.  

C.5 SCANNING TEXT 

To scan a text document into a text-editable file: specify document settings, specify scanner 
settings, start the job, specify text options, and process the document. The following steps provide a guide 
through this process. If many similar scan jobs are to be performed, the setup process can be streamlined 
by creating a settingsfile that may be loaded to process future jobs.  

1. Select Scanner as the Input Source on the Main window (Figure C-2).  

2. Select Text as the Process Type on the Main window.  

3. Select the Start command on the Main window. The Start Processing window appears 
(Figure C-7).  

4. Specify the output directory and document name. (Do not include a file extension.) 
(Reference Section C.3.4.1) 
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5. Specify the Text Format (Figure C-8). Select the pop-up menu with the right mouse button.  
The default is outlined with a double border. To change the selected format, hold down the 
right mouse button, point to the new format, then release the button.  

6. Load the document in the scanner. If using the ADF, place the documents in the ADF face 
down, with the top of the pages entering the scanner.  

7. Select Done in the Start Processing window.  

The scanner scans all the pages. When all pages have been scanned, the system displays the 
Out of Input window (Figure C-10).  

8. If there are more pages to scan, load the additional pages, then select Continue. If there are 
no more pages, select the End Document button.  

The system outputs the recognized text to the selected formatted file type tfor use with word 
processing, desktop publishing, or other text applications.  

C.6 SCANNING IMAGES 

For image scanning, only some of the settings in the Document Settings window are appropriate.  
These are Orientation and Page Size.  

1. Select the Document command in the Main window. The Document Settings window appears 
(Figure C-5).  

2. Specify document settings appropriate for the image to be scanned (see Section C.3.2).  

3. Select Done. The Document Settings window closes.  

4. From the Process category in the Main window, select Image. The Image button is turned 
on.  

5. Select Scanner Settings from the Main window. The Scanner Settings window appears 
(Figure C-6).  

6. Specify scanner settings (reference Section C.3.3.).  

7. Select Done. The Scanner Settings window closes.  

8. Select the Start command from the Main window. The Start Processing window is displayed 
(Figure C-7).  

9. Specify the output directory and file name. Do not include a file extension.  

10. Select Done. ScanWorX displays the Start Processing window and scans the image on the 
flatbed. The system then displays the Out of Input window.  

11. Continue or end the job. To continue, go to Step 12; to end the job, go to Step 13.
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12. Place another image on the scanner flatbed, then select Continue. The image is processed to 
the same base name.  

13. To end the image scanning document, from the Out of Input window select End Document.  
The images that were scanned are written to the system.  

C.7 COMPOUND SCANNING (TEXT AND IMAGES) 

Text scanning creates a binary image of the page and then performs character recognition on the 
image. Any graphics on the page are ignored. During image scanning, all print on the page is read as black 
and white pixels and the data is stored in the specified image file format. Compound scanning allows text 
and images to be processed at the same time. Separate files result from compound scanning; a text file for 
the recognized text and an individual image file for each page of the document. Note: With compound 
scanning, the page images will be saved only as binary (Text/Line Art) data.  

With compound scanning, all of the text and graphics in a document can be processed in a single 
procedure. Later, an image editor can be used to edit the desired specific graphics.  

To scan text and images in a single process: 

1. Set up the text scanning options. Refer to Section C.3.2 for settings.  

2. Load the document into the scanner.  

3. Select the following options on the Main window (Figure C-2): 

a. Input Source = Scanner 

b. Process = Both 

4. Select the Start command from the Main window. The Start Processing window appears 
(Figure C-7).  

5. Specify the output path and file name.  

6. Specify the Text Format (refer to Figure C-8) and the Image Format (refer to Section 
C.3.4.2).  

7. Define the Text Options (refer to Section C.3.4.4).  

8. In the Start Processing window, select Done.  

The scanner now scans all of the loaded pages. When all of the pages have been scanned, the 
Out of Input window is displayed (Figure C-10).  

9. When all pages have been scanned, select the End Document button in the Out of Input 
window.  

The system outputs the recognized text to the specified format for use with a text application.
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The page images are stored in image files in the format specified in Step 6.

C.8 PREVIEWING DOCUMENTS 

ScanWorX provides previewing tools that allow control of how each page of a document is 
processed. A page can be viewed and zones created to identify data as text, image, or to be ignored.  

To open the Document Preview window, select the Preview box in the Main window 
(Figure C-2). The Document Preview window is organized in three sections: commands, a toolbox, and a 
preview window.  

C.8.1 Preview Commands and Options 

At the top of the Document Preview window (Figure C-11), directly below the title bar, are 
eleven commands and options. They are as follows: 

Process-Recognizes the current page., and then scans the next page of the document or reads in 
the next TIFF file and displays it in the Preview window.  

Scan Page- Scans a page or reads in another TIFF file at any time.  

Interrupt-Saves all the intermediate character recognition and format analysis files for pages of 
the document that have been recognized so far. Processing of this document can be resumed 
later.  

Cancel Page-Cancels the page being processed. All previous pages are retained.  

End Document-Converts all pages of the document that have been recognized so far. This 
option brings the system back to the idle mode and recognition processing and scanning are no 
longer in process.  

Cancel Document-Cancels processing of this document, removes all temporary files, and clears 
the document preview window.  

Load Template-Loads a set of zones previously saved in template files.  

Save Template-Saves the set of zones currently displayed in the preview window to a named 
template file that can be reloaded for future jobs.
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C.8.2 Preview Toolbox 

The toolbox is the series of icons near the top of the Preview window directly beneath the 
commands (Figure C-11). There are nine icons that enable a variety of operations in the Preview window.  
When the icon is selected and the cursor moved within the Preview window, the cursor takes the shape of 
the icon. The intended operations can then be performed.  

The functions of the nine tools are as follows: 

\ Edit Zone-Use to select, move, and resize rectangles 

S Zoom In-Use to zoom in on the previewed page 

SZoom Out-Use to zoom out on the previewed page 

T Text Zone-Use to outline text areas for text recognition 

L Image Zone-Use to outline areas to be processed as image files 

0 Ignore Zone-Use to outline areas to be ignored during processing 

SDelete Zone-Use to delete text zones, image zones, ignore zones, and cut links 

Link Zones-Use to link the order in which zones of the same type are to be processed 

E Zone Attributes-Use to specify recognition settings for individual text zones 

C.8.3 Previewing a Page 

The following procedure provides basic instructions for previewing and zoning a page for 
scanning and character recognition.  

1. From the Options category in the Main window, select the Preview check box.  

2. Select the Input Source.3.Prepare the scanner or TIFF Queue. If the input is the scanner refer 
to Section C.3.  

4. Select the Process type that applies to this job (text only, images only, or both).  

5. Select the Start push-button. The Document Preview window opens(Figure C-i1).  

6. Select the Scan page command at the top of the Document Preview window. The Start 
Processing window is displayed (Figure C-7).  
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7. Specify the appropriate entries in the Start Processing window, then select Done. Refer to 
Section C.3.4.  

The image is scanned (or read from a TIFF file) and is displayed in the Preview window.  

C.8.4 Zoning Pages 

Identifying precise areas of a page to be processed is referred to as zoning. Areas of the page can 
be zoned as text zones, image zones, and ignore zones by use of the Preview window tools. Using text 
zones can speed up the recognition process by excluding areas of the page not to be processed. A total of 
39 zones can be setup on a single page.  

C.8.4.1 Creating a Text Zone 

To create a text zone: 

T 1. With a page displayed in the Preview window, select the Text Zone icon (left) in the 
toolbox. The mouse pointer becomes the "T" symbol icon.  

2. Draw the text zone rectangle. Select and hold on the upper left comer of the area to be 
defined as a text zone. Drag the mouse toward the lower right comer of the zone. A zone 
rectangle is drawn around the text area (Figure C-12). Release the mouse button when the 
rectangle outlines the entire text zone.  

\ 3. Use the Edit Zone tool (left) to select and edit zones.  

S 4. Use the Zoom In tool (left) to magnify the page display so the edges of the rectangles can 
be precisely defined.  

5. Use the Zoom Out tool or the scroll bars to display the next area to zone. A text zone can be 
created that overlaps another zone. The last text zone created takes precedence over the zone 
that it overlaps. Any text contained in both zones belongs to the topmost zone.  

Repeat this procedure until all of the text zones for the page have been defined.  

C.8.4.2 Specifying Text Zone-Specific Recognition Settings 

Without specific instructions, ScanWorX recognizes all text zones on a previewed page with 
default recognition settings. These include text type (alphanumeric, numbers only, or letters only); and 
whether to use context verification during recognition.  

To control how individual text zones on a page are to be processed, zone-specific recognition 
settings must be specified. When all text on a page is generally the same type, Document Settings in the 
Main window for all zones can be specified; zone specific recognition settings are not necessary.
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Figure C-12. ScanWorX-Text Zone 

However, if the text to be processed differs in format, such as a financial table that includes both 
text and numbers, zone-specific settings should be used. For a zone containing a financial table, 
zone-specific settings might include Numbers Only and Context Verification OFF. This should result in 
recognitions being faster and more accurate than using normal text default settings.  

To specify zone-specific settings: 

1. Use the Text Zone tool to identify the text zones. All of the text zones on a page may be setup 
before defining the recognition settings for individual zones.  

S2. Select the Zone Attributes tool (left).  

3. Define the zone information for a specific text zone. Place the mouse pointer (now displayed 
as the Zone Attributes icon) inside a text zone on the page, then press the mouse button. The 
Recognition Settings window is displayed (Figure C-13).  

4. Specify Recognition Settings as required by the type of text.

C-24



Figure C-13. ScanWorX-Recognition Settings for individual text zones window 

5. Select Apply.  

6. Repeat Steps 2 through 5 for each zone requiring specific recognition settings.  

C.8.4.3 Creating an Image Zone 

The process of creating image zones is very similar to the process for creating text zones. When 
a page with image zones is processed, each image zone is output to a separate file that can be used with 
compatible applications.  

When setting up to process a document with images, either Image or Both must be selected as the 

Process on the Main window (Figure C-2). Otherwise, image zones are not processed.  

To create image zones: 

1. With the page displayed in the Preview window, select the Image Zone tool (left).  

2. Draw the image zone rectangle.  

a. Select and hold the upper left corner of the area to be defined as an image zone.  

b. Drag the mouse toward the lower right corner of the zone. A zone rectangle is drawn 
around the image area.  

c. Release the mouse button when the rectangle outlines the image zone. Handles appear 
in the comers of the image zone, indicating that the zone is currently selected.  

\ 3. Use the Edit Zone tool (left) to select and edit zones.  

, 4. Use the Zoom In tool (left) to magnify the page display so the edges of the rectangles can be 
precisely defined.  

5. Use the Zoom Out tool or the scroll bars to display the next area to zone.
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Repeat this procedure until all of the image zones for the page have been defined. A total of 39 
zones (of all types) can be created on a single page. A zone may be created that overlaps another zone. The 
last image zone created takes precedence over the zone that it overlaps. Any part of an image contained in 
both zones belongs to the topmost zone.  

Image files zoned from a page use the document name as the base name. A three-digit page 
number and a two digit figure number are appended. For Example: tampapg 001_fg01. ext 

In the above example, "tampa" is the base name, "001" is the page number, "01" is the figure 
number on that page, and ".ext" is the extension that identifies the output format (reference Section 
C.3.4.1, Output file names).  

C.8.4.4 Creating Ignore Zones 

It may be desirable to specify areas of the previewed page to be ignored when the job is 
processed. For example, there may be a logo or a portion of an article that you do not wish to process, 
ignore zones are used for this purpose.  

To create ignore zones: 

0 1. With the page displayed in the Preview window, select the Ignore Zone tool (left).  

2. Draw the ignore zone rectangle.  

a. Select and hold the upper left comer of the area to be defined as an image zone.  

b. Drag the mouse toward the lower right comer of the zone. A zone rectangle is drawn 
around the image area. An ignore zone rectangle is divided into four quarters by two 
thin, solid lines (Figure C-14).  

c. Release the mouse button when the rectangle outlines the ignore zone. Handles appear 
in the comers of the image zone, indicating that the zone is currently selected.  

\ 3. Use the Edit Zone tool (left) to select and edit zones.  

4. Use the Zoom In tool (left) to magnify the page display so the edges of the rectangles can 
be precisely defined.  

5. Use the Zoom Out tool or the scroll bars to display the next area to zone.  

Repeat this procedure until all of the ignore zones for the page have been defined. A total of 
39 zones (of all types) can be created on a single page.  

C.8.4.5 Linking Text or Image Zones 

Normally, ScanWorX processes zones on a page from left to right, top to bottom. However, the 
sequences in which the zones are processed can be specified by use of the Link Zones tool. Text zones can 
only be linked to text zones, and image zones can only be linked to image zones.
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Figure C-14. ScanWorX-ignore zones 

With text zones, the Link Zone tool can link multiple text zones to determine the order in which 
the recognized text is output to a text file. With images (each of which are output to separate files), the Link 
Zone tool controls the order in which they are processed and, by extension, the figure numbers that are 
appended to image file name.  

To link zones: 

C 1. With the page displayed in the Preview window, select the Link Zones tool (left).  

2. Position the cursor in the zone to be processed first.
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3. Hold down the left mouse button and drag the cursor into the second zone. The cursor draws 
an arrow from the first to the second zone. This arrow indicates the order in which the zones 
are to be processed (Figure C-15).  

4. Position the cursor in the second zone, hold down the left mouse button, and drag the cursor 
into the third zone.  

5. Repeat Step 4 until all of the zones to be linked are connected. If any zones are left unlinked, 
they are processed after all linked zones.

Figure C-15. ScanWorX-linked zones
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C.8.5 Processing a Previewed Document

After the first page of a document has been displayed in the Preview window, it can be 
processed. There are two options for processing the document: (i) display and zone each page individually, 
or (ii) set up a page template (set of zones) on the first page and process all pages with the same template.  

With the first page of the document displayed in the Preview window, use the following 
procedure to process the document.  

1. Create zones and perform other previewing operations, as required, for the displayed page.  
Refer to the previous sections in C.8 for details.  

"* To process each page individually, go to Step 2.  

"* To process all pages with the same template, go to Step 3.  

2. Leave the preview window open, and select the Process command at the top of the window.  
Text and/or images are processed, then the next page in the scanner (or in the TIFF Queue) is 
displayed in the Preview window.  

Proceed from Step 1 to process each additional page.  

When all pages have been processed, the Out of Input window is displayed (Figure C-10).  
Proceed to Step 4 to end the document.  

3. Select the Preview check box in the Main window (Figure C-2). The Preview window closes, 
and all pages in the scanner (or the TIFF Queue) are processed according to the same 
template.  

When all pages are finished, the Out of Input window is displayed.  

4. When the job is completed, select End Document in the Out of Input window. A single text 
file is created and saved in the specified directory and path name. Image files are saved in the 
specified format.  

C.9 VERIFYING TEXT 

Certain document characteristics can cause character recognition accuracy to decline. Examples 
are: ornate, thin-stroke typefaces, dirt, smudges, handwritten notes, and documents with noise-such as 
second or third generation photocopies.  

To ensure the optimum character recognition, ScanWorX provides interactive text verification 
tools collectively call the Verifier. The Verifier is a subsystem that enables the user to view and interact 
with the system's Intelligent Character Recognition to verify recognized text, and to correct errors. The 
Verifier also allows the user to provide values for special characters or symbols that have no ASCII 
identification. By verifying the first one or two pages of a long document, the accuracy rate for the entire 
document can be improved.
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The results of a verification session, called verification data, can be saved in reusable files.  
Whenever it is necessary to process the same type of document, the verification data file can be reloaded.  

C.9.1 Verifier Window 

When the Verifier checkbox is selected in the Main window (Figure C-2), the Verifier window 
and Verifier Toolbox open onto the desktop. When text recognition is initiated, the system displays and 
highlights questionable characters in the Verifier window (Figure C-16). The current character (the one 
ready for verification) is highlighted (white type in a black rectangle).

S$aaWorX - Teit Verifier 

a4 i 

Extended Chatrc- Keypad

ScanWorX - TOIR Verifier 

computers, higher resol!P

Figure C-16. ScanWorX-Text Verifier window

C-30

I



C.9.2 Verifier Toolbox

Above the Verifier window is the Verifier Toolbox. The toolbox provides nine icons that can be 

selected with the mouse to perform the different verification tasks in the Verifier window.  

The functions of the nine verifier tools are documented below: 

Accepts the whole word without saving verification data.  

SIgnores the highlighted character group, it may be simply noise.  

S]Undoes any operations to the previous entire group.  

W Moves the cursor left one character within the block.  

L-1 Accepts the character with verification. Character was recognized correctly.  

B] Moves the cursor right one character.  

[ ]Joins this character (or group of characters) with the previous character. Cursor is now in 

overstrike mode, and anything typed replaces the characters.  

SAccepts the entire group with verification.  

S] Joins this character (or character group) with the next character. Cursor is now in overstrike 
mode.
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D CALERA M/SERIES PROFESSIONAL-SCANNING, OPTICAL 
CHARACTER RECOGNITION, AND DOCUMENT CLEANUP 

D.1 OVERVIEW 

The scanning, optical character recognition (OCR), and document cleanup processes involve 
several distinct steps: 

"* The document is examined to determine if exception conditions must be accommodated.  

"• A new or existing document is specified, and the system assigns ajob name.  

"* A user-supplied document name, four characters or less in length, is entered, and options for 
text and full-page images are selected.  

"• The pages are placed in the document feeder or on the scanner bed and scanned.  

"• Pages are zoned as required to designate areas of text versus areas that contain images.  

"* Pages of text are accessed through a special editor to correct scanning/OCR errors.  

"* The corrected text is exported to the file system, along with any associated images, for loading 
into the full-text and image repositories.  

The scanning process is initiated from the SCAN and OCR entry in the Operatons pull-down 
menu (Figure D-l) on scan capable workstations. If the workstation is not scan-capable (does not have the 
appropriate scanner and software installed) this option does not appear. Select the Operations entry from 
the CDOCS Main Menu. The perations pull-down menu appears. Select the SCAN and OCR entry in the 
Operations pull-down menu, and the scanning facility is started.

Figure D-1. CDOCS-Operations pull-down menu
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D.2 STARTING THE SCANNING OPERATION

The M/Series Pro initial scanning screen is illustrated in Figure D-2. This screen includes a menu 
bar at the top with entries for Eile, Edit, fools, Q~ptions, and Help, and an action bar containing icons for 
the most commonly used functions.  

D.2.1 The M/Series Pro Menu Bar 

The M/Series Pro File pull-down menu is illustrated in Figure D-3. This pull-down menu has 
options for New, Qpen Document, Close Document, Delete Document, Retrieve Settings, Save Settings As, 
and Exit. Mnemonics for each option are indicated by an underscore. The accelerator key for each option is 
indicated at the right of the option.

1.1....-,---,----.-----------.--,-,--,---.------,--------.--,--.-...,.,.-,.4 .............. ......... ...................  ............... .......... ........  . ............ ...  
.. . .......... ...........  M ........... ...... MCI_

Figure D-2. MiSeries Pro--initial scanning screen
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Upen Uocument... Utrl+tI1Z 
Close Document... Ctrl+F4

Delete Document... Ctrl+F9 Defte Done Nvaf.is~ 

Re!;rieve Settings ... Alt+R Import 
Save Settings As ... Alt+S .. , 

Exit Alt+ F4 :ii 

: :'-"j: Scan 

Zone 

N ~Edit 

Export 

Figure D-3. M/Series Pro-File pull-down menu 

New-This option is used to create a new document. This option is also available as an icon on the 
action bar.  

Qpen Document-This option is used to open an existing document for additional processing.  
This option is also available as an icon on the action bar.  

Close Document-This option is used to close and save the current document.  

Delete Document-This option is used to delete an existing document.  

Retrieve Settings-This option is used to retrieve a named set of settings.  

Save Settings As-This option is used to save the current settings with a new name.  

Exit-This option is used to exit from the scanning process.  

The MISeries Pro Edit pull-down menu is illustrated in Figure D-4. This pull-down menu has 
options for Lock Document, -Clear, Delete, Insert, ~Page Attributes, Dqcument Settings, and Rebuild 
Document. Mnemonics, where available, are indicated by an underscore. The accelerator keys are 
indicated at the right of the option.
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Clear... Bksp
Delete... Del.. ... ".....  Insert... InsDoeitr Done Wnifing 

_Page Attributes... Import 
Do~cument Settings...  

__ebuild Document...  

Scan 

'M 

zone 

Figure D-4. M/Series Pro-Edit pull-down menu 

Lock Document-This option is used to lock or unlock a document. The option works as a toggle 
switch because selecting this icon reverses the locked status. When the document is locked, a 
check appears to the left of the option. When the document is unlocked, the check does not 
appear at the left of the document. This option is also available through icons on the action bar.  

Clear-This option is used to clear the status of one or more scanning/OCR functions within a 
selected page or document.  

Delete-This option is used to delete a page within a document.  

Insert-This option is used to insert a new page in a document.  

Eage Attributes-This option is used to display an option screen for setting page attributes.  

Document Settings-This option is used to display an option screen for entering document 

Rebuild Document-This option is used to display an option screen for rebuilding a document.  

The MISeries Pro Tools pull-down menu is illustrated in Figure D-5. This pull-down menu has 
options for Import, Scan, Zone, Edit, and Fxport. Mnemonics are indicated by an underscore. The 
accelerator keys are indicated at the right of each option 

Import-This option is used to import a previously saved image and store it in the selected page.  
This option is also available as an icon at the right side of the screen.  

Scan-This option is used to start the scanning process. This option is also available as an icon at 
the right side of the screen.
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Edit... Ctrl+E Done 
Export... Ctrl+X 

Figure D-5. M/Series Pro--Tools pull-down menu

Zone-This option is used to start the zoning process. This option is also available as an icon at 
the right side of the screen.  

Edit-This option is used to start the editing process for OCR cleanup. This option is also 
available as an icon at the right side of the screen.  

Export-This option is used to export the current document to a named set of text and image files 
in a specified directory. This option is also available as an icon at the right side of the screen.  

The MiSeries Pro Qptions pull-down menu is illustrated in Figure D-6. This pull-down menu has 
options for Reader Errors, and Preferences.  

Reader Errors-This option is used to display a list of scanner errors detected in the current 
document.  

Preferences-This option is used to display an option screen for setting user preferences.  

_File Edit Tools I _IHelp 

Figure D-6. M/Series Pro-Options pull-down menu 
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D.2.2 The M/Series Pro Action Bar

Below the M/Series Pro menu bar, there is an action bar with icons. The icon functions are: 

Open an Existing Document-This icon is selected if an existing document is being updated 
with newly scanned pages. Selecting this icon causes the document to be opened.  

Open a New Document-This icon is selected if a new document is being submitted for 
scanning and OCR. This is the normal selection for most documents. Selecting this icon causes a 
new document to be opened.  
Lock a Document-This icon is selected to lock an existing unlocked document. The appearance 
of the locked and unlocked icons indicates the current status of the document. If the document is 

locked, this icon is highlighted, and the icons at the right side of the screen are shaded to indicate 
that their functionalitv is not available.  

Unlock a Document-This icon is selected to unlock an existing locked document. The 
appearance of the locked and unlocked icons indicates the current status of the file. If the 
document is unlocked, this icon is highlighted and the icons at the right side of the screen are not 
shaded. This indicates that their functionality is available. This icon is initially highlighted to 
indicate that it has been selected as the default value.  

~. Scan the front sides of the pages-This icon is selected if only the front sides of the pages are to be scanned. This icon is initially highlighted to indicate that it has been selected as the default 

value. Unless a different icon in this group is selected from the action bar, only the front sides of 
the document pages will be scanned.  

SScan the back sides of the pages-This icon is selected if only the back sides of the pages are to 
be scanned.  

S~'Scan the front and back sides of each document page-This icon is selected if both the front and 
back sides of the pages are to be scanned, alternating front and back sides.  

Scan the front sides of all pages in the document and then all the back sides-This icon is selected if both the front and back sides of the pages are to be scanned, scanning all of the front 

sides first and then all of the back sides.  

The center of the M/Series Pro initial scanning screen contains an information display area with 
columns for Scanning, Zoning, Reading, and Editing. This portion of the screen is updated with the status 
of each page as the Scanning, Zoning, OCR, and Editing processes are performed.  

The right side of the M/Series Pro initial scanning screen contains the following icons that are 
used to start various functions. These icons are shaded initially to indicate the functions are not available 
until a new document has been selected or an existing document has been opened.
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11n Import- Retrieve one or more existing images for processing 
Import 

"Scan-Initiate scanning of document pages 

Scan 

Q Zone- Specify areas of document pages as text or image 

Zone 

:I Edit- Correct OCR errors 

Edit 
Export- Convert the format of the internal text/image files and store the output text and image 

BC files in a directory specified by the user 
Export 

D.2.3 Selecting the Document and Options 

Before scanning can be started, a document must be made available to hold the scanned text and/ 
or images for the scanned pages. The document may be made available by either: (i) opening an existing 
document or (ii) creating a new document. In most instances, a new document is created by selecting the 
New icon from the File pull-down menu or the Open a New Document icon from the action bar.  

The type of page scanning (i.e., front, back, front/back, etc.), must also be selected from the 
action bar.  

If New is selected, the Document Settings entry screen will appear ( Figure D-7). The system 
assigns ajob number which is an internal unique identifier for the data. The job number is displayed on the 
screen following the Job # prompt. This job number cannot be changed on the screen but it should be noted 
for future reference.  

An input field is provided following the Document name prompt for entry of a name for the 
document. While the document name can be longer, a four-character identifier for the document is strongly 
recommended. This four-character identifier is the user-assigned document name, and it must be unique. It 
is used as the name of the output text file, and it is also used as the first four characters of the names of any 
associated image files. Entry of the document name is further described in Section D.2.4.  

A drop-down selection field is provided below the Document name field for setting the Priority.  
The Priority field has a default value that is not normally changed.  

An entry field is provided below the Priority field for specifying the User Dictionary file for the 
spelling checker. The User Dictionary field contains a default dictionary name that is not normally 
changed. If the Change push-button is selected, the User Dictionary option screen will appear (see 
Figure D-8). The upper pane of this screen permits the user to: (i) select from a list of existing dictionaries, 
(ii) create a new dictionary, or (iii) delete an existing dictionary. The lower pane of this screen permits the 
user to Add, Delete, Replace, or Import words into the currently selected dictionary.
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Figure D-7. M/Series Pro-Document Settings screen 

In the group area in the lower part of the Document Settings screen (Figure D-7) there are three 
check boxes that control the display of diagnostic information pertaining to OCR errors: 

Character Markers-If this option is selected the system will mark ambiguous characters that 
may have caused an OCR error.  

WordMarkers-If this option is selected, the system will mark words that the spelling checker 
found to be in error.  

Get Popups-If this option is selected, the system will permit popups of portions of the image to 
be selected from characters marked as suspected OCR errors.  

When all of the document settings have been entered, select the OK button to create the new file
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Figure D-8. M/Series Pro--User Dictionary selection screen

D.2.4 Specification of the Document Name 

The entered Document name is used as the first four characters of the file name for both the text 
and image output files. Since there can be many image files associated with each document, the system 
appends a suffix to the four-character document name to form a unique file name for each image. Thus, the 
document name is limited to a maximum length of four characters. If more characters are entered for the 
document name, they are truncated. If fewer than four characters are entered, they are not padded, 
therefore the resulting file name will be shortened.  

The following structure is used for the output text file names: 

ddW=e Where--dd is the user-specified document name.  

The following structure is used for the output image file names: 

ddddm=A.ut Where-dad is the user-specified document name.  

r= is a sequentially assigned number corresponding to the page sequence of the scanned 
document.
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A is an alphabetic suffix sequentially assigned to distinguish additional images within a single 
page.  

tttis a three character file type for the image file (e.g., TIF, GIF, etc.).  

D.2.5 Setup for Scanning 

Once the new document has been created or the existing document has been accessed, the M/ 
Scan screen will appear (Figure D-9). This screen has a menu bar at the top with entries for Eile, Edit, 
Options Actions, and Help.  

The M/Scan Eile pull-down menu is illustrated in Figure D- 10. This pull-down menu has options 
for Retrieve Template, Save Template as, Scanner Selection, and Ejit. The mnemonic for each option is 
indicated by an underscore, and the accelerator key is indicated at the right of the option.  

Retrieve Template-This option is used to retrieve an existing document template.  

Save Template as-This option is used to save the current document template with a user
specified name.  

Scanner Selection-This option is used to select the scanning device.  

Exit-This option is used to exit from the scanning process.  

The M/Scan Edit pull-down menu is illustrated in Figure D- 11. This pull-down menu has options 
for Undo, Delete Zones, and Clear Template. The mnemonic for each option is indicated by an underscore, 
and the accelerator key is indicated at the right of the option.  

.Undo-This option is used to reverse the last entry or action.  

Delete Zones-This option is used to delete zones defined for the current page.  

Clear Template-This option is used to clear the current template.

Figure D-9. M/Scan-menu bar
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Figure D-1O. M/Scan-File pull-down menu

Cler Ternplh Shift+Del

Figure D-11. M/Scan-Edit pull-down menu

The M/Scan Options pull-down menu is illustrated in Figure D- 12. This pull-down menu has 
options for View Settings, Scanner Settings, Show Images, and Preserve Template. The mnemonic for each 
option is indicated by an underscore and the accelerator key is indicated at the right of the option.  

View Settings-This option is used to view the current settings.  

Scanner Settings-This option is used to change the scanner settings.  

Show Images-This option is used to enable or disable the display of images during scanning.  

P.reserve Template-This option is used to save the current template.  

The M/Scan Actions pull-down menu is illustrated in Figure D- 13. This pull-down menu has 
options for Next Page, Process Stack, Rescan, and Stop. The mnemonic for each option is indicated by an 
underscore, and the accelerator key is indicated at the right of the option.  

Next Page-This option is used to continue scanning with the next page.  

Process Stack-This option is used to process the remaining document pages in the stack.  

Rescan-This option is used to scan the current page again.  

Stop-This option is used to stop the scanning process.  
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Figure D-12. M/Scan-Options pull-down menu
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Figure D-13. M/Scan-Actions pull-down menu 

Below the menu bar, there is an action bar of icons that are divided into five groups. The icons in 
the first group control the scanner as follows.  

Scan the nextpage-The scanner is started and scans and processes one page.  

""Scan a stack ofpages-The scanner is started and scans and processes a stack of pages.  

Re-scan a page-The scanner is started, and the last page is scanned again.  

Stop-The scanning operations are stopped.  

A II ~ Scanning options-A screen is displayed that permits the scanning options to be set or changed.
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The next five icons set options for zoning. Four of these five icons have dotted frames. These 
icons are used to specify the zoning for text and images. One of these four icons should be selected to 

indicate the type of information on the document page: 

Text Zoning-The zoning area contains text without any images.  

in Image only-The zone contains only images without any text.  

Ilim- Numbers only-The zone contains only numbers without any alphabetic text or images.  

Text and images-The zone contains a combination of text and images.  

N Change zoning order-Selecting this icon causes a zoning order screen to be displayed and 
permits the order of zoned areas to be changed.  

The next icon permits specification of text that was printed on a dot matrix printer.  

Dot matrix text-Selecting this icon alternately sets or clears the dot matrix mode. When text is 

printed on a dot matrix printer, the individual characters are made up of closely spaced dots that 
may result in OCR errors. When in the dot matrix mode, the OCR software correctly interprets 
dot matrix text.  

The last six icons permit adjustment of the position, size, and orientation of the image.  

,..,, Full width display-The display of the scanned image is adjusted so that the width of the image 

fits in the width of the display screen.  

SFull-page display-The display of the scanned image is adjusted so that the entire image fits in 

the display screen.  

One-to-one display-The display of the scanned image is adjusted so that each picture element 

(pixel) in the scanned image is represented by one pixel on the display screen.  

.'\Magnify the image-The image is increased in size.
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Shrink the image-The image is decreased in size.  

Rotate the image-The image is rotated 90 degrees in a clockwise direction.  

D.2.6 Changing the Scanner Settings 

The option to change scanner settings is selected from the M/Scan Qptions pull-down menu.  
While it is not usually necessary to adjust the scanner settings, some documents may have particularly light 
or dark images that must be accommodated. When the Scanner Settings option is selected from the M/Scan 
Qptions pull-down menu, the scanner settings screen is displayed (Figure D-14). This screen permits 
adjustment of Brightness, Contrast, Page Size, and Scanning Resolution.  

D.2.7 Selecting the Initial Zoning Options 

Default zoning for routine loading includes both text and full-page images. This option is also 
normally selected for on-demand loading. The Text and Image icon is selected from the action bar at the 
top of the initial scanning screen to designate full-page zoning for both text and image.  

D.2.8 Starting the Scanner 

Once the initial zoning options have been selected to specify the layout of the pages for both text 
and image, scanning can be started. A decision needs to be made before starting the scanner about whether 
to: (i) scan and process pages individually, or (ii) scan and process pages continuously. In general, 
continuous scanning is only appropriate for documents whose pages have a very high degree of uniformity 
in their format and are primarily textual in nature. Documents that include many equations, interspersed 
landscape and portrait pages, or require intervention should have their zoning deferred or should be 
processed in single-page mode.  

Made: 11F''~1 rgtu 
® Manual0 Atsnumak 

Dithier I~o E'\ I __ 

Dab pas inch: [F74M ~ i~i 

Lefter -&85zl11in ®*Manual 0 tstAfm~stk 
PD•DRT Verson 1.30 * I j 1 

KOFAXICVeFion 1.23 

Figure D-14. M/Scan-Scanner Settings screen
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D.2.9 Scanning Unbound Documents

If the document is not bound, the pages should be placed face down in the document feeder with 
the tops of the pages against the scanner head. Depending on whether the document is printed on one or 
both sides of the pages, the appropriate scanning option icon should be selected to either: (i) scan the front 
of the pages, or (ii) scan the front and back of the document continuously. The scanning operation is started 
by either: (i) selecting the icon to scan a stack of pages from the action bar, or (ii) by displaying the Actions 
pull-down menu (Figure D-15) and selecting the Process Stack entry. Scanning proceeds automatically 
until all documents in the scanner have been read.  

D.2.10 Selecting Zoning Options 

If no zoning options have been selected, a pop-up screen will appear that allows selection of 
zoning options (Figure D-16). The options displayed on this screen depend on the initial zoning options 
selected for the document. If the Text Only icon was selected, then the Full-Page option on this screen will 
specify full-page text. If the Text andImage icon was selected, then the Full-Page option on this screen will 
specify full-page text and images.The option selected on this screen is very important because it will affect 
the way the OCR process is performed.  

Defer-If this option is selected, zoning will be deferred until the scanning has all been 
performed. This option provides the greatest flexibility in zoning because each page image is 
available for zoning before the OCR process is started for that page. However, if this option is 
selected, the text and full-page image must be individually zoned for each page.  

Full-Page-If this option is selected, the default zoning selected for the document will be applied 
to all pages, and OCR will be performed automatically for each page as it is scanned. This option 
is appropriate for documents with highly uniform pages that are mostly textual in content.  
However, if this option is selected, the text and full-page images will be zoned automatically for 
each page, and there will be no opportunity to override that zoning for unusual pages prior to the 
OCR process.  

D.2.11 Scanner Intervention Options 

The scanner always tries to read from the document feeder. If the feeder is empty, a pop-up 
screen will appear to permit selection of the next action to be taken by the scanner (Figure D-17).  

i ie Edit Options Help--------

S~Process Stack Ctrl÷S 
Rescan Ctrl+R 

Stop 

Figure D-15. M/Scan-Actions pull-down menu
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Figure D-16. M/Scan-zoning specification options

Prepare scanner 

KOFAX Kipp 2.0 (BIC) Driver (Sikplex/DtutezJ

Next page 

* Front of sheet 17 

0 Back of sheet 16

Sheet courtm Z Scan ahead 
* All theets in stack 

0 Number of sheets: 

... .. ... i.

Figure D-17. M/Scan-scanner intervention options screen 

The radio buttons in the Paper path group box permit selection of either the document feeder 
or the flatbed scanner.  

The radio buttons in the Next page group box permit selection of the front or back of pages.  
When both sides of the document pages are being scanned, the fronts of all pages are scanned 
first. Then, the Back of sheet.. option is selected, and the backs of the pages are scanned in 
reverse order. This approach facilitates the use of the document feeder. The front sides of all 
pages are scanned first. Then the entire stack is turned over and passed again through the 
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document feeder. This results in the back side of the last page being scanned, followed by 
successively lower pages until the back side of the first page has been scanned. The order of 
the pages is very important because the text and images will be associated with the system 
generated page number as determined by the scanning order.  

"• The radio buttons and entry field in the Sheet count group box may be selected to scan all of 
the pages in the stack or only a specified number of pages.  

"* The Scan ahead option permits scanning to continue while OCR for previous pages is 
running.  

" The Continue scanning button may be selected to continue scanning after adjusting scanning 
intervention options and/or placing more pages on the scanner. When all pages have been 
scanned, the Stop scanning button is selected to terminate the scanning operationScanned 
Image Displays 

As each page is scanned, the image is displayed (Figure D-18). If continuous scanning has been 
requested, the image for each page is displayed, but the scanning operation does not stop until intervention 
is required on the scanner.  

If continuous scanning was not requested, the system stops after each page has been scanned, and 
the image is displayed for review and zoning. The scanning operation may be resumed by selecting the 
icon to scan a single page from the action bar or by displaying the Actions pull-down menu and selecting 
the Next Page entry. Scanning will then proceed for the next page. This process is repeated until all pages 
have been scanned.  

D.2.12 Automatic Numbering of Document Pages 

The output of the scanning process is a collection of text and image files with appropriate 
markers for known and suspected scanning and OCR errors. The files created for each page by the 
scanning and OCR processes are not immediately available for external use because they contain error 
indicators and links between the text and image. These internal format files are used as input to the Edit 
and Export processes.  

The sequence in which the documents are scanned determines the page numbers. The text/image 
files are numbered consecutively as the pages are scanned, and they are listed with these numbers in the 
scanning status screen. Therefore, to avoid confusion and improper sequencing of the output text file, it is 
important that the pages of the document be scanned in the proper order. Missing pages also cause 
problems because the pages following the missing page will be assigned incorrect page numbers. If pages 
are missed, they may be scanned later and inserted, but it is preferable to assure that the input document is 
complete and in the correct sequence before scanning it.  

D.2.13 Zoning Options 

If continuous feeding was selected, scanning will proceed until the document feeder is empty.  
Then the scanner intervention screen will display (Figure D-17). If the Stop scanning option is selected, the 
scanning operation terminates, and the zoning and OCR processes begin. If no zoning options were 
selected, another option screen will display that permits selection of zoning options for the images 
(Figure D-19). The default for the system is to scan and store a single full-page image for each page of text 
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Figure D-18. M/Scan--document image display during scan 

Therefore, for documents that contain text only without many equations or figures that might cause OCR 
errors, the Full-Page option should be selected, However, if the format of the pages is highly variable or if 
there are equations or figures that require zoning, the option to Defer zoning should be selected.  

D).2.14 Document Status Display 

Scanning is normally performed in a way that produces a single full-page image for each page.  
The output of the scanning/OCR process is a series of text and image files corresponding to the content of 
each page. The image files are given names, as described in Section D.2.4, that are based on a combination 
of the document name, the page sequence number, and an image sequence letter.
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Figure D-19. M/Scan screen-zoning specification options 

Scanning is followed automatically by the zoning and OCR processes. As the scanning, zoning, 
and OCR processes are performed, a status screen is updated (Figure D-20). This screen contains a column 
of numbers on the left that indicates the scanned page sequence. Four additional columns correspond to the 
four major steps in the scanning/OCR process.  

Scanning-This column indicates the scanning status for each page. When a page has been 
successfully scanned, the word "Done" appears in this column for the page.  

Zoning-This column indicates the zoning status for each page. When a page has been 
successfully zoned, the word "Done" appears in this column for the page.  

Reading-This column indicates the OCR status for each page. When a page has been 
successfully processed for OCR, the word "Done" appears in this column for the page.  

Editing-This column indicates the editing/cleanup status for each page. When a page has been 
successfully scanned, zoned, and processed for OCR, the word "Waiting" appears in this column 
for the page. After the page file has been processed by the editor, the word "Done" appears in this 
column for the page.
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Figure D-20. M/Series Pro-status display following optical character recognition 

The edit/OCR cleanup process normally follows the scanning, zoning, and OCR processes. It is 
important to do the edit/cleanup function immediately while the source document is available for visual 
reference, but the editing does not start automatically. It must be started by selecting the Edit icon at the 
right of the status screen.  

Although the individual lines in the status display may be selected for some functions (e.g., 
Clear), the system does not permit zoning or editing files out of sequence. When editing is started, the 
system accesses each file with a status of "waiting" in the Editing column. When the file has been edited 
and saved, the status is changed to "Done" in the Editing column. Thereafter, the file cannot be edited 
again with the OCR editor.  

D.3 ZONING OF INDIVIDUAL PAGES 

Document pages, such as the one illustrated in Figure D-2 1, that contain text, images, and/or 
equations may require individual zoning to minimize OCR errors. The OCR process normally uses the 
entire page image as input, but individual zoning may be required if the image contains features that may 
cause the OCR software to misinterpret the characters, these include: 

"* Greek characters and mathematical symbols frequently found in equations 

"* Text with unusual orientations, such as feature labels on maps 

"* Text with both horizontal and vertical orientations, such as labels on figures and graphs
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When these features appear in an image, it is advisable to identify the areas that contain them in 
order to prevent those areas from being processed by the OCR software. This is done using the zoning 
capabilities of the system. All document pages are zoned, either automatically by the system or manually 
by the operator.  

D.3.1 Full-Page Zoning 

The default mode of operation is to have the system zone pages automatically. This is done by 
selecting the initial zoning mode and selecting the option to read all pages as full-page text and image (see 
Section D.2.7). If this default zoning is selected, each page will be zoned automatically, and the zoning and 
OCR processes will follow scanning without interruption. Therefore, if this option is selected, there will be 
no opportunity to select special zoning for a particular page. For this reason, full-page zoning is only 
appropriate for documents in which all pages contain normal text in a consistent format. If the document 
contains numerous equations or images that may result in OCR errors, full-page zoning should not be 
selected.  

D.3.2 Deferred Zoning 

An option is provided to allow the decisions on zoning to be deferred until after scanning is 
completed. This option is appropriate for documents that contain numerous equations or images of figures 
that would cause OCR errors. When this option is selected, zoning will be deferred for all pages, and the 
OCR process will be delayed until zoning options have been specified on a page-by-page basis.  

D.3.3 Specifying Areas in a Scanned Image for Zoning 

Zoning is initiated by selecting the Zone icon at the right of the document status screen. When 
the zoning facility is started, it automatically processes all pages that have not yet been zoned (i.e., pages 
with a status of "waiting" in the Zoning column). Pages are processed in sequence, from first to last, and 
any attempt to select an individual page will result in error messages. Therefore, individual pages should 
not be selected.  

The image of each page with a "waiting" status in the Zoning column of the document status 
screen will be selected and displayed in sequence. By selecting the appropriate zoning icon from the top of 
the image display screen, areas of the image may be designated as text, image, numbers, or text and image 
(see Section D.2.5 for a discussion of the zoning icons). When a zoning icon is selected, a cursor that 
indicates the selected type of zoning appears. This cursor should be positioned at the upper left comer of 
the area to be zoned, and then, with the left mouse button depressed, the cursor should be dragged to the 
lower right comer of the area (Figure D-21). A dashed box will be drawn around the zoned area, and the 
area will be labeled in the upper left-hand comer with the type of zoning (e.g., TXT, IM, etc.), and in the 
upper right-hand comer with the zoning sequence (e.g., 1,2,3, etc.). The following codes are used to 
indicate the type of zoning: 

"• TXT-Text zoning 

"* IM-Image zoning 

"* TXT-IM-Text and image zoning 

"* #-Numeric zoning 
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. D-TXT-Dot matrix text zoning

. D-4-Dot matrix numeric zoning.  

D.3.3.1 Zoning Considerations 

Several considerations need to be kept in mind as zoning is specified.  

" Zoning should be performed in sequence-The sequence in which text areas are zoned 
determines the sequence of the text following OCR. There is a provision for altering the 
sequence of zoned text or inserting a newly zoned area between previously zoned areas, but 
using this facility requires additional time and effort. Therefore, specification of text zones 
should proceed in order, top to bottom. If multiple columns of text appear on a page, the left 
column should be zoned first, top to bottom, and then the right column should be zoned.  

" Zone areas from the upper left-hand comer to the lower right-hand corner-The zoning 
process assumes that the first point identified is the upper left-hand comer of the area, and the 
second point identified is the lower right-hand comer. If points are specified out of sequence, 
the image will be inverted or reversed, causing severe OCR errors.  

" Specify the zones correctly the first time-There are provisions for changing the zoning after 
it has been specified, including the ability to adjust the size of the zoning boxes. However, if 
zoning is specified incorrectly, the zoning corrections require additional time and effort.  
Therefore care should be taken to specify the zones correctly the first time.  

" Leave some white space between the zoning box and the text characters-Each zoning box 
has black squares, called handles, at the center of the top and bottom and the left and right 
sides of the box. Any of these handles may be selected and dragged to enlarge or reduce the 
size of the zoning box in one of its dimensions. Care should be taken to leave some white 
space between the characters and the zoning box. If the edge of the zoning box is too close to 
the characters, the image of the characters may be clipped resulting in lost characters or OCR 
errors.  

" The zoning cursor may not appear if the cursor position falls within a previously defined 
zoning box of the same type. This is because the cursor position may be ambiguous to the 
software, and it may select the previously defined zone rather than beginning a new zone.  
Therefore, when defining adjacent zoning boxes of the same type, it is sometimes necessary to 
initially define the second zoning box somewhat smaller than the text being selected. Then the 
handles on the sides or top and bottom of the zoning box can be used to expand the box to 
include the desired text.  

D.3.3.2 Zoning for the Full-Page Image 

The general approach for documents to be loaded into the permanent database is to store both 
text and full-page images. When zoning is deferred to permit the requirements of individual pages to be 
accommodated, the full-page images are not automatically captured. Therefore, after the text has been 
zoned, the image zoning icon must be selected and the entire page must be zoned for the full-page image. It 
is important that in zoning the fill-page image, that the upper left-hand comer be selected first, followed by
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the lower right-hand comer. Selecting comers out of sequence or selecting other comers may result in the 
image being rotated or reversed.  

D.3.3.3 Continuing the Zoning Process 

When all zoning operations for a page have been completed, the system must be instructed to: 
(i) go to the next page, or (ii) suspend the zoning operation. This is done be selecting the Actions pull-down 
menu from the Menu Bar of the M/SCAN screen (Figure D-22) 

D.3.3.4 Changing the Order of Zoned Areas 

Occasionally, zones will be specified out of sequence. If not corrected, this condition will cause 
the OCR process to produce text that is also out of sequence. Therefore, a facility is available to permit the 
order of zoned areas to be changed. This facility is accessed by selecting the Change Zoning Order icon 
from the action bar of the M-Scan screen. When this icon is selected, the Change Zoning Order screen 
appears (Figure D-23).  

D.4 OPTICAL CHARACTER RECOGNITION 

As soon as a page has been scanned and zoned, the OCR process is initiated automatically for 
that page. There are multiple OCR reader processes that are selected automatically by the software. When 
the OCR process for a particular page is finished, the status for that page is updated in the Read column of 
the status display screen.  

D.4.1 Editing and Cleanup of Document Pages 

During the OCR process, an internal format text file is created for each page. In these files, the 
text is flagged with colored markers to indicate the two levels of error: 

"* Known or suspected scanning and OCR errors are marked with yellow markers.  

"* Errors detected by the spell checker are indicated by blue markers.

Iile tdit ptions Z Help 
Next Page Ctrl+N 
Process Stack Ctrl+S
Rescan 
Stop

C t r l l R I

Figure D-22. M/Scan-zoning Actions pull-down menu
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Figure D-24. MIEdit--edit display for optical character recognition cleanup 

* In its first occurrence, "Department ofNuclear Engineering" lost a space character.  

• "Chosun University" was flagged by the spell checker, but is actually the correct spelling.  

• The name "Kun Jai Lee" was flagged by the spell checker but was correct.  

* In its second occurrence, "Department oj'Nuclear Engineering" misread the word "of'.  

* The "o" in "Taej on" was accented and was therefore scanned as a "6".  

* The word "ABSTRACT" was misread.  

In this sample page, there a re several errors that can easily be corrected. However, the resolution 
of some of the errors, such as the proper spelling of "Kin Jai Lee," requires reference to the source 
document Therefore, document cleanup should immediately follow scanning and OCR so that the source 
"document will be available for reference to resolve this type of ambiguity.

D-26

. .. .. .... ..... .... ..... .  .. .........  .. ..............  ....... ... .... ........ .. ... ... .. . .. .........  ............... ... .. ......... .. ...... ..  .... ... . ........ .. ........ . ............  .. .... . ... .......................... ...... ...... .. .............  ......... .. .....  ........ ....  ......... ............. ..... i ...... .... ......... .1 -0 . ...... .. .................. .............  .... ... .... .. 1. .. . .- ....  
....... . ... ........ ..... .  -X X ... .. ..................

I



D.4.2 Use of Pop-up Images to Resolve Scanning Errors

When the OCR process encounters sufficient ambiguity in the interpretation of a character, the 
location in the text is flagged with a yellow marker and provision is made to pop-up an image of the 
questionable area. Image pop-ups, such as the one illustrated in Figure D-25, are available during the edit 
process. To access the image pop-up associated with a particular suspected scanning /OCR error, the 
cursor is positioned at the yellow highlight and the lit3-d key is depressed.  

D.5 DOCUMENT EXPORT 

When the scanning, zoning, OCR, and cleanup functions have been completed, the document 
must be exported to make the text and images available to the user. The system maintains documents in an 
internal file format that relates each page of text to its associated images. While a document may be saved 
in this format, it is not fully accessible to the user until it has been exported.  

During the export process, the text portions of all pages are combined into a single text file. Each 
page is accessed in sequence, and within the page, text zones are accessed in sequence. The resulting text 
file is stored in the directory specified by the user. The first four characters of the user-supplied job name 
are used as the name of the text file, followed by a file type suffix of "TXT." 

Images are extracted, page by page, and stored with the selected image file format in the 
directory specified by the user. Because there may be multiple images associated with each page, there 
may be many image files. The names assigned to the image files are structured to indicate the document, 
page number, and image sequence within the page. Image file names take the form ddddnnnA.TIF, where 
dddd is the first four characters of the document name, nnn is the page number, and A is an alphabetic 
sequence character distinguishing multiple images on a single page. The file extension (e.g., TIF) indicates 
the format used for the image file.  

When the Export icon is selected, the M/Export screen is displayed (Figure D-26). This screen 
permits the user to specify, the directory where the text and image files will be stored, as well as the 
document name and the format for the image files.  

Once a document has been exported, the text and image files are available for use. The user may 
copy the text and/or image files to a diskette, network disk, or local hard disk where they may be used.

D-27



"ile Edit Search Character Options
"t ve assumptions caused by the geonetr• 
i11 l ea, boundary conditions, and 
v11ýariable variance 1 3). Furthermore, 1, 

scribing the sensitivity of the outcome to 
the 'input parameters and their statist4, 
easily obtained.  

1,Theoretically, the method is based on i1 
......order t series expansion at a sped.  

Mio point to calculate a measure of relii; 

liability problem is typically formulated 
:1function describing the performance o0 
1of interest. In general, the performance ýi 
1111f=ined asg(X when . ....... .... I 

fined~ ............. ' 

~:ector of rand SQ ws- 9 ý 
Mparameters of 
Whure state is de 

1sponding a 011 4 
\Iagainst exceediri 

K vance function I' 

is giv en by,.'....... ......  

Figure D-25. Pop-up image for a suspected scanning optical character recognition error 
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